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Preface 

Why another textbook on Microsoft® Excel®? 
As an instructor, past learner of many 
professional-technical technology courses, and 
worker in the private/public workforce, I have 
learned a good deal about how Excel can be 
used and how it can be efficiently rolled out 
for new and developing users. I try to bring a 
realistic Universal Design approach, and to tell 
a story of Excel usage that makes sense to 
learners and workers who use the application 
in various settings. In a way, this order also 
allows for learning in stages and being able to 
get to work fast, even if one cannot complete a 
full course of study before doing so. 

• Program introduction: The layout, user 
interface, options, etc. 

• Worksheet management: Making, styling, 
editing, and manipulating documents for 
solo and team work. 

• Data input, formatting, use, and 
organization: Adding text, graphics, and 
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numeric data to documents so Excel can 
work its magic, plus using Excel tools (like 
tables) for consolidating, sorting, and 
filtering data. 

• Workbook(s) management: Working with 
multi-sheet workbooks, and multiple 
workbooks. 

• Basic and intermediate formulas for 
calculations: Formulas / functions for 
creating meaningful data from raw 
numbers, so that you can use Microsoft® 
Excel® to communicate information like 
budgets, etc. 

• Summarizing data with summary and
pivot tables: Summarizing data that you 
create so that people can understand/use 
it for reporting. 

• Displaying data with charts and graphs: 
Displaying data from your tables in easy-
to-view live graphics so that people can 
use it for reporting. 

• Data informatics and analysis tools: 
Acquiring big data and cleaning/modeling 
it for problem solving. 

I have developed additional content, new 
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examples, and fresh assessments that are 
different from previously adapted versions of 
the source OER materials, in keeping with 
Universal Design and an eye to Diversity, Equity, 
and Inclusion (DEI) principles. I have also 
simplified the design format of the 
book(s)/course(s) from the previous versions to 
help them be as accessible as possible, 
regardless of format (computer, mobile, 
accessible pdf or E-pub, etc. 

This book attempts to focus on analyzing and 
solving business-related problems in basic and 
efficient ways; they are not the only ways. This 
book does not focus on AI tools or automation, 
both rather the basics of learning and working 
with how Excel actually functions for the 
average user. Automation and AI tools will have 
their place, yet understanding the 
underpinnings of the program’s use and value 
has to come first. 

Learners are offered clear, easy-to-follow 
guidance for each skill presented. Learners can 
approach the objectives with detailed steps in 
Try Me activities, and try things out in the 
ACTION: Quick task options. Learners should 
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be challenged to use critical thinking to solve 
real world scenarios, because what is all this 
for if not to help enhance one’s education and 
workplace future? 

NOTE: As workflow develops to include more 
automation, data analysis tools, and more of 
a focus on business informatics, Excel is 
modifying into a more robust tool. Aspects of 
its functionality, including contents and tasks 
on various toolbar/ribbons, will continue to 
change and add more options for 
intermediate-to-advanced work, such as more 
automation, power queries, and AI-assisted 
analysis with CoPilot. We are not covering these 
in this textbook. 

Disclaimer: One thing to keep in mind is that 
Microsoft Excel is part of MS Office’s 
subscription as a service (SaaS). As such, it has 
regular updates and modifications to its user 
interface and sometimes even how items are 
named. While this book strives to be accurate 
and current, learners will occasionally see 
variations – PC from Mac, last month to this 
month, etc. Things like the phrase ‘hyperlink’ 
being changed to just plain ‘link’ will happen, 
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as will minor phrasing or placement in Excel’s 
options, ribbon/toolbars, dropdown menus, etc. 
Learners are encouraged to be adaptable to 
this. 

This book also attempts to have a personal feel 
and occasionally some quirks in humor. Who 
wants a totally boring author? 

Suitable Learners 

This book can be used by: 

• Adult Basic Education (ABE) learners. 
• I-Best business and technology programs. 
• Worker retraining programs at colleges 

and employment service centers. 
• Learners at community colleges, training 

programs, and high schools. 
• Professionals as a quick review of business 

technology information and skills. 
• Self-study learners. 
• Anyone else with an interest in the covered 

topics. 
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Introduction: 
Using this Book 
as a Course 

How to Access This Book 

This textbook is available in the following 
Pressbooks-generated formats: 

• HTML. An HTML file can be opened in a 
browser. It has very little style so it doesn’t 
look very nice, but some people might find 
it useful. 

• Mobile. If you want to read this textbook 
on your phone or tablet offline, you can 
use the EPUB (eReader) or MOBI (Kindle) 
files. 

• Online webbook. You can read this book 
online on a computer or mobile device in 
one of the following browsers: Chrome, 
Firefox, Opera, Edge, and Safari. 
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• PDF. You can download this book as a PDF 
to read on a computer (Digital PDF) or 
print it out (Print PDF). Note: if you choose 
to have this book printed out in PDF 
format for your own study use, I am fine 
with this, and you should let your printer 
know this approval is part of the Open 
Educational Resource (OER) nature of this 
publication. 

You can access the online webbook and any of 
the formats for free. To download the book in 
a different format, look for the “Download this 
book” drop-down menu on the book’s startup 
page and select the file type you want. 

To access a shared CANVAS course of the 
textbook with the downloadable 
StudentDataFiles.zip, you will need to visit 
CreativeCommons: look for Business 
Spreadsheet Fundamentals CANVAS Course: 
BSF_2024, which (with files) is currently 
available HERE. 

How to use different formats: 
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MedAttrib: author-generated. Textbook format 
options and features. 

Tips for Using This Textbook 

• Annotate the textbook: If you like to 
highlight or write on your textbooks, you 
can do that by getting a print copy, using 
the Digital PDF in Adobe Reader. 

• Navigate the textbook: This textbook has 
a table of contents to help you navigate 
through the book more easily. If using the 
online webbook, you can find the full table 
of contents on the book’s homepage or by 
selecting “Contents” from the menu when 
you are in a chapter. The contents may be 
collapsed or expanded as needed. 

• Search the textbook: If using the online 
webbook, you can use the search bar in 
the top right corner to search the entire 
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book for a key word or phrase. To search a 
specific chapter, open that chapter and 
use your browser’s search feature by 
hitting [CTRL] + [f] (PC) or [CMD] + 
[f] (Mac). 

• The [CTRL] + [f] and [CMD] + [f] keys will 
also allow you to search a PDF, HTML, 
EPUB, and MOBI files if you are reading 
them on a computer. 

If using an eBook app to read this textbook, the 
app should have a built-in search tool. 

Key Features 

As an aid to learners, the book provides some 
useful features: 

• Callouts on specific tips and keybind 
shortcuts. 

• Clear and easy-to-understand written 
format and style. Materials presented in 
visual color and and gray scale format. 

• Clear step-by-step instructions* for in-
chapter activities. 
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• Key terms, definitions, phrases, concepts, 
etc. are located with a glossary. 

*  Instructions are designed for book learners. 
They are meant to be used independently of 
any classroom instructions. Learners who use 
this book within a course provided by an 
instructor may be asked to save their student 
data files, their working files, and their 
resources in different places than the book 
instructs, and that is okay. They may also be 
asked to rename their working files per their 
instructor’s requirements, which is also okay. It 
is up to the learner to differentiate between 
what the solo-study instructions are and what 
their course instructor – if any – requires 
instead. 

Doing the Work 

This Open Education Resources (OER) book 
can be used as a stand-alone overview, for 
general practice, and/or for a course that 
teaches introductory-to-intermediate business 

xvi  |  Introduction: Using this Book as a Course



technology information and productivity 
applications’ basics. This book includes: 

• Data files (Excel .xlsx, CSV, database, and 
image files for students to work with) 

• Examples for learners to try out (Try Me 
activities) 

However, this book does not currently include 
additional starter or finished classroom 
assignments used by L.J. Bothell in a full 
course, or video/demo resource links, or other 
personalized/in-the-moment resources. 
Instructors will likely create, have and/or access 
full assignment content, steps, previews, and 
example finished product documents. A later 
edition may include a few generalized 
classroom assignments; this edition does not. 

• Alternately, learners can also access demos 
on productivity tool exercises, and other 
training demos/tutorials, on the web. 
Sources can include LinkedIn Learning, 
free online learning academies, free 
Microsoft and Apple resources and 
tutorials, etc. Learners may also look up L.J. 
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Bothell tutorial videos on YouTube 
(produced 2023.) 

For following/trying out in-book demos as a 
solo learner, it is recommended that you take 
the following steps to prepare yourself for 
exploring MS Excel Bootcamp, and for going 
through the content in this book. Instructors 
using the book may have other requirements 
instead. 

NOTE: Mac Users will have a different 
experience with the Excel for Mac user 
interface, and while this book does offer some 
tips on this, it is primarily directed toward MS 
Excel for MS Windows/Office for PC. 

ACTION: Preparation steps for using 
this content 

If your instructor uses this textbook and has 
their own file naming/saving standards, then 
use that. Otherwise, on your own computer, 
in a location you can easily find, create a file 
directory called EXCEL_BOOTCAMP. 
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• In this directory, create 3 (three) sub 
folders: Examples, Images, DataFiles 

• Use the Examples folder to save your 
explorations, activities, and activities in this 
book. 

• Use the Images folder for any images you 
choose to use in your work, any 
screenshots you take as you learn, and 
notes of image attributions. 

• Use the DataFiles folder for any textbook 
or other Excel working files you download 
to use while working with this book. You 
want to keep only the Original 
downloaded files here, so that you can 
reuse them when you rename/save a 
working copy to your Examples folder for 
actual textbook activities work. 

MedAttrib: author-generated. Recommended 
learner file directory organization. 

• Download the datafiles.zip Zip file and 
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save it into your new DataFiles folder 
• Extract the data files from the Zip file and 

also save them in the same DataFiles 
folder. 

• When you need a working Excel file for a 
textbook activity, make a copy of it with a 
new chapter-related file name and place 
that copy in your Examples folder. This 
way you still have the original file in your 
DataFiles folder while being able to work 
safely on a file for a textbook activity in 
your Examples folder. 

TIP: Zip files. You can use the free 
built-in operating system, or 7-Zip, 
PEAZip, or file applications, which 
should work for all computer types (PC, 
Mac, Linux). You should be able to 
extract files from the zipped 
datafiles.zip folder for use. 

Regularly SAVE your practice work and your 
activities in your Examples folder (unless you 
have an instructor who has other instructions). 
Saving regularly is one of the most useful and 
time/aggravation-saving things you can do for 
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yourself. The textbook regularly notes “SAVE 
your work” several times in an activity to 
prompt and built this good/stable habit. It can 
also be used as a good assessment place for 
taking a screenshot of accomplished work if 
you or an instructor wishes to see your 
progress in that way. 
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Part 1: 
Fundamental 
Skills 

Microsoft® Excel® is a tool that can be used 
in virtually all careers and is valuable in both 
professional and personal settings. Whether 
you need to keep track of music selections in 
an online shop or create a financial plan for 
your budget, Excel enables you to do these 
activities efficiently and accurately. This section 
of chapters introduces the fundamental skills 
necessary to get you started in using Excel and 
to a solid intermediate level of competence, 
confidence, and comfort using the application. 
You will find that just a few skills can make you 
very productive in a short period of time. 

While this content refers to Excel, the skills you 
learn and practice here are consistent with 
other open-source and other variations of 
spreadsheet programs, like Libre Office, Google 
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Sheets, etc. However, Excel – as covered in this 
content – is a robust, supported, and frequently 
tweaked/updated application that is part of the 
integrated Microsoft® Office® suite. Also, this 
content will focus on a full installation of the 
complete program, not the light/free version 
that is offered online. This is because the full 
version has many tools and activities that the 
lighter online version, and mobile app versions, 
may not support. However, you can scale your 
skillsbuilding work on Excel to use the lighter 
versions with what you do learn and practice 
here. 
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Chapter 1: 
Microsoft Excel 
Overview 

What We’ll Cover >>> 

• Excel Prep 
• Excel for Windows and Mac 
• The Excel Workbook 
• Navigating Worksheets 
• The Excel Ribbon 
• The File Backstage 
• Right-click Menus 
• Saving Workbooks 
• The Status Bar 
• Excel Help 

Microsoft® Office contains a variety of tools 
that help people accomplish many personal 
and professional objectives. Microsoft Excel is 
a versatile and widely used program in all the 
Office applications, and a lot of job descriptions 
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specifically mention it as a core skillset. No 
matter which career path you choose, you will 
likely need to use Excel to accomplish your 
professional objectives, some of which may 
occur daily. This chapter provides an overview 
of the Excel application along with an 
orientation for accessing the commands and 
features of an Excel workbook. 

As workflow develops to include more 
automation, data analysis tools, and more of 
a focus on business informatics, Excel is 
modifying into a more robust tool. Aspects of 
its functionality, including contents and tasks 
on various toolbar/ribbons, will continue to 
change and add more options for 
intermediate-to-advanced work, such as more 
automation, power queries, and AI-assisted 
analysis with CoPilot. We are not covering these 
in this textbook. 

Excel Prep 

Microsoft® Excel® is a ‘spreadsheet’ program/
application. Spreadsheets tend to be 
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applications for mainly quantitative 
information (analysis, computations) although 
many spreadsheets may not actually compute 
anything at all. 

Taking a very simple view, Excel is a tool that 
allows you to enter quantitative data into an 
electronic spreadsheet to organize it and to 
apply one or many mathematical 
computations. These computations ultimately 
convert that quantitative data into information 
for data analysis and decision-making. The 
information produced in Excel can be used to 
make decisions in both professional and 
personal contexts. For example, employees can 
use Excel to determine how much inventory to 
buy for a small business retailer, to calculate 
grades for students in a course, or how much 
money to spend to stay within a budget. With 
respect to personal decisions, you can use 
Excel to determine how much money you can 
spend on a home, how much you spend on 
car lease payments, or how much you need to 
save to reach your retirement goals. So, let’s get 
started! 
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Starting the Excel application 

• This content will focus on the full 
installation of the complete Excel 
application on a computer setup, such as 
your home desktop machine, your 
travelling laptop, and workplace / school 
use from server installations. The process 
for using Excel Online and mobile device 
smaller Excel apps will be different and not 
focused on here. 

• Note: Spreadsheet = worksheet, or 
workbook (file with one or more 
worksheets) 

ACTION: Try Me activity 

• Locate Excel on your computer. This can 
be done with your computer’s search tool 
so that you can locate the application icon. 

• Click Microsoft Excel icon/execution file to 
launch the Excel application. You will then 
be presented with workbook options to 
help get you started. 

• Options will include a Blank workbook, 
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tours of program information, templates 
installed with your application, and the 
choice of opening an existing Excel file. 

• New Excel workbooks start with a blank 
file of worksheet(s) – which are like tabbed 
pages for you to start new work. 

• Existing files can be opened from your 
computer, an external drive, and an online 
source like OneDrive (if you have/use that). 

• For now, choose Blank Workbook, which 
should open a new, blank workbook with a 
default of 3 Sheet tabs. 

Excel for Windows vs Excel for 
Mac 

The Excel for Windows and Excel for Mac 
software versions are very similar, although the 
Mac version can be a little behind in all the 
options and features available and may use 
different names/phrasing. Most of the features, 
tools and commands are available in both 
versions. There are, however, some differences 
with the Excel interface. There are also a few 
features that are not available in the Excel for 
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Mac version. The screenshots and step-by-step 
instructions in this textbook are specific to 
Excel for PC Windows. This book attempts to 
provide alternate screenshots and instructions 
for the Mac version when the differences are 
significant, and if there is no Mac Users option 
mentioned the steps should be the same as for 
PCs. 

TIP: Microsoft Updates. Information/MS 
features can and do routinely change as 
the current SaaS online application 
version adjusts the MS Office programs 
when Microsoft makes modifications. 

The Excel Workbook 

A workbook (spreadsheet file) is an Excel file 
that contains one or more worksheets (which 
are like separate pages in a file folder). Excel 
will assign a default file name to the workbook, 
such as Book1, Book2, Book3, and so on, 
depending on how many new workbooks are 
opened. See image below. 
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The images below show a blank workbook 
after starting Excel and choosing Blank 
workbook. Take some time to familiarize 
yourself with this screen. Your screen may be 
slightly different based on the version you’re 
using. 

TIP: Excel for Mac. This textbook won’t 
usually have comparison images for 
Excel for the Mac. However, if you have 
trouble finding something, use the 
Excel for Mac HELP area to ask and the 
program should link to Excel for Mac 
information to help you. 

When your workbook opens, it should open 
with a default of 3 worksheets (named Sheet1, 
Sheet2, Sheet3) and you will be on the first 
worksheet. Your worksheet should already be 
maximized (or shown at full size) once Excel 
is started. However, if your screen looks it is 
undersized after starting Excel, you should click 
the maximize button. 

Your worksheet has various spaces to keep in 
mind. 
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MedAttrib: author-generated. MS Excel for 
Windows User Interface. 

MedAttrib: author-generated. MS Excel for Mac 
User Interface. 

• The program frame, which in Excel is 
usually medium green in color, has a top 
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bar which will show the name of the 
workbook, the Quick Access Toolbar (if you 
use one), a search bar, and some 
application window sizing (minimize, full 
size, and exit) buttons. Note that recent 
updates to MS Office 365 may default the 
program frames to white, not green. 

• The menu bar, which shows menu items 
(like Home), will also display a contextual 
ribbon of tool icons below it. 

• A bar that shows a cell address field, a 
function selector area, and the formula 
bar, which displays the content of active 
worksheet cells and also formulas you use. 

• The worksheet working space, which by 
default shows the faint outlines of cells 
that make up rows and columns. The 
working space also shows a tab at the 
bottom of it that will be where you can 
rename the active worksheet. More than 
one tab indicates that you have more than 
one worksheet in your workbook file. 

• A Status Bar at the bottom of the 
application displays Excel messages, 
viewing options, and a slider to increase or 
decrease the magnification of the 
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worksheet’s working space. This can be 
customized. 

Navigating Worksheets 

In Excel, spreadsheet files are called 
workbooks, and their native saved format will 
be .xlsx. An Excel workbook contains tabbed 
pages called worksheets. A worksheet is like a 
section in a file folder and can also feel like a 
page, and a worksheet itself can actually have 
many pages once printed out or saved in a 
PDF. On the screen the worksheet will present 
as a single ongoing document with many 
columns (fields) and rows (records) of cells in 
which to add and work with data. 

Data are entered and managed in cells by 
entering numeric and non-numeric data. Each 
cell in an Excel worksheet contains an 
identification address, which is defined by a 
column letter followed by a row number. For 
example, the top left cell A1. This would be 
referred to as cell location A1 (or cell reference 
A1) – Column A Row 1. You can navigate in an 
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Excel worksheet with your mouse pointer or 
using the arrow buttons on your keyboard. 

ACTION: Try Me activity, continued 

• In the blank workbook, place your mouse 
pointer over cell A1 and click. 

• Check to make sure column letter A and 
row number 1 are highlighted – they 
should appear a slightly different intensity 
of gray than the rest of the column and 
row address segments. 

• Look at the application’s upper left field 
(below the ribbon) where you should see 
A1 in the Name Field. 

• Move the mouse pointer to cell D6. 
• Click and hold the left mouse button and 

drag the mouse pointer back to cell A1. 
• Release the left mouse button. You should 

see several cells highlighted because you 
‘selected’ them. IF you have trouble 
holding and dragging, you can instead 
select cell A1, then press and hold the Shift 
key, then click the cell D6. This will also 
select the same set of cells. They will be 
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cells A1-D6. 

This is referred to as a cell range and would 
be documented in formulas and reference as: 
A1:D6. Any two cell locations separated by a 
colon are known as a cell range. The first cell is 
the top left corner of the range, and the second 
cell is the lower right corner of the range. This 
is important because cell ranges will be an 
important part of formulas later on. 

TIP: Cell Ranges in this book. This book 
will refer to cell ranges as Cells XX-XX, or 
Cells XX through XX when you need to 
take some action. When you see Cells 
XX:XX, that usually refers to how Excel 
shows the range reference in a formula/
function. 

Keyboard Shortcuts > Worksheet 
Navigation 

• Use the arrow keys on your keyboard to 
select (activate) cells on the worksheet. 

• Hold the SHIFT key and press the arrow 
keys on your keyboard to highlight a range 
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of cells in a worksheet. 
• Hold the CTRL key while pressing the 

PAGE DOWN or PAGE UP keys to open 
other worksheets in a workbook. 

• Mac Users: Hold down the Function (Fn) 
and CMD keys and press the left or right 
arrow keys 

The Excel Ribbon 

Excel’s features and commands are found in 
the Ribbon, which is the upper area of the Excel 
screen that contains several menu tabs 
running across the top. Each tab provides 
access to a contextual set of Excel commands. 
In this book, Ribbon, Ribbon Tabs, and Menu 
will be used interchangeably, as they often are 
in a workplace. 

• The older dropdown menu structure is still 
available with Excel for Mac. 

• The specific commands and tools within 
each tab are slightly different between the 
two Excel ribbons. Some of the commands 
found within the Excel for Windows ribbon 
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tabs are located within the dropdown 
menu structure in the Excel for Mac 
version. So, if you can’t find the tool on the 
Excel for Mac ribbon, then try to find the 
tool by looking through the dropdown 
menu instead. You may also need to 
Google to ask. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Ribbon. 

Group title names on the Excel 
menu ribbon 

If you look closely at the Excel ribbons/tabs  you 
will see that the ribbon is separated in groups 
of tool buttons, and each group has a title 
name. For instance, on the Home ribbon/tab, 
the group title names are “Clipboard”, “Font”, 
“Alignment”, “Number”, “Styles”. “Cells,” 
“Editing”, etc. The tool buttons within each 
group are all related to the group title. In this 
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book, instructions will usually point you to the 
Ribbon/Tab and specific Group name to help 
you find the right icon / command to use. 
Ribbon and Tab will be used interchangeably. 

Mac Users: The default “View” for the Excel for 
Mac ribbon does not display these group title 
names. It is a good idea to change this view 
so you can see the group title names. Here are 
steps. 

• Click the Excel menu option at top left 
above the ribbon 

• Choose Preferences 
• Click the “View” button 
• Scroll down and check the box for Group 

Titles 
• Close the View dialog box. The group title 

names should now display as shown above 

Overview for each tab of the 
ribbon 

• File: Also known as the Backstage view of 
the Excel workbook (Windows PC). 
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Includes all commands for opening, 
closing, saving, and creating new Excel 
workbooks. Includes print commands, 
document properties, e-mailing options, 
and help features. The default settings and 
options are also found in this tab. MAC 
users will have to find these spread out in 
different ribbons (such as File/Preferences) 
and in the Apple menu for the program. 

• Home: Includes the most frequently used 
Excel commands. Formatting commands 
are found in this tab along with 
commands for cutting, copying, pasting, 
and for inserting and deleting rows and 
columns. 

• Insert: Used to insert objects such as 
charts, pictures, shapes, tables, Pivot 
tables, Internet links, symbols,  and text 
boxes. 

• Page Layout: Includes commands used to 
prepare a worksheet for printing/
distribution. Also includes commands 
used to show and print the gridlines on a 
worksheet. 

• Formulas: Includes commands for adding 
mathematical functions to a worksheet. 
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Also contains tools for auditing 
mathematical formulas. 

• Data: Includes commands used when 
working with external data sources such as 
Microsoft® Access®, Azure, text files, or the 
Internet. Also contains sorting commands 
and access to scenario tools. 

• Review: Includes Spelling and Track 
Changes features. Also contains protection 
features to password protect worksheets 
or workbooks. 

• View: Used to adjust the visual appearance 
of a workbook. Common commands 
include the Zoom and Page Layout view. 

• Automate: This is a fairly new ribbon 
designed for tasks that use scripts and 
macros. Good for large spreadsheet work, 
not covered in this book. 

• Help: Provides access to help and support 
features such as contacting Microsoft 
support, sending feedback, suggesting a 
new feature, and community discussion 
groups. This tab is not available with Excel 
for Mac. 

• Draw: Provides drawing options for using a 
digital pen, mouse or finger depending on 
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the type of device (laptop with touch 
screen, tablet, computer, etc.). This tab is 
not visible by default and this book does 
not cover it. See below on how to 
customize the ribbon to add or remove 
tabs. 

• Developer: Provides access to some 
advanced features such as macros, form 
controls, and XML commands. This tab is 
not visible by default and this book does 
not cover it. 

• See below on how to customize the ribbon 
to add or remove tabs. 

The ribbon defaults to full, or maximized. The 
benefit of having a full ribbon is that the 
commands are always visible while you are 
developing a worksheet. However, depending 
on the screen dimensions of your computer, 
you may find that the ribbon takes up too 
much vertical space on your worksheet. If this 
is the case, you can minimize the ribbon by 
clicking the Ribbon Display Options button at 
the top near right of the application; a recent 
update has changed this to let you choose Full 
Screen mode, which you can exit by electing 
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three dots at the upper left of the screen to 
show other Screen View options for the 
ribbons/tabs. When minimized, the ribbon will 
show only the tabs and not the command 
buttons. When you click on a tab, the 
command buttons will appear until you select 
a command or click anywhere on your 
worksheet, then the ribbon will hide again. 

Keyboard Shortcuts > Minimizing or 
Maximizing the ribbon. Toggle: Hold 
down the CTRL key and press F1 key. 
Mac: CMD and Option keys and press R 
to minimize, and do this again to 
maximize. 

The File Backstage 

The File tab (on the MS Windows PC operating 
system) is also known as the Backstage view of 
the workbook. It allows you to do tasks related 
to the management of your file. It does not 
display a ribbon like the other menu tabs. 
Instead, it includes a left-hand bar that shows 
a variety of features and commands related to 
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the workbook that is currently open, to new 
workbooks, and/or to workbooks stored in 
other locations on your computer or network. 
To leave the Backstage view and return to the 
worksheet, click the arrow in the upper left-
hand corner. 

MAC USERS: You can find some of this same 
information – though it will look different – by 
accessing your Excel File/Preferences option, 
and selecting from the choices there. 

• 

MedAttrib: author-generated. MS Excel for 
Windows PC OS Backstage Info page. 
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NOTE: Mac users do not have this same 
Backstage view. Instead, they will need to look 
for related items using their Apple menu’s 
Excel area, and other Excel ribbon tabs – like for 
preferences, views, etc. 

MedAttrib: author-generated. MS Excel for 
Windows MAC OS Info panels. 

ACTION: Try Me, continued. 

Included in the File tab are the default settings 
for the Excel application that can be accessed 
and modified by clicking the Options button, 
which may be hidden and require you to select 
“more” at the bottom of the left-hand menu 
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to see the choice for Options. This shows the 
Excel Options window, which gives you access 
to settings such as the default font style, font 
size, and the number of worksheets that 
appear in new workbooks. 

Excel has a number of defaults that the 
program starts with, and you can change these 
as you become familiar with the way you would 
like to work with your files, such as how you 
would like to view, save, backup, and set other 
standards. You need to explore this for yourself 
to get familiar with what is available
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Options Window for Windows PC. 

Mac Users: To access these same options in 
Excel for Mac, you need to click the “Excel” 
menu option and choose “Preferences.” 

Customize the Excel ribbon 

You can customize the Excel ribbon for any or 
all of the menu tabs; however, unless you are 
a proficient power-user of Excel, this is not 
recommended because you may move or hide 
important things and need to reset the Ribbon 
to default to find them again. The instructions 
below will also work for customizing the Quick 
Access Toolbar, which shows in the top green 
bar of the Excel Application if there are 
selections in it. The Quick Access Toolbar is 
more nimble and less risky to personalize than 
the actual program ribbons. 

Here are the steps to add additional tabs to the 
Excel ribbon: 

• Click the File tab and choose More (if 
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needed) Options 
• Click on “Customize ribbon” (or Customize 

Quick Access Toolbar) at the left side of the 
Options screen 

• Click the checkbox next to the Tab name 
that you want to add. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Customizing the ribbon. 
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Quick Access Toolbar 

The Quick Access Toolbar is found at the upper 
left side of the Excel screen above the ribbon. 
This area provides access to the most 
frequently used commands, such as Save and 
Undo. You also can customize the 

Quick Access Toolbar by adding commands 
that you use on a regular basis. By placing 
these commands in the Quick Access Toolbar, 
you do not have to navigate through the ribbon 
to find them. To customize the Quick Access 
Toolbar, use the same process as for 
customizing the ribbon, which will open a 
menu of commands that you can add to the 
Quick Access Toolbar. If you do not see the 
command you are looking for on the list, select 
the More Commands option. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Customizing the Quick Access 
Toolbar. 

Right-Click Menus 

In addition to the ribbon and Quick Access 
Toolbar, you can also access many commands 
by right clicking anywhere on the worksheet, 
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which will enable a dropdown menu (often 
contextual) of choices that are relevant to what 
you need to accomplish. 

Mac Users: There is no “Right-click” option for 
Excel for Mac. Instead, hold down the Control 
key and click the mouse button. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel’s Right-Click dropdown menu. 
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Saving Workbooks 

Once you create a new workbook, you will need 
to change the file name and choose a location 
on your computer or network to save that file. 
It is important to remember where you SAVE 
your workbooks, so that you can easily find 
them again. The process of saving can be 
different with different versions of Excel. Please 
be sure you follow the steps for the version of 
Excel you are using. The following steps 
generally explain how to save a new workbook 
and assign it a file name. 
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TIP: Save Work Immediately and Often. 
BEFORE you do any work in a new 
workbook, make a habit of naming and 
saving your file right away so that you 
can find it again easily if interrupted or 
if some technical glitch happens while 
you are working. Then SAVE your work 
frequently so your changes are updated 
and saved. The Quick Access Toolbar 
shows a little disk icon, and the 
common keybind is CTRL S / Mac: CMD 
S. 

• If you have not done so already, open a 
blank workbook in Excel. 

• Click the File tab and then the Save As
button in the left side of the Backstage 
view window. This will open the Save As
dialog box. 

• Determine a location for saving on your 
computer by looking for and clicking the 
Browse button to open the Save As dialog 
box. 

• Click in the File Name box near the bottom 
of the Save As dialog box. I recommend 
you give the file a name such as: 
Ch1-ExcelIntro.docx 
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• Review the settings in the screen for 
correctness and click the Save button. 
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TIP: Save Locations. It is not good to use 
the default save location in Excel. A 
professional tip is that you should get 
into the habit of setting up a directory 
on your hard drive which allows you to 
save important documents. And/or get 
into the habit of saving your documents 
with the other documents of any 
project / course / workspace you set up 
for your workflow, like the files for the 
same class, or files for the same 
accounting client, etc. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel’s Save As Dialog entries. 

Keyboard Shortcuts > Save. CTRL S / 
Mac CMD S 

The Status Bar 

The Status Bar is located below the worksheet 
tabs on the Excel screen. It displays a variety of 
information, such as the status of certain keys 
on your keyboard (e.g., CAPS LOCK), the 
available views for a workbook, and the 
magnification of the screen. You can customize 
the Status Bar as follows: 

• Place the mouse pointer over any area of 
the Status Bar and right click to display the 
“Customize Status Bar” list of options. 

• Mac Users: use “Control-click” on the 
Status Bar to display the “Customize 
Status Bar” options. 

• Select your preferred option from the 
menu. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel’s Customizing the Status Bar. 

Excel Help 

The Excel Help feature provides extensive 
information about the Excel application. 
Although some of this information may be 
stored on your computer, the Help window will 
automatically connect to the Internet, if you 
have a live connection, to provide you with 
resources that can answer most of your 
questions. You can open the Excel Help 
window by clicking the question mark in the 
upper right area of the screen or ribbon. With 
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newer versions of Excel, use the query box to 
ask your question and select from helpful 
option links or select the question mark from 
the dropdown list to launch Excel Help 
windows. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel’s Help Window. 

Keyboard Shortcuts > Excel Help. F1 key. 
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Chapter 2: Data 
Input / Editing 

What We’ll Cover >>> 

• Entering Data 
• Editing Data 
• Auto Fill 
• Deleting Data 
• Adjusting Columns/Rows 
• Hiding and Unhiding Columns/Rows 
• Inserting Columns/Rows 
• Moving Data 
• Deleting Columns/Rows 

In this section, we will begin the development 
of a worksheet. The skills covered in this section 
are typically used in the early stages of creating 
one or more worksheets in a workbook. 

Part of what we will cover here is inputting 
data. However, Excel can import data from 
other sources, like databases and other 
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programs. We will look at data imports in Part 
2. For now, we are simply getting used to the 
basics of Excel with more straightforward files 
and data input. 

Let’s clarify what data in Excel actually means. 
The contents of any cell are referred to as the 
value in that cell – whether it is qualitative text 
or the quantitative returned information from 
a formula. Values in Excel include: 

• Text: Plain text is static. It contains some 
combination of letters, numbers, spaces, 
and symbols. It is descriptive/
informational, and in itself doesn’t provide 
the values of a formula. Text remains 
constant when it is used in a formula. 

• Number: Numbers are data that is acted 
upon in formulas. They can be formatted 
to be different kinds of numbers, like 
currency, percentages, etc. They are what 
most formulas calculate with in order to 
give an answer and/or transform their 
meaning. 

• Logical: Data in this type is either TRUE or 
FALSE, usually as the result of a test or 
comparison from a formula. 
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• Error: A value that returns if a formula 
cannot complete calculations properly. 

Entering Data 

Entering data in Excel is very unlike the type 
and enter experience you may have with word 
processing documents, presentation files, and 
web page text entry fields. Excel basically has 
to use information in little pieces in order to 
calculate with it, sort it, filter it, and otherwise 
analyze it. For instance, if you type a person’s 
name and address all in one line or worksheet 
cell, it can only be sorted by the very first letter, 
not the address, or zip code, or last name, etc. 

This means that you will need to become 
comfortable with using cells, which is the 
medium with which Excel can identify pieces of 
data and use them. 

Columns of cells tend to be referred to as fields 
of information. Rows of cells ten to be referred 
to as records of data. So: 

• A person’s first name in a column is an 
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entry in the column’s field. A column can 
have multiple fields (instances) of data, like 
a column of first names in a range of data. 
In the image below, Column A fields 
contain first names, like L.J., Alfre, Jonna, 
etc. 

• A person’s row of information, like first and 
last name, email address, and favorite 
dessert, is a record for that one person. A 
data range is usually made up of many 
records. In the image below, the Row 1 
record contains data like Ajay Bashira 
apple juice, etc. 

ACTION: Try Me activity 

• Follow along and try things. There is no 
“wrong”, this is just play and exploration! 
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MedAttrib: author-generated. MS Excel cells, 
rows, and columns. 

Plain Data 

• BEFORE you do this activity, make sure 
you have taken the Preparation Steps in 
the Part 1 Introduction of this book – about 
creating file folders on your computer and 
downloading available files for later use. 
OR, if you have an instructor who 
requires other file folder organization 
and file naming standards, do that 
instead.  Either way allows you to have a 
safe place to save your files of work while 
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you explore this content – your Examples 
folder. 

• Once you have a storage space to save 
your work, Create a new, blank workbook 
in Excel. 

• Immediately give it a name and save it to 
your chosen working directory folder on 
your computer. File naming 
recommendation: Ch2-DataEntry.xlsx. 

• Click cell A2. 
• Type your own first name in cell A2, then 

press the ENTER key. After you press the 
ENTER key, cell A3 will be activated. Using 
the ENTER key is an efficient way to enter 
data vertically down a column. 

• Enter the following first names, pressing 
ENTER after each: A3=Alfre, A4=Jonna, 
A5=Patrick, A6=Julio, A7=Ajay 

• Click cell B2. 
• Type your own last name and press the 

ENTER key. After you press the ENTER key, 
cell B3 will be activated. 

• Type the name DuShayne into cell B3 and 
press the ENTER key. Do this with the rest 
of the names through cell B7: Mills, 
McNeill, Mendez, Bashira 
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• Click cell C2. 
• Type the number 50 and press the ENTER 

key. 
• Enter the following numbers in cells C3 

through C7: 75, 180, 65, 48, 125 
• SAVE your work as you go: the Quick 

Access Toolbar shows a little disk icon, and 
the common keybind is CTRL S / Mac: 
CMD S. 

MedAttrib: author-generated. MS Excel cells, 
rows, and columns. 

TIP: Avoid formatting symbols when 
typing numbers. When typing numbers 
into an Excel worksheet, it is best to 
avoid adding any formatting symbols 
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such as dollar signs and commas – just 
type in the numeric data itself. 
Although Excel allows you to add these 
symbols while typing numbers, it slows 
down the process of entering data. It is 
more efficient to later use Excel’s 
formatting features to add these 
symbols to numbers after you type 
them into a worksheet. 

Column Headings 

In Excel, data rarely means anything to a user 
if there is no context attached to it. Commonly 
this is done through column headings, which 
identify what the content in the column is 
supposed to be. This can also be done as row 
headers instead, but in this course we’ll mostly 
use the standard column headings. 

In the image above, you likely also saw a row 
of bold text in cells A1-C1. These are column 
headers, and you can type them: 

• In cell A1, type Fname, then press TAB. Tab 
lets you move to the right of an active cell 
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and activate the next one to its right for 
data entry. 

• In cell B1, type Lname and press TAB. 
• In cell C1, type DrinkBudget, and press 

TAB. 
• In cell D1, type FaveDrink, and press TAB. 
• In cell E1, type Month and press TAB. 

These are the column headings that tell you 
the first column is full of first name fields, the 
second column is full of last names, and the 
third column has amounts for a coffee budget, 
etc. 

Editing Data 

Data that has been entered in a cell can be 
changed by double clicking the cell location 
or by selecting the cell but typing data into 
the Formula Bar. You may have noticed that as 
you were typing data into an cell location (like 
A2), the data you typed also appeared in the 
Formula Bar. The Formula Bar can be used for 
entering data into cells as well as for editing 
data that already exists in a cell. The following 
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steps provide an example of entering and then 
editing data that has been entered into a cell 
location: 

• Click cell D2. 
• Type Moc and press the ENTER key. 
• Click cell D2 again to select it. 
• Move the mouse pointer up to the 

Formula Bar. You will see the pointer turn 
into a cursor. Move the cursor to the end of 
the abbreviation Moc and left click. 

• Type the letters ha to complete the word 
Mocha. 

• Click the check mark to the left of the 
Formula Bar. This will enter the change 
into the cell. 

• Use this method – clicking a cell but typing 
into it through the Formula Bar – to add 
coffee beverages you see in the Try Me 
image (above) into cells D3-D7. 

• SAVE your work as you go: the Quick 
Access Toolbar disk icon, and keybind is 
CTRL S / Mac: CMD S. 

Keyboard Shortcut: Editing Data in a 
Cell. Activate the cell that is to be edited 
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and press the F2 key. 

Auto Fill 

The Auto Fill feature is a valuable tool when 
manually entering data into a worksheet. It is 
sometimes referred to as Smart Fill.  This 
feature has many uses, but it is most beneficial 
when you are entering data in a defined 
sequence, such as the numbers 2, 4, 6, 8, and 
so on, or nonnumeric data such as the days 
of the week or months of the year. It does not 
work for all seemingly consistent series – just 
for simple ones. 

The following steps demonstrate how Auto Fill 
can be used to enter the months of the year in 
column E: 

• Click cell E2 in the Sheet1 worksheet. 
• Type the word January and press the 

ENTER key. 
• Click cell E3 and type February, then Press 

Enter. 
• Click cell E4 and type March, then Press 
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Enter. 
• Move the mouse pointer to the lower right 

corner of cell E4. You will see a small 
square in this corner of the cell; this is 
called the Fill Handle. When the mouse 
pointer gets close to the Fill Handle, the 
white block plus sign will turn into a black 
plus (+) sign. 

• Left click and drag the Fill Handle down 
through cell E13. Notice that the Auto Fill 
tip box indicates what month will be 
placed into each cell. Release the mouse 
button when the tip box reads 
“December.” 

Once you release the left mouse button, 12 
months of the year should appear in the cell 
range E2:E13. You will also see the Auto Fill 
Options button. By clicking this button, you 
have several options for inserting data into a 
group of cells. 

• SAVE your work as you go: the Quick 
Access Toolbar disk icon. Keybind is CTRL S 
/ MAC: CMD S. 
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Deleting Data 

There are several methods for removing data 
from a worksheet, and with each method, you 
use the Undo command if you change your 
mind. This is a helpful command in the event 
you mistakenly remove data from your 
worksheet. 

You can delete data by selecting a cell and 
using your keyboard’s Delete button. You can 
right-click on a cell and choose Delete. You can 
select a cell and use the Home tab Editing 
group and choose the Clear icon, then Clear all. 

• Select Cells E8 through E13. 
• Press the DELETE key / Mac FN key + 

Delete. This deletes the contents of those 
cells. 

• So that we can recover that information, 
click the Undo button – which is by default 
available in the Quick Access Toolbar. This 
should replace the data in the cells E8-E13. 

• To re-delete the info, Use the Home tab 
Editing group and choose the Clear icon, 
then Clear all. 
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Keyboard Shortcut: Undo. CTRL key + Z 
key / Mac CMD key + Z key. 

Adjusting Columns/Rows 

TIP: Column and Row Addresses. Every 
row has an address – the gray “cell” 
number to the left of the editable part 
of your worksheet. Every Column has 
one too, the gray “cell” letter just above 
the editable part of your worksheet. You 
click on these to select a whole row or 
column. 

There may be a few entries in a worksheet that 
appear cut off. This is because the column is 
too narrow for the contents. The columns and 
rows on an Excel worksheet can be adjusted to 
accommodate the data that is being entered 
into a cell using  different methods. The 
following steps explain how to adjust the 
column widths and row heights in a 
worksheet. 

• Bring the mouse pointer between column 
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A and column B in the Sheet1 worksheet. 
You will see the white block plus sign turn 
into double arrows. 

• Click and drag the column edge to the 
right so the entire column looks like it is 
about 2 inches wide. As you drag the 
column, you will see the column width tip 
box. This box displays the number of 
characters that will fit into the column 
using the Calibri 11-point font which is the 
default setting for font/size. If you are 
using a different font size as a default, then 
you will have a wider column as a result. 

• Release the left mouse button. 

You may find that using the click-and-drag 
method is inefficient if you need to set a 
specific character width for one or more 
columns. This is a second method for adjusting 
column widths when using a specific number 
of characters: 

• Click any cell location in column A by 
moving the mouse pointer over a cell 
location and clicking the left mouse 
button. You can highlight cell locations in 
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multiple columns if you are setting the 
same character width for more than one 
column. 

• In the Home tab of the ribbon, left click 
the Format button in the Cells group. 

• Click the Column Width option from the 
drop-down menu. This will open the 
Column Width dialog box. 

• Type the number 29 and click OK on the 
Column Width dialog box. This will set 
column A to this character width. 

A third method is the double-click one: 

• Once again bring the mouse pointer 
between column A and column B so that 
the double arrow pointer displays ,and 
then double-click to activate AutoFit. This 
features adjusts the column width based 
on the longest entry in the column. 

Row Height adjustment works similarly. Steps 
1 through 4 demonstrate how to adjust row 
height, which is similar to adjusting column 
width: 

• Click cell A1. 
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• In the Home tab of the ribbon, left click 
the Format button in the Cells group. 

• Click the Row Height option from the 
drop-down menu. This will open the Row 
Height dialog box. 

• Type the number 24 and click OK on the 
Row Height dialog box. This will set Row 1 
to a height of 24 points. A point is 
equivalent to approximately 1/72 of an 
inch. This adjustment in row height was 
made to create space between the totals 
for this worksheet and the rest of the data. 

Now, to adjust the row with the autofit option: 

• Bring the mouse pointer between row 1 
and row 2 so that the double arrow pointer 
displays, and then double-click to activate 
AutoFit. This features adjusts the row 
width based on the largest entry in the 
row. 

• SAVE your work as you go: the Quick 
Access Toolbar disk icon, and keybind is 
CTRL S / Mac: CMD S. 

Keyboard Shortcut: Column Width. Hold 

Chapter 2: Data Input / Editing  |  53



ALT key then press letters H, O, and W 
one at a time. Mac Users: not available. 

Keyboard Shortcut: Row Height. Hold 
ALT key then press letters H, O, and H 
one at a time. Mac Users: not available. 

Hiding and Unhiding Columns/
Rows 

In addition to adjusting the columns and rows 
on a worksheet, you can also hide them. This 
is a useful technique for enhancing the visual 
appearance of a worksheet that contains data 
that is not necessary to display but which is 
otherwise needed for computations and/or 
storage. 

• Click cell C1. 
• Click the Format button in the Home tab 

of the ribbon. 
• Place the mouse pointer over the Hide & 

Unhide option in the drop-down menu. 
This will open a submenu of options. 
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• Click the Hide Columns option in the 
submenu of options. This will hide column 
C. 

To unhide a column – like the now hidden 
column C – follow these steps: 

• Select the columns B and D, which now 
seem to be right next to each other. 

• Click the Format button in the Home tab 
of the ribbon. 

• Place the mouse pointer over the Hide & 
Unhide option in the drop-down menu. 

• Click the Unhide Columns option in the 
submenu of options. column C should now 
be visible on the worksheet. 

Keyboard Shortcut: Hiding Columns. 
Hold down CTRL key while pressing the 
number 0 on your keyboard. 

Keyboard Shortcut: Unhiding Columns. 
Highlight cells on either side of the 
hidden column(s), then hold down CTRL 
key & SHIFT key while pressing the close 
parenthesis key ). MAC: Hold down 
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Control and Shift keys and press the 
number 0. 

The following steps demonstrate how to hide 
rows, which is similar to hiding columns: 

• Click row 3. 
• Click the Format button in the Home tab 

of the ribbon. 
• Place the mouse pointer over the Hide & 

Unhide option in the drop-down menu. 
This will open a submenu of options. 

• Click the Hide Rows option in the 
submenu of options. This will hide row 3. 

To unhide a row, follow these steps: 

• Select the rows 2-4, which will seem to be 
right next to each other. 

• Click the Format button in the Home tab 
of the ribbon. 

• Place the mouse pointer over the Hide & 
Unhide option in the drop-down menu. 

• Click the Unhide Rows option in the 
submenu of options. Row 3 will now be 
visible on the worksheet. 
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Keyboard Shortcut: Hiding Rows. Hold 
down CTRL key while pressing number 
9 key on your keyboard. 

Keyboard Shortcut: Unhiding Rows. 
Highlight cells above and below the 
hidden row(s), then hold down CTRL key 
& SHIFT key while pressing the open 
parenthesis key ( . MAC: Hold down 
CTRL + SHIFT keys and press the 
number 9. 

TIP: Hidden Rows and Columns. In most 
careers, it is common for professionals 
to use Excel workbooks that have been 
designed by a coworker. Before you use 
a workbook developed by someone 
else, always check for hidden rows and 
columns. You can quickly see whether a 
row or column is hidden if a row 
number or column letter is missing. 

Inserting Columns/Rows 

Using Excel workbooks that have been created 
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by others is a very efficient way to work 
because it eliminates the need to create data 
worksheets from scratch. However, you could 
realize that to accomplish your goals, you may 
need to add additional columns or rows of data. 
In this case, you can insert blank columns or 
rows into a worksheet. The following steps 
demonstrate how to do this: 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Insert Button (Down Arrow). 

• Click cell C1. 
• In the Home tab of the ribbon, click the 

down arrow on the Insert button. 
• Click the Insert Sheet Columns option 

from the drop-down menu. A blank 
column will be inserted to the left of 
column C. The contents that were 
previously in column C now appear in 
column D. Note that columns are always 
inserted to the left of the activated cell. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Insert Drop-Down Menu. 

To insert a row with the same kind of process: 

• Click cell A3. 
• in the Home tab of the ribbon, click the 

down arrow on the Insert button. 
• Click the Insert Sheet Rows option from 

the drop-down menu. A blank row will be 
inserted above row 3. The contents that 
were previously in row 3 now appear in row 
4. Note that rows are always inserted 
above the activated cell. 

• SAVE your work as you go: the Quick 
Access Toolbar disk icon, and keybind is 
CTRL S / Mac: CMD S. 
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Keyboard Shortcut: Inserting Columns. 
Press the ALT key and then letters H, I, 
and C one at a time. MAC: First hold 
down the Control key and press the 
spacebar to select the column; then 
hold down the Shift and Controls keys 
and press the + symbol. 

Keyboard Shortcut: Inserting Rows. 
Press ALT key and then letters H, I, and 
R one at a time. MAC: First hold down 
Shift key and press spacebar to select 
row; then hold down Shift & Controls 
keys and press the + symbol. 

Moving Data 

Once info is entered into a worksheet, you 
have the ability to move it to different 
locations. The following steps demonstrate 
how to move data to different locations on a 
worksheet: 

• Select the data range cells A1-D7. 
• Bring the mouse pointer to the left edge of 
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cell D7. You will see the white block plus 
sign change to cross arrows. This indicates 
that you can left click and drag the data to 
a new location. 

• Left Click and drag the selection so the 
upper left corner is at cell D2. If a context 
menu appears, select “Move Here”; 
otherwise the selection should just be 
moved for you. 

• Release the left mouse button. The data 
now appears starting in column D in cell 
D2 rather than in column A cell A1 where it 
previously was. 

• Click the Undo button in the Quick Access 
Toolbar (or use Ctrl+Z keyboard shortcut). 
This moves the data back to where it 
started in cell A1. 

• SAVE your work as you go: the Quick 
Access Toolbar disk icon, and keybind is 
CTRL S / Mac: CMD S. 

TIP: Moving Data. Before moving data 
on a worksheet, make sure you identify 
all the components that belong with the 
series you are moving. For example, if 
you are moving a column of data, make 
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sure the column heading is included. 
Also make sure you grab all of the data 
in the range, so you don’t leave 
something out. 

Deleting Columns/Rows 

You may need to delete entire columns or 
rows of data from a worksheet. This need may 
arise if you need to remove either blank 
columns or rows from a worksheet or columns 
and rows that contain data. The methods for 
removing cell contents were covered earlier 
and can be used to delete unwanted data. To 
delete a column: 

• Click cell C1. 
• in the Cells group in the Home tab of the 

ribbon, click the down arrow on the Delete 
button. 

• Click the Delete Sheet Columns option 
from the drop-down menu. This removes 
column C and shifts all the data in the 
worksheet (to the right of Column B) over 
one column to the left. 

Chapter 2: Data Input / Editing  |  63



• Click the Undo button in the Quick Access 
Toolbar (or Ctrl + Z). This returns the 
column you deleted. 

The same process works for deleting and 
undeleting a row: 

• Click cell A3. 
• In the Cells group in the Home tab of the 

ribbon, click the down arrow on the Delete 
button. 

• Click the Delete Sheet Rows option from 
the drop-down menu. This removes row 3 
and shifts all the data (below row 2) in the 
worksheet up one row. 

• Click the Undo button in the Quick Access 
Toolbar (or use Ctrl+Z keyboard shortcut). 
This returns the row you deleted. 

64  |  Chapter 2: Data Input / Editing



Keyboard Shortcut: Deleting Columns. 
Press ALT key and then letters H, D, and 
C one at a time. MAC: Hold down 
Control key and press spacebar to 
select column; then hold down Control 
key & press the – symbol. 

Keyboard Shortcut: Deleting Rows. 
Press ALT key and then letters H, D, and 
R one at a time. MAC: Hold down Shift 
key and press spacebar to select row; 
then hold down Control key & press the 
– symbol. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Delete Drop-Down Menu. 
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FINISHED! 

• SAVE your work by clicking either the 
Save button on the Home ribbon; or by 
selecting the Save option from the File 
menu, or the Quick Access Toolbar disk 
icon, or the keybind CTRL S / Mac CMD S. 
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Chapter 3: Data - 
Formatting for 
Analysis 

What We’ll Cover >>> 

• Text Formatting 
• Cell Merges 
• Dataset Formatting 
• Text Effects 
• Number Formatting 
• (Auto)Sum Feature 

This section addresses formatting commands 
that can be used to enhance the visual 
accuracy and appearance of worksheets. It also 
introduces a very basic mathematical 
calculation. These skills  will highlight how 
Excel can be used to prepare spreadsheets to 
help evaluate information and make decisions 
with the data. 
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ACTION: Try Me activity 

TIP: Working with book files. In each 
chapter’s Try Me activities, you should 
make a copy of the requested data file 
that you extract from this textbook’s 
companion datafiles.zip folder. You 
should save it on your computer so you 
can save your changes, find it again, 
and reference it in the future if needed. 
Learners should use this tip while 
working through Try Me activities in 
each chapter. 

For this chapter, we will use the data file 
Ch3-Format.xlsx in order to demonstrate the 
various steps. For data file download and 
saving information, please refer to the chapter 
Book Resources information. 

Text Formatting 

There are several fundamental formatting skills 
that will be applied to the workbook that we 
are developing for this chapter, like text and 
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number formatting, adding visual touches, a 
basic calculation, etc. The basic worksheet 
formatting tasks can mostly be found on 
Excel’s Home menu Tab/ribbon. Note: this 
chapter focuses on the interface for the MS 
Windows operating system for PC, and Mac 
users will likely see similar icon/commands 
arranged a little differently. 

The Windows for PC Excel’s Home ribbon 
currently has 9 groups of collected commands/
icons. In this series of tasks, we’ll work with the 
Clipboard, Font, Alignment, and Styles groups. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Font Group of Commands. 
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To get started, open the Ch3–Format.xlsx file. 
This is the look we will be working to 
accomplish: 

MedAttrib: author-generated. MS Excel 
Ch3-Format.xlsx final result. 

You will find there is more than one way to 
do most tasks in Excel, and while the work-
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through here may list one method, please 
explore. 

Text size and styles 

First, we’ll work on Row 1, which is a document 
identifier title that lets a viewer know what the 
data they are seeing represents. 

• Select cell A1. When active you will be able 
to see its contents showing in the formula 
bar. 

• With cell A1 active, choose the Text size in 
the Home ribbon’s Font group and select 
18. This makes the text a larger 18pt size. 

• Then, from the same Font group, click the 
buttons for Bold, then Italic, then 
Underline. 
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Keyboard Shortcut: Text Formats. Hold 
down CTRL key while pressing the letter 
B (Bold), or I (Italic) or U (Underline) / 
Mac: hold down CMD key instead. 

Cell and text colors 

You can emphasize a region of a spreadsheet 
by adding color to the cells and/or text. 

• Select the cells A1-F1. You may see the 
contents of only A1 in the formula bar, but 
you should also see a selection outline 
around the 6 cells you chose. 

• Find the paintbucket Fill Color icon on the 
Home ribbon’s Font group, and click the 
down arrow on its right side. This will show 
you a color palette to choose a cell color 
from. 

• If you hover over the colors, a tooltip will 
appear with the color’s information. Click 
on Blue, Accent 5 Darker 25%, which 
should be the second to the last column of 
colors, and second from the bottom of 
that column. OR, choose another dark 
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color you like from the palette. 
• Click only cell A1 again. Then using the 

Font Color button on the ribbon’s Font 
group, click the down arrow on its right 
side. This will show you a color palette to 
choose a text color from. Select White. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Fill Color Palette. 

Merge Cells 

Data is entered solely into one cell at a time, like 
in this activity file example’s rows and columns. 
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However, for stylistic purposes, data can also be 
merged into more than one cell. For instance, 
the Merge & Center command is used to center 
the title of a worksheet directly above columns 
of data. 

• Select cells A1-F1 again. 
• Click the arrow on the Merge & Center 

button in the Font section of the Home 
ribbon to select the Merge & Center 
setting. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Merge Cell Drop-Down Menu. 

• SAVE your work as you go: the Quick 
Access Toolbar shows a little disk icon, and 
the common keybind is CTRL S / Mac CMD 
S. 
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Dataset Formatting 

Header rows 

Any range of data in Excel that you may want to 
sort, filter, and/or calculate is considered to be a 
data set or data range. In order to help a viewer 
know what the data is for, a data range should 
include some kind of  Header Row. This is a row 
that you use to identify the expected contents 
of the columns of data (with the names of the 
columns, like FirstName, LastName, etc,). 
Sometimes you may see instead a header 
column, but for this course the norm will be the 
header row above columns. 

The header row should stand out from the rest 
of the range of data for ease of identification. 
Let’s do that here. 

• Select cells A3-F3. 
• Using the Home tab’s Font group Bold 

icon, make these cells Bold. 
• With the A3-F3 cells still active, click the 

Font group Border button’s arrow and 
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select Bottom Border. 
• SAVE your work as you go: the Quick 

Access Toolbar shows a little disk icon, and 
the common keybind is CTRL S / Mac: CMD 
S. 

Borders 

In Excel, adding custom lines to a worksheet is 
known as adding borders. Borders are different 
from the visually clarifying grid lines that 
appear by default on a worksheet to define the 
perimeter of the cell locations. The Borders 
command lets you add a variety of line styles 
to a worksheet that can make reading the 
worksheet data much easier. Here is a method 
for adding preset borders and custom borders 
to a worksheet: 

• Click the down arrow to the right of the 
Borders button in the Font group  in the 
Home page ribbon. This displays border 
options. At the bottom, the More Borders 
will open a new Interface window called 
Format Cells, with one of the tabs in  it 
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called  border. We won’t use this right now, 
but it’s good to take a look. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Borders Dropdown Menu. 
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Autowidth expansion 

See how the column E for the salary data may 
be showing pound signs (####) in the data 
cells? This #### indicates that a numeric data 
column is too narrow to accommodate the 
data in it. While a text column will show some 
of the data in a too-narrow column (like the 
Address column), Excel can’t do this with 
numbers. Excel can’t do wrap text for numeric 
data, because numeric formats are usually for 
calculations, not just static text information. 

You can fix this issue by widening the column. 
We’ll cover more column-related sizing later, 
but for now, the Autowidth action will suffice. 

• Select the whole Column E – by clicking on 
the E column’s letter E at its top. Your 
cursor tip should then also show a down 
arrow. 

• Slowly move your cursor to the right until 
the tip shows a Crosshair graphic. This 
means you have hovered over the border 
between columns E and F. 

• Double-click while you see this crosshair, 
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and column E should snap to a width that 
shows all the numbers within. You may 
have to try this a few times until you ‘get 
the hang of it’. 

Text Effects 

Alignment of cell content 

The data you input into cells, unless formatted 
into some numeric form, likely defaults to a 
Bottom Alignment and to an Align Left. Any 
workbooks you inherit may change these 
defaults, and/or you may develop a different 
preference for your own work. For this 
worksheet, we’ll go for Top Alignment and 
Align Left. The file we are working with 
currently shows the first two columns are align 
center. 

• Select cell A3, and click the Top Align 
button on the Home ribbon’s Alignment 
group. 

• With A3 still selected, then click the Align
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Left button in the same Alignment group. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Alignment Group in Home Tab. 

You can also change the alignments of several 
cells at one time: 

• Select cells A4-A21. 
• Click the Top Align and Align Left buttons 

again. The rest of the column should now 
look aligned like cell A3. 

• Now, select cells B4-F21, and click the Top 
Align and Align Left buttons again. The 
rest of the table will also be formatted to 
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be top aligned and aligned left. 

There is just one cell that may remain 
unaligned properly: cell B3. Let’s use the Excel 
Format Painter button to fix that. The Format 
Painter button will pick up the formatting of a 
cell, and hold it until you click on another cell to 
‘copy’ the format onto it. 

• Select cell A3. 
• Click once on the Format Painter 

‘paintbrush’ button in the Home ribbon’s 
Clipboard group. 

• Then, click once on cell B3. This should 
copy cell A3’s alignment format onto cell 
B3. 

• SAVE your work as you go: the common 
keybind is CTRL S / Mac: CMD S. 

Wrap text 

Often, a text column may have not be wide 
enough for the information in it, and the text 
information will seem to be cut off. One way 
to fix this is to wrap text so that the cell will 
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increase in size to accommodate the data and 
also push some of the data in what seems like 
a second (or more) line in the same cell. 

• Select cell C4. 
• Click on the Wrap Text button in the 

Home ribbon’s Font group. See how the 
row expands in height to show all the data 
which also now appears to be taking up a 
couple of “lines” of space inside the cell. 

• Now, while cell C4 is still active, click on 
the Format Painter button from the 
Clipboard group. 

• Then, while the Format Painter is active, 
hover then click over cells C5-C21 to apply 
the wrap text to the rest of the column. 

Keyboard Shortcut: Wrap Text. Press 
ALT key and then letters H and W one 
at a time. MAC: N/A 

Number Formatting 

Text is easy to work with in Excel – the program 
just recognizes it as static data that is 
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informational, not computational. However, 
numbers (unless used as dummy text in 
something like an address or phone number) 
are recognized as potential data to calculate. 
There are several types of numeric data that 
Excel recognizes, including: 

• Comma, which adds a comma and a 
decimal point with a default 2 decimals 
after the decimal point. 

• Dates, which offers both long and short US 
date formats. 

• Time, which offers minutes and seconds. 
• Percentage. 
• Currency (discussed below). 
• Accounting money (discussed below). 
• Fraction. 

For this example, let’s first format the Salary 
columns contents with a comma so that the 
numbers look like common ‘thousand’ units. 

• Select cell E4. 
• Look for the Home ribbon’s Number 

group, and click the arrow on its right side, 
which will show a dropdown selection of 
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number formats. 
• Scroll down that list until you find 

Currency, and click on that. The cell’s 
contents should now appear as 
$44,200.00. 

• Let’s take out the “cents” part of that 
number. With cell E4 still active, click twice 
on the Number group’s Decrease Decimal. 
This should remove the .00 from the 
number. 

• You can repeat the Currency format and 
Decrease Decimal steps after you select 
cells E5-E21. 

◦ Alternative method: use the Format 
Painter paintbrush to paint cell E4’s 
format over cells E5-E21. Click once on 
the Format Painter ‘paintbrush’ 
button in the Home ribbon’s Clipboard 
group while cell E4 is active, then paint 
over cells E5-E21. 

• SAVE your work as you go: CTRL S / Mac 
CMD S. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Number Group of Commands. 

Formatting money standard 
practices 

There are accepted professional formatting 
standards when spreadsheets contain only 
currency-related data. For this course, we will 
use the following Excel guidelines for 
formatting. The first image displays how to use 
Accounting number format when ALL figures 
are currency. Only the first row of data and 
the totals should be formatted with the 
Accounting format. The other data should be 
formatted with Comma style. There also needs 
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to be a Top Border above the numbers in the 
total row. If any of the numbers have cents, you 
need to format all of the data with two decimal 
places. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Accounting Standard format. 

Often, an Excel spreadsheet will contain values 
that are both currency and non-currency in 
nature. When that is the case, you’ll want to use 
the guidelines in the following figure: 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Currency/Mixed standard format. 

The Format Cells panel 

This was mentioned above. When you become 
proficient with Excel and the content you plan 
to produce, you can also use a more 
comprehensive Format Cells panel, which has 
several tabs you can choose from while 
formatting a cell or row or column. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Borders Tab of Format Cells Dialog. 

Here, we will add a line to the bottom of the 
data range we have been working on, so that 
you can input some data yourself, then format 
it. First, let’s add another line of data – about 
YOU. 

• Click on cell A22, and type YOUR own first 
name in it. 

• Add more information about yourself in 
cells B22-F22. Other than your own real 
last name, please feel comfortable 
‘making up’ data for the other cells so that 
you preserve your confidentiality. 
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• Once you have your new data entered in 
row 22, click on cell A22. 

• Then, in the Font group on the Home 
ribbon, look for a tiny Font settings arrow 
icon in the Font group’s lower right corner, 
and click on it. This should open the panel 
for Cell Formatting, which has 6 tabs in it: 
Number, Font, Alignment, Border, Fill, 
Protection. 

• Since cell A22 is a static text data, you can 
use the Font and Alignment tabs to look 
at your choices and to change the cell’s 
format. 

• Using the Alignment tab, make the 
contents of cell A22 top aligned and 
aligned left – if it is not already – then click 
Okay. 

• Let’s try an other way. RIGHT-Click on cell 
B22, then scroll down the contextual menu 
until you see the Format Cells option (you 
may have to scroll down the menu list 
since it is near the bottom). Then, click on 
the Format Cells option. The same Format 
Cells panel you have already used will 
open. 

• Using the Alignment tab, make the 
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contents of cell B22 top aligned, aligned 
left if it is not already, then click OK. 

◦ Now, you can use either of these 
options to open the Cell Formatting 
panel as you adjust the formats of cells 
C22-F22. 

• OR, you can just select cells of the row 
above your newly typed row – C21-F21 – 
and click the Format Painter paintbrush 
button on the ribbon, and then paint the 
style over cells C22-F22. 

• SAVE your work as you go: CTRL S / Mac: 
CMD S. 

Special formatting 

Much of your data formatting will be basic 
tasks, like changing the color of the text or cell 
backgrounds, cell/column/row alignments and 
wrap, and selecting basic numeric formats like 
dates, accounting, percentages, etc. However, 
there are a number of basic additional formats 
that Excel lets you customize in cell formatting 
for more complicated needs, like: 
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• Phone numbers 
• Social Security numbers 
• Zip codes 
• Showing negative numbers in stand-out 

formatting 
• Additional date and time formats 
• Additional fraction formats 
• Customized number formats 
• Validation techniques (later chapter) 

These options are shown in the Format Cells 
panel, in the Number tab. 
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MedAttrib: autogenerated. MS Excel Format 
Cells panel. 

Examples: 

Phone number: 2065551234 = (206) 555-1234 

Social Security Number: 2221111234 = 
222-111-1234 

Zip Code + 4: 981012345 = 98101-2345 
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Negative Number (one of the formats): -2700 = 
(2,700) 

Sum Feature 

Applying mathematical computations to a 
range of cells is accomplished through 
functions in Excel, which we will cover in detail 
in Part 4. However, the following steps will 
demonstrate how you can quickly sum the 
values in a column of data using the AutoSum 
command in the Home menu ribbon. It is now 
usually referred to as the Sum button but it 
automatically writes an addition formula for 
you. 

• Click cell E23 in the worksheet. 
• In the Home tab’s ribbon, look for the 

Editing group (more to the right side of 
the ribbon). 

• Look for the button that looks like an and 
reads Sum when you hover over it. Click it 
while cell E23 is active. 

• What you’ll ‘see’ in the Formula Bar: cell 
E23 will turn into a formula – 
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=SUM(E4:E22) – and a dotted border and 
light blue fill will affect the column of 
numbers above it. This is Excel’s way of 
writing a basic addition calculation for 
you. 

• When you press the ENTER key on your 
keyboard, the sum will calculate 
automatically, and add up the numbers in 
the column above cell E23. 

• Now you will see the sum of the salaries of 
the people in the data range we have been 
working with, including the row you input 
about YOU! 

• You should select the cell E23 again, and 
apply the Accounting format to it. 

• SAVE your work as you go: CTRL S / Mac: 
CMD S. 

We are finished with this activity! 
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Chapter 4: Data - 
Conditional 
Formatting 

What We’ll Cover >>> 

• Duplicate Values 
• Text That Contains. . . 
• Ranking Rules 
• Range Conditions 
• Color Scales 
• Data Bars 
• Icon Sets 
• Corrections 

Conditional Formatting in Excel allows you to 
visually identify patterns in data so that it is 
easier to analyze for patterns and trends. You 
can apply conditional formatting to a range of 
cells (either a selection or a named range), an 
Excel table, and in a Pivot table report (in 
Windows, not Mac). 
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NOTE: This chapter is presuming that learners 
are using the default Office color palette that 
Excel opens with. If you are using another one, 
you will need to go into the Page Layout 
ribbon, choose the Colors icon of the Theme 
group, and select Office. 

The important thing with any conditional 
formatting is for it to be useful for observing 
and analyzing data. It should not get in the way 
of the data, or be used in ways that is a barrier 
to anyone with visual divergences who cannot 
see the formatting. Keep your conditional 
formatting very readable with good contrast 
colors and border line thicknesses, wider 
columns if needed, and use of conditions that 
don’t rely solely upon color differentiation to be 
useful. 

ACTION: Try Me activity 

This is what we will achieve in this chapter 
(image below). Please refer to it as you try the 
following activities. The instructions are for 
Windows PC and Mac users may have different 
UI locations for some of the commands. To 
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work along, please download the starter file 
Ch4-Conditional.xlsx, open it, and save a copy 
of it to work on. This file is for Taste du Monde, 
an international specialty foods company, and 
we’ll look at a basic workbook for them. You’ll 
see them again later in the course! 

MedAttrib: author-generated. MS Excel 
Ch4-Conditional.xlsx final result. 

Duplicate Values 

First, let’s look at Duplicate values. Duplicate 
values are something you may need to see to 
determine if there is a pattern or an error in 
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inputting data. Conditional formatting can 
help you “see” these things. 

• Select Cells A6-A33 in the OrderNo 
column. 

• On the Home Menu ribbon, look in the 
Styles group for the Conditional 
Formatting button. 

• Press the button’s down arrow to see the 
choices available. 

• Choose Highlight Cells Rules, then choose 
Duplicate Values. 

• Click OK in the dialog box that appears. 
This will add formatting to cells that seem 
to be duplicates of other cells in the same 
column. 

• Scroll down your Excel worksheet to see a 
couple of highlighted duplicates. 

• This is a good use of Duplicate Values, 
because here you can see if the 
OrderNumber refers to the same order or 
possibly an input mistake. Hint: In THIS 
case, the duplicates are an error, since 
they refer to two different order dates. 

• SAVE your work as you go: the Quick 
Access Toolbar shows a little disk icon, and 
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the common keybind is CTRL S / Mac: CMD 
S. 

MedAttrib: author-generated. MS Excel 
Conditional formatting dropdown. 

Try Another: 

Select Cells E6-E33 in the Sub-Category 
column. 
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• Again choose the Conditional Formatting 
button 

• Again Choose Highlight Cells Rules, then 
choose Duplicate Values. 

• Again click the OK button. 
• Now scroll down your worksheet, and see 

how ALL of the data cells in column E are 
highlighted. 

• Note: This is not a good use of conditional 
formatting, especially if you are actually 
trying to ‘sort’ or ‘filter’ or otherwise work 
on specific data of like content/kinds. You 
would use Sorting or Filtering – to be 
discussed in a later chapter. 

Text That Includes… 

You may need to look for data that includes 
something specific, especially if you are 
working in a large worksheet and the data is 
buried in the content of a cell with additional 
information. This is a TEXT-Only task, not for 
numeric data. 

• Select Cell D6 in the Category column. 
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• Choose the Conditional Formatting 
button, then choose Highlight Cell Rules. 

• Choose Text that Contains… 
• In the dialog box that opens, type the word 

Cook, then select the Red Border from the 
dropdown style options, then click OK 

• Look at your worksheet. Cell D6 should 
have a red border around it. 

• Next, let’s use this conditional formatting 
on the rest of the column. 

• While in Cell D6, Click the Format Painter 
paintbrush in the Home Menu ribbon’s 
Clipboard group. 

• Paint the rest of the column: cells D7-D33. 
This will apply the conditional formatting 
rule to all these cells, although only the 
‘Cookery’ cells will be highlighted because 
only they will match the criteria. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

Ranking Rules 

Top/Bottom formatting lets you get a feel of the 
importance of some percentage of numeric 
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data. Perhaps you want to know the top 5% of 
the scores on a class test, or the 10% of students 
who seem to have the lowest scores and might 
need additional assistance. Here we’ll consider 
the prices for products at Taste du Monde. 

• Select Cells G6-G33 in the Price column. 
• Choose the Conditional Formatting 

button, then choose Top/Bottom Rules. 
• Click Top 10%. 
• In the Top 10% dialog box that opens, you 

can see that 10 is already selected in the 
Percent field – this number can easily be 
changed as one needs in future work. 
Keep this at 10. 

• In the styles field, choose Custom Format. 
• In the Format Cells panel, choose the Fill 

tab. 
• In the Fill tab, choose a pale yellow 

background color. This should be in the 
8th column of the color palette, lightest 
yellow option. Click on it, then click OK. 

• In the Top 10% dialog box, click OK. 
• As you scroll down your worksheet, you 

should see two cells with the pale yellow 
highlight color. 
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• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

Average Conditions 

Another option of Top/Bottom rules lets you 
see averages in some numeric data, such as 
to see if some products are underselling. Here 
we’ll consider the order prices at Taste du 
Monde. 

• Select Cells I6-I33 (Column I – Cell I6 
through Cell I33) in the OrderPrice 
column. 

• Choose the Conditional Formatting 
button, then choose Top/Bottom Rules. 

• Click Below Average 
• In the Below Average dialog box that 

opens, you have only a formatting 
selection, including Custom. In the styles 
field, choose Custom Format. This will 
open a Format Cells panel. 

• In the Format Cells panel, choose the Fill 
tab. 

• In the Fill tab, choose a pale blue 
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background color. This should be in the 
5th column of the color palette, lightest 
blue option. Click on it, then click OK. 

• In the Below Average dialog box, click OK. 
• As you scroll down your worksheet, you 

should see several cells with the pale blue 
highlight color. 

• SAVE your work. 

Range Conditions 

Another option in Top/Bottom formatting lets 
you observe a specific and limited range of 
numeric information in a column. Here we’ll 
consider the prices for sales tax at Taste du 
Monde. 

• Select Cells N6-N33 in the Tax column. 
• Choose the Conditional Formatting 

button, then choose Highlight Cells Rules. 
• Click Between. 
• In the Between dialog box that opens, you 

can input values for the lower and upper 
range of what you want to consider – this
number can easily be changed as one 
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needs in future work. Type .75 in the first 
field and 1.25 in the second field. 

• In the styles field, choose Light green fill 
with dark green text, then click OK. 

• As you scroll down your worksheet, you 
should see several cells that qualify have 
changed color. 

• SAVE your work. 

Color Scales 

Conditional Formatting Gradients lets you see 
a sort of ‘heat map’ of the range of all the 
numeric data in a cell. Here we’ll consider the 
with discount totals at Taste du Monde to see 
how they range in value. 

• Select Cells L6-L33 in the WithDiscount 
column. 

• Choose the Conditional Formatting 
button, then choose Color Scales. 

• Click the Green-White color scale. This will 
instantly apply the conditional formatting. 

• As you scroll down your worksheet, you 
should see a variation of greens to white in 
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all the cells of the column. Note that we 
selected the 2-color green-white, instead 
of the full color range; this was simply 
because this particular activity worksheet 
is already stuffed full of eye candy. 

• SAVE your work. 

Data Bars 

Instead of colorizing an entire cell, one might 
use small data bars to observe the difference 
in numeric data values. Here we’ll consider the 
with order totals at Taste du Monde to see how 
they range in value. 

• Select Cells O6-O33 in the OrderTotal 
column. 

• Choose the Conditional Formatting 
button, then choose Data Bars. 

• Click the Blue Gradient Bars color scale. 
This will instantly apply the conditional 
formatting. 

• As you scroll down your worksheet, you 
should see a bar of some length in each 
cell of Column O. This can look better and 

106  |  Chapter 4: Data - Conditional Formatting



make more sense if your choose to make 
the column wider than just the content, 
especially if the bar seems to overlap any 
of the text. Remember, the important 
thing with any conditional formatting is for 
it to be useful, which means readable with 
good contrast. 

• SAVE your work. 

Icon Sets 

One difficulty with Conditional Formatting is 
that much of it relies on color. There are, 
however, a lot of people who have some form 
of color perception divergence, and unless the 
conditional format color only uses high-
contrast, and only 1 color selection to 
differentiate conditions, a color-divergent 
person may not be able to access and interpret 
the data. It can get in the way of actually seeing 
the data itself, too. 

Excel doesn’t give many options, but the Icon 
sets can help. Many still depend on colors, but a 
couple give primarily ‘shape-oriented’ options, 
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like the arrows used in our finished example 
above, and a couple more indicators’ choices. 
Even though these indicators use colors, the 
shapes themselves can be differentiated 
without color. 

Here we’ll consider the Discount prices at Taste 
du Monde to see which are the higher 
discounts of 10%, medium of 5%, and no-
discount price. 

• Select Cells K6-K33 in the DiscountPrice 
column. 

• Choose the Conditional Formatting 
button, then choose Icon Sets. 

• In the Icon Sets samples, click the first of 
the Directionals – the 3 directions of arrows 
that are red, yellow, and green. 

• As you scroll down your worksheet, you 
should see all the K Column’s data cells 
show an arrow that you could identify even 
if you cannot see color. 

• SAVE your work. 
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Corrections 

What if you have made a mistake with your 
Conditional Formatting? Or, do you want to 
delete it altogether? This is very easy to do. You 
can use the Conditional Formatting Manage 
Rules option. 

• On the Home Tab, in the Styles Group, 
select Manage Rules at the very bottom of 
the Conditional Formatting drop-down list. 

• Show formatting rules for: This Worksheet 
• In the Conditional Rules Formatting 

Manager panel that opens, click once on 
the Duplicate Values for cells E6-E33. 

• Click on Edit Rule, then click the format 
button. 

• In the Format Cells panel, choose the Fill 
tab. 

• In the Fill tab, choose a pale orange 
background color. This should be in the 6th 

column of the color palette, lightest 
orange option. Click on it, then click OK. 

• Click OK to exit the Format Cells panel, 
and click OK to exit the Conditional Rules 
Formatting Manager panel. 
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• SAVE your work and close your file. We’re 
finished! 

TIP: Conditional Rules Formatting 
Manager. You can also choose to delete 
a formatting rule, duplicate one to 
change the data range and modify the 
style for it, and even to create a new rule 
that you could then apply to a data 
range you select. 

MedAttrib: author-generated. MS Excel 
Conditional formatting manager. 
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Chapter 5: Inserts 
and Visual 
Appeal 

What We’ll Cover >>> 

• Themes 
• Modifying Themes 
• Tables 
• WordArt 
• Pictures 
• Icons 
• SmartArt 
• Hyperlinks 

Excel is primarily a spreadsheet for 
computations and data analysis. However, it 
also has a number of basic visual 
communication enhancements, like 
Microsoft® Word® and Microsoft® 
PowerPoint®. This is mainly so that documents 
shared by the same entity, like a business or 
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a multi-application project can use the same 
stylistic elements between them. In this 
chapter, we will work with a small file and play 
around with adding elements to it. 

ACTION: Try Me activity 

For this chapter, we will use the data file 
Ch5-Inserts.xlsx in order to demonstrate the 
various steps. Please find and open 
Ch5-Inserts.xlsx, and save a copy to your 
Examples folder. Most of our work will use the 
Inserts menu ribbon, with some coverage of 
the Page Layout menu ribbon for only themes, 
colors, fonts, and effects. 

112  |  Chapter 5: Inserts and Visual Appeal



MedAttrib: author-generated. MS Excel 
Ch5-Inserts.xlsx final result. Dessert: Creative 
Commons 

Themes 

We’ll start with the Page Layout ribbon. This is 
because when putting together a document or 
spreadsheet, it can be more efficient to look 
from the macro level to the granular level; the 
theme, colors, and other things that affect all 
the styling of the worksheet should be 
considered when creating the project, so that 
any inserts, tables, and charts/graphs flow from 
the color and font selections. 

In Ch5-Inserts.xlsx, we’ll change the theme 
first, then determine if it meets our needs and 
how to adjust it by choosing other colors and/
or fonts. Normally, Excel defaults to the current 
Office theme, which gives a palette of colors 
and shades from across the color spectrum. 
However, on spreadsheets, you may instead 
prefer a different color set, or inherit a 
workbook at work that uses another color 
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scheme, or be tasked with an assignment with 
certain theme specifications. While Excel is 
designed for themes to be changed almost 
effortlessly and without technical glitching, it 
is always good to plan your work and do steps 
efficiently to avoid rework or conflicts to very 
large spreadsheets later. 

Colors to prioritize for this small company: royal 
blue, muted brick red, white, French blue, 
yellow ochre, pale lavender. We’ll find out what 
applies in the color themes, if any. Blues and 
related muted colors are preferred. We may not 
find them all in a theme, but a theme that 
captures several will work. 

Note that the file you open already has a deep 
blueish color applied to the data range’s 
header row, which will be important to 
remember later. The text in the row seems 
invisible as a result. 

• Click on cell A1, then choose the Page 
Layout menu ribbon. 

• In the Themes group of the ribbon, choose 
the Themes dropdown box arrow. 

• For fun, just click on a few – on your screen 
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outside the Themes dropdown, you can 
see the fonts and the header row color 
seems to Preview a change. 

• We’ll settle on the Berlin theme, because 
the font selection seems easy enough to 
read with a little added text boldness, but 
not too stylistic to make a workbook hard 
to understand. 

• The existing color of the header row will 
have changed color. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

Note: this course is focusing on Excel for 
Windows (PC) and the assumption that your 
full installation has all the built-in items, like 
themes, color palettes, etc. However. If you 
don’t have some of these themes or named 
palettes / font collections (like with a Mac), 
choose what you can that seems closest to gain 
the skills-building anyway. 

Modifying Themes 

Now, the Berlin theme has great fonts, but the 
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color palette may not work. Let’s check it out. 
The Taste du Monde header row is currently 
kind of a orange-brown color. Not good for the 
company’s planned color scheme. 

• Right-click on the Cell A5, the first cell in 
the header row, which will pull up a menu 
list. 

• Choose the Format Cells (you may have to 
scroll down the menu list since it is near 
the bottom), which opens the Format Cells 
panel. In this panel, choose the Fill tab. 

• In the Fill tab, look at the upper left that 
shows a palette of 10 columns of colors 
and their shades. This is the color palette 
for this particular theme, and includes 
maybe a couple of the muted French 
county colors we could use, but no blues. 
No thank you! 

• Exit the Format Cells panel by clicking 
Cancel. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

116  |  Chapter 5: Inserts and Visual Appeal



Colors Palette 

Now, let’s consider other color options for this 
theme. While keeping the Berlin theme, we will 
use the Colors panel to look at options. 

• You can click anywhere on the work area 
of your worksheet; then In the Themes 
group of the ribbon, choose the Colors 
dropdown box arrow. 

• We are looking for something that has a 
dark blue, medium blue, darkish brick red, 
and a couple of neutral colors in the 
palette that could be purposed for Taste 
du Monde. Scroll down the Colors 
dropdown, and notice how our header 
row’s color changes. The closest we may 
find is the Aspect color palette. 

• In the Colors palette, choose Aspect (near 
or at the bottom of the list). This looks 
mostly like reds and so we’ll repeat looking 
at cell A5 in the Cell Format panel’s Fill Tab 
to check out the color palette’s spread of 
colors. 

• In the Cell Format panel’s Fill Tab, look at 
the color palette. In it, there is a blue 
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column with a dark blue and a French 
blue, dark brick reddish color, a lavender 
color, a kind of light tan, and white. This 
should do. 

Fonts Palette 

We can look at the Fonts palette to determine 
if we want a different font set. 

• You can click anywhere on the work area 
of your worksheet; then In the Themes 
group of the ribbon, choose the Fonts 
dropdown box arrow. 

• In the dropdown list, there are a number of 
font sets. Unfortunately, the dropdown list 
does not show which specific font set we 
are using. You need to click on one of the 
cells in your workspace to see, in the Home 
ribbon’s Font Field which font this 
document is using: Trebuchet. 

• Scroll down and see how the fonts on your 
worksheet seem affected in the preview. 
You can choose to experiment by clicking 
on one or two, but for Taste du Monde, 
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we’ll stay with the Berlin theme’s chosen 
fonts. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

Effects Panel 

The Effects panel lets you preview some effects 
that can be used on graphics like shapes, 
SmartArt, WordArt, and image borders in Excel 
workbooks. We don’t have a shape inserted yet, 
but we can change this effect in advance. We 
may see how this is reflected in a later inserted 
item. 

• In the Themes group of the ribbon, choose 
the Effects dropdown box arrow. 

• Click on the Glossy effect to choose it. 
• Note: Effects can be very subtle, 

depending on the theme used. Some 
themes will show more effects, and others, 
like Berlin, may not show much effect 
detail at all. 

Chapter 5: Inserts and Visual Appeal  |  119



Tables 

Tables are an Excel mainstay of ‘collecting’ data 
in an integrated format. They allow the data 
rows and columns to be seamlessly connected 
to each other for efficient sorting, filtering, 
styling, and calculations. We will cover tables 
in detail in Part 2. However, for this activity, we 
want to convert the data range of cells A5 
through D28 from a plain data range to an 
Excel Table object, because this is something 
that can be better modified with the Theme 
and Color Palette’s options. 

Now, we will cover the Inserts menu ribbon 
options. For the purpose of this chapter in 
Inserts, we will simply ‘insert’ a table for the 
practice, since it is a very important skill. 
Inserting a table over a range of data (bunch of 
cells) actually converts the existing cells to the 
table object, it doesn’t put in a new separate 
table, 

• Click on cell A5. 
• Go to the Inserts menu ribbon, to the 

Tables group. 
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• Click on the Table button. 
• When a small Create Table dialog box 

opens, put a checkmark in the My table 
has headers field. 

• Look over the field for “Where is the data 
for your table.” Excel has improved 
significantly over its versions, so that the 
program can discern a collection of data in 
a range of cells next to each other 
(columns, rows). As a result, the field for 
Where is the data… should already be 
populated with the information 
$A$5:$D$28, which is the spread of cells 
from the first cell in the Header row to the 
final cell at the lower left of the range of 
data. 

• If, for some reason, you do not see this info 
in the data range field, you can manually 
type it in: $A$5:$D$28 

• Click the OK button on the Create Table 
dialog box. The range of data from A5-D28 
will have converted the plain data range 
into a default table format with filters and 
banded color rows that uses the Berlin 
theme’s fonts and the color palette we 
chose. 
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• One more thing: we will want the table’s 
header row text to be white, so you need to 
select the header row cells and change the 
font color to white so you can see the text 
in the colored background. 

• For now, we will do no more work with this 
table. Lots more on tables will be in Part 2! 

• SAVE your work. 

WordArt 

WordArt lets you add a special stylized and 
editable text graphic. In Excel, graphics like 
WordArt, SmartArt, images, and shapes are all 
‘unanchored’ to cells, which means that they 
float above cells and can be easily moved 
without affecting the data inside your cells. We 
won’t cover the other Text Group button 
options in this activity, but they work much the 
same way as the WordArt one. 

Here is a refresher of what the final project 
should look like. 
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• Delete the content in cell A1. 
• In the Inserts menu ribbon, click the Text 

group button for Text, and select WordArt 
from the dropdown menu. 

• In WordArt, click the last option on the 
second row: Fill: Dark blue Accent Color 3; 
Sharp Bevel 

• A WordArt box will appear on your 
workspace. It is in a poor position and the 
text seems really big. The good news is 
that this is editable. 

• First, click inside the WordArt. This 
‘activates’ the WordArt, and a new, 
contextual ribbon appears at the right-
hand side of your Menu bar, called Shape 
Format. 
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This same kind of contextual ribbon options 
shows up for anything you can insert in Excel. 
For now, we won’t work with this one. Instead: 

• Type over the words in the WordArt to 
replace them with Taste du Monde. 

• Next, select all those words, and using your 
Home ribbon’s font size field, choose the 
font size 24. 

• Then, click outside the WordArt box, 
carefully hover your mouse cursor over it 
until you get a dark crosshairs icon, and 
press down to select the WordArt box for 
movement. 

• Move it by dragging the box over to the 
right border of cell B1. 

• SAVE your work. 

Pictures 

Excel lets you add illustrations, like photos and 
clipart. Like WordArt, pictures are ‘unanchored’ 
to cells, which means that they float above cells 
and can be easily moved without affecting the 
data inside your cells. Also, like WordArt, an 
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inserted picture (when made active by clicking 
on it) will reveal a contextual Menu ribbon for 
doing editing work on the inserted item. 

• In the Inserts menu ribbon, click the 
Illustrations group button for Pictures. 

• Click Pictures, which shows you image 
locations to choose from: This Device, or 
Stock Images, or Online Pictures. 

• In this case, assuming you are online, 
choose the Online Pictures option, which 
will pull open an Online Pictures window 
only. 

• If you see the option in this window, place 
a checkmark in the Creative Commons 
Only checkbox, so that you use only freely 
available images. 

• Then, type in YOUR favorite type of dessert 
– if you have one – and look at the results 
you get. Then, choose one of the images 
and click it, which will insert it into your 
worksheet. 

Your image could insert itself  in any size, so 
we’ll set a size for whatever image we use so 
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that it works nicely in the Taste du Monde 
worksheet. 

• Click your inserted picture. This ‘activates’ 
the picture so that a new, contextual 
ribbon appears at the right-hand side of 
your Menu/Ribbon bar, called Picture 
Format. We will use this ribbon for the 
next several steps. 

• In the Picture Format ribbon, on the far 
right, choose the text field for the 
horizontal size, and type in 1.5.” This will 
resize your picture to 1.5 inches wide, and 
to whatever the proportional height is. 

• Next, click the Accessibility button on the 
Accessibility group. In the text field, type 
“image of my favorite dessert,” and place a 
checkmark in the Mark as decorative 
checkbox. This allows Excel to consider this 
image as accessible in the program. 

• Then, in the Picture Styles group, choose 
Picture Border, and in the dropdown, 
choose the color black. This adds a very 
narrow border to your picture. 

• in the Picture Styles group, choose Picture 
Border again, and in the dropdown, 
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choose Weight, and on the flyout menu, 
choose 3pt. This will make a more 
prominent border for your picture. 

• Drag the picture so that it floats just to the 
top right edge of the Taste du Monde 
table, like in the final example above. 

• SAVE your work. 

The Picture Format menu ribbon offers all sorts 
of options for you to work with: 

• Adjustments like color correction, 
colorizing, and artistic effects; 

• Picture Styles like preset borders and 
Picture borders / effects / layout; 

• Arrange options like Bringing Forward and 
Sending Back; and 

• Size options like Crop and resizing fields. 
• Just for fun, you could try using an artistic 

effect on the image. 
• Note: Even though we selected “frosted” in 

the Effects Panel selection above, this 
effect may not actually appear 
prominently on an image – it will usually 
appear for inserting shapes and such. No 
worries! 
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Icons 

Excel also lets you add other illustrations, like 
icons. Icons are built into the Excel subscription 
and Excel accesses them online. Icons also are 
‘unanchored’ to cells, and an inserted active 
icon will reveal a contextual Menu ribbon for 
doing editing work on the inserted item. 

• In the Inserts ribbon, click the Illustrations 
group button for Icons. 

• Excel will open a Stock Images online 
search panel in the Microsoft® library for 
Excel/Office subscribers. This search area 
has tabs for Images, Icons, Cutout People, 
Stickers, Illustrations, and Cartoons that 
are in the Microsoft® library. 

• In the Icon tab of the Stock Images search, 
type food, then scroll down until you see a 
little black croissant. You could also type 
“croissant” in the search bar. 

• Click the selector circle at the top right of 
the croissant icon, then click the Insert 
button at the bottom right of the Stock 
Images search panel. 

• The icon will appear in your Excel 
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workspace, floating somewhere in the 
center. Clicking on it will activate a 
Graphics Format contextual menu ribbon. 

• You can manually resize the icon by 
dragging the lower right-hand corner 
inwards to make it a little smaller, say .7 
inches. Or you can click on the icon and 
type .7” in the Graphics Format ribbon. 

• Then, drag the croissant icon over to the 
left side of Cell A1, like in our example final 
image above. 

• After that, click on and drag the WordArt 
of Taste du Monde a little to the left so that 
it aligns with the croissant icon, like in our 
example final image above. 

• SAVE your work. 

SmartArt 

SmartArt is a Microsoft illustration that 
combines editable linked shapes with text 
boxes, and allows you to an alternate way of 
structuring visual communication information. 
SmartArt is ‘unanchored’ to cells, and an 
inserted active SmartArt item will reveal a 
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contextual Menu ribbon for doing editing work 
on the inserted item. 

• In the Inserts ribbon, click the Illustrations 
group button and look for the SmartArt 
button. 

• Excel will open a SmartArt panel that 
offers many SmartArt choices in several 
group options. 

• From the top group option – All – scroll 
down and choose the Continuous Arrow 
Process, then click OK. 

MedAttrib: author-generated. MS Excel 
SmartArt panel. 

• The SmartArt will appear in your Excel 

130  |  Chapter 5: Inserts and Visual Appeal



workspace, floating somewhere in the 
center. Clicking on it will activate a 
SmartArt Design contextual menu ribbon 
and another contextual ribbon to its left 
simply called Format. 

• In the SmartArt Design ribbon, let’s 
change the color using the SmartArt 
Styles group. Choose Accent 3, which is 
the dark blue. 

• Inside the SmartArt, click the first Text 
field and type Quality. Click in the second 
Text field and type Care. Click in the 
second Text field and type Desserts. 

• Inside the SmartArt, click on the Format 
contextual ribbon. In the ribbon’s WordArt 
styles, click on the Text Fill button. In the 
Text Fill palette, choose White. 

• Do these same steps to change the words 
Quality and Desserts to white. 

• Click on the border of the SmartArt image, 
and in the Format ribbon’s right side, 
choose Size. In Size / Width, type 4”. 

• Carefully drag the whole SmartArt graphic 
so that it flies out about ½ inch from the 
right side of your image of a dessert. 

• SAVE your work. 
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SmartArt has a lot of options to work with, 
especially in changing colors, effects, adding 
text and levels, and more. There are also several 
types of SmartArt groups: 

• List: Non-sequential information 
• Process: Steps in a process/timeline 
• Cycle: Illustrate a continual process 
• Hierarchy: Organization chart or decision 

tree 
• Relationship: Show connections 
• Matrix: Demonstrate how parts relate to 

the whole. 
• Pictures: use to accent content. 
• Pyramid: Illustrate proportional 

relationships. 

In SmartArt, you can add and organize text in 
hierarchical levels either manually or with a text 
pane. There is too much to cover when our 
focus is on Excel, so it is recommended that you 
experiment on your own for this. 
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Hyperlinks 

You may need to add hyperlinks in Excel 
worksheets, especially if you create/maintain 
lists of customers with email addresses, and 
companies with website locations. 

• Select Cell A3, which reads Visit Our 
Website! 

• In the Inserts ribbon, click the Hyperlink 
button (near the middle right). There may 
be a list of recent documents you have 
used, but ignore those for now; click Insert 
Link which is listed at the bottom of the 
dropdown. 

Insert Link will open an Insert Hyperlink panel, 
which offers the options to link to: an existing 
file or web page, a place in the same workbook, 
a new creation of another document, or an 
email address. 
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MedAttrib: author-generated. MS Excel Insert 
hyperlinks. 

• Choose the Existing File or Web Page 
option. 

• Then, in the Address field at the bottom of 
the panel, type: 
http://www.tastedumonde.biz (Note: this 
is a made-up address for this task; to my 
knowledge no such business actually 
exists). 

• SAVE your work, then close your file. We’re 
done with it! 

Keyboard Shortcut: Add Hyperlink. Hold 
down CTRL key while pressing letter K 
on your keyboard / Mac CMD K. 
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Chapter 6: 
Distribution 

What We’ll Cover >>> 

• Print Preview 
• Page Layout 
• Repeating Column/Low labels 
• Page Breaks 
• Print Area 
• Headers and Footers 
• Spell Checker 
• Cleanup with Find & Replace 
• Accessibility Review 
• Notes and Comments 
• Protecting Workbooks and Worksheets 
• Backstage Info Page 
• Distribution Methods 

Excel workbooks can be distributed in several 
ways, such as a printed document, a PDF for 
printing or adding to a website, shared in the 
cloud through OneDrive, linked into a 
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SharePoint site, and exported to PowerBI (a 
business enterprise application). Whatever 
method you might need to use to share your 
workbooks, setting them up for readability, 
printability, and clear defining between pages 
and sections is important. For our purposes, 
we’ll focus on practical standards for printing, 
which also translate well to PDFs and to being 
linked into a SharePoint (because other people 
might print or view your workbook(s) in a 
meeting, etc.) 

ACTION: Try Me activity 

Please find and open CH6–Distribute.xlsx, and 
save a copy to your Examples folder. Some of 
our work will use the Page Layout menu
ribbon, with some coverage of the Review 
menu ribbon, and some coverage of the Home 
menu’s Backstage area for Info, Print, Share, 
Export, and Publish. 
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Print Preview 

Print previewing may seem to be an odd place 
to start a chapter on distributing Excel 
workbooks, since there are a lot of pre-
distribution tasks one needs to get done first. 
However, Print previewing is also the quickest 
way to see how a document will look when you 
print it, so we’ll start here. 

With CH6–Distribute.xlsx open, go to your File 
menu item on the menu bar. When you click 
File, you will enter the Excel Backstage area 
(covered in Chapter 1). Much of the Backstage 
area has to do with printing and other 
document distribution options. 

• In the Backstage area, click Print. 
• Look at how the CH6-Distribute.xlsx will 

look if we just printed it as is. Below the 
image of the page printout, there is a field 
that reads Page 1 of 6. The data would be 
there, but it would be messy, with 
confusion as to which page is which. 

Keyboard Shortcut: Print (and Print 
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preview). CTRL key P / Mac CMD P. 

In this view, the left hand side of the Print 
preview page tells us what the page size, 
orientation, margins, page scaling for print, and 
which sheets will be printed. The information 
shown in the Print preview page is the default 
for Excel, and you’ll need to make changes. 

The Print preview page can be used for making 
changes to your document if you need to do 
so just before printing. For instance, a common 
adjustment is to choose to print the full 
workbook (all worksheet tabs, not just the 
current one you were on before going to the 
Print preview). Another common adjustment is 
the scaling of the page on the printout. The 
Collated/Uncollated option has to do with how 
a printer (particularly an office printer with 
many options) will output your documents. 

However, while you can use the Print Preview 
page to change margins, page orientation, and 
page size, this is a messy use of your time. 
Planning those things should happen as you 
begin a new document, the same as the 
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Theme (Chapter 6) and other page layout 
options (see below). 

TIP: No printer? Many people do not 
have a printer accessible where they 
work (home, in a classroom, in a 
coffeeshop or at a friend’s home, etc. In 
this case, some of your prep work may 
not work if Excel doesn’t recognize a 
printer to address options to. Easy fix: 
Set your printer to “Microsoft Print to 
PDF”, which acts as a virtual printer 
structure. 

Instead, we’ll focus on the Page Layout menu 
ribbon for common workbook and worksheet 
setup. 
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MedAttrib: author-generated. MS Excel Print 
preview. 

Page Layout 

For any document you work on – Word, 
PowerPoint, and Excel – you need to plan your 
output even as you are creating a new 
document. You will likely inherit a lot of 
workbooks in the workplace and need to 
contend with what you receive, and even then 
it is a good practice to understand a 
document’s shape and size before getting into 
the actual content. 

The Excel Page Layout menu ribbon offers 
most tasks you need to accomplish to set your 
documents up appropriately to your needs. 
What you do here will stick with your 
document and once in the Print preview before 
printing/distributing your work, the prepared 
output should be assured. Note that your 
changes will affect only one sheet of your 
workbook unless you temporarily group them. 
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TIP: Multiple Worksheet set-up: You can 
select all the worksheets in your 
workbook and set the Page Layout 
options all at once, if you know what 
your project parameters will be. 

• With your CH6-Distribute.xlsx file open, 
select both the Distribution sheet and 
Sheet2 by clicking on the Distribution 
sheet worksheet tab, holding the SHIFT 
key down, and then clicking on the Sheet2 
worksheet tab. 

• Go to the Page Layout ribbon’s Page 
Setup group, and click Margins. 

• With Margins open, choose Narrow. Then, 
click Margins again, and choose Custom 
Margins (at the bottom). 

• Custom Margins will open the Page Setup 
panel, and the Margins tab in it. Make the 
changes to the margins that you see in the 
image below: 

• Top margin=1,   Bottom margin=.70, 
 Header=.25,   Footer=.25,   Center on 
page=Horizontally 
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MedAttrib: author-generated. MS Excel Page 
setup. 

• Click OK to exit the Page Setup panel. 
• Next, with both the Distribution sheet and 

Sheet2 still selected together, choose 
Orientation from the Page Layout ribbon’s 
Page Setup group. 

• Choose Landscape. The default is Portrait, 
which makes the worksheet print-out 
taller than it is wide. Landscape will make 
it wider than tall, and help accommodate 
more columns of information on the same 
page. 

142  |  Chapter 6: Distribution



• With both the Distribution sheet and 
Sheet2 still selected together, choose Size 
from the Page Layout ribbon’s Page Setup 
group. 

• In the Size dropdown, choose Legal. Legal 
(8.5″ x 14″) is often used for spreadsheets 
due to their many columns that need to 
appear on a single page. 

• If you do not see that, or if some/all of the 
options in page size are grayed out, you 
may not have Excel recognizing a printer – 
or you may not even have a printer. In this 
case, you can use the tip from the Print 
Preview section above to set a printer as
“Microsoft Print to PDF”. 

• Check how the page will look using the 
File menu’s Backstage Print preview page. 
Now when you look, all the columns 
appear on the same page instead of being 
broken up. You can also observe that the 
first three ‘pages’ to be printed are from 
the Distribution worksheet, and the 4th 

page is for Sheet2. 
• SAVE your work as you go: Keybind is 

CTRL S / Mac CMD S. 
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MedAttrib: Beginning to Intermediate Excel. 
Purpose and Use for Page Setup Commands. 

Repeating Column/Row Labels 

One significant problem exists for what we see 
in the Print preview. The Distribution 
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worksheet has 3 pages, but only the first page 
shows the header row, which makes 
interpreting the second and third page 
difficult, 

Now that you have fixed the cell and text 
formatting, you are ready to review the 
worksheet in Print Preview. You will notice that 
the worksheet is printing on multiple pages, 
and you cannot tell what each column of data 
represents on some of the pages. 

• With CH6–Distribute.xlsx open, select 
ONLY the Distribution worksheet tab by 
clicking on it; this should ‘ungroup’ the 
previous both-worksheets selection. 

• On the Page Layout ribbon’s Page Setup 
group, click the Print Titles button. The 
Page Setup panel will open to the Sheet 
tab. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Page Setup Sheet panel 

• Click in the Print Titles / Rows to repeat at 
top field. Be sure your insertion point is 
blinking in that box before moving on to 
the next step. 

• In the worksheet, select Row 3. The text 
$3:$3 should now appear in the Rows to 
repeat at top field. 

• While still in this panel, also choose Page 
Order: Over, then down. While we hope 
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that all out columns will stay on one 
“page”, of they do overflow it would be 
easier to sort if the tag-end page printed 
just after its main page, rather than at the 
end of the print session. 

• Go to Print Preview (CTRL P) and look at 
each of the pages. Notice that the first 
three rows are now repeated at the top of 
each page. 

• SAVE your work. 

You will not see a change to the worksheet in 
Normal view, so you will need to return to Print 
Preview. In our case, this seems to be good 
enough, but in other documents, you may 
find that pages are breaking in inconvenient 
places, such as when some cells are word 
wrapped. We’ll continue good standard 
practices as if this were the case. 

Page Breaks 

If data is split between pages, you may want 
to set a page break to force Excel to push a 
row down to the next page to avoid orphaning 
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some visual data. We want all of the data for 
each state to be together on the same page 
for better analysis, so we need to control the 
page breaks. We are going to start by inserting 
a page break before the data in Row 25 to force 
Row 25 to start on the next page. 

• With your cursor anywhere in your 
Distribution worksheet’s workspace, go to 
the View menu ribbon, and in the 
Workbook Views Group click then click 
Page Break Preview. 
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MedAttrib: author-generated. MS Excel Page 
Break Preview. 

Mac Users: in the next paragraph, the location 
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of the automatic page breaks may be in 
different locations. That’s ok. 

In Page Break Preview, automatic page breaks 
are displayed as dotted blue lines. These lines 
indicate where Excel will start a new page. For 
this worksheet, we want the first page to break 
before Row 25 with Cody Green’s name, so we 
are going to insert a manual page break. 

MedAttrib: author-generated. MS Excel Page 
Breaks Button on Page Layout tab. 

• Select cell A25. When inserting a page 
break, you select the cell below where you 
want the page break to appear. 

• Select the Page Layout ribbon and then 
click the Breaks button in the Page Setup
group. 

• Select Insert Page Break from the menu. 
There is now a solid blue line after row 24, 
which indicates a manual page break that 
was inserted. 

• Do the same thing just above cell A50, and 

150  |  Chapter 6: Distribution



cell A75. 
• Go to Print preview (CTRL P). Notice that 

we now have 4 pages on this worksheet 
for printing. 

• Exit the Backstage area and then SAVE 
your work. 

Print Area 

Setting a print area for your workbooks is 
another standard practice. Even though this 
CH6–Distribute.xlsx file seems to look good, 
we are going to set a print range that leaves 
out the Hire Date. We don’t want to delete that 
column, and hiding it doesn’t always work for 
print/distribution needs. 

• Select Cells A1–K90. This is the only part of 
the worksheet that you want to have print. 

• On the Page Layout ribbon, click the Print 
Area button. Choose Set Print Area from 
the menu. 

• Preview the worksheet in the Print preview 
page (CTRL P) to check that the print area 
that leaves out the Hire Date column 
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setting worked. 
• SAVE your work. 

Headers and Footers 

When printing worksheets from Excel, it is 
common to add headers and footers to the 
printed document in order to show on every 
page important information like the date, page 
number, file name, company name, and so on. 
Headers and footers show up on every page in 
Print preview and in print pages, even though 
you won’t see them in Normal worksheet view. 

• Go to the Insert ribbon and click on the 
Text button near the top right. 

• Click on Header & Footer button. This will 
add a contextual Header & Footer menu 
ribbon with various options to add to your 
document. Also, this will convert the view 
of the worksheet from Normal to Page 
Layout. This Page Layout view makes 
adding Headers & Footers easy and 
provides key features to incorporate. 

• In the opened Header space, click inside 
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the left header section to edit the field. 
• Click on the Current Date icon on the 

ribbon to add the date to the left section of 
the worksheet Header. The &[Date] 
symbols which will toggle to a Date format 
when you click outside of this area. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Design Tab for Creating Headers and 
Footers. 

• In the Header section, click inside the 
middle header section to enter the field, 
then type your name in it. 

• Click the Go to Footer button in the 
Navigation group of commands in the 
Design tab of the ribbon. 

• Place the mouse pointer over the far right 
section of the footer and click to edit the 
field. 

• Click the in the Header & Footer ribbon, 
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choose the Page Number button in the 
Header & Footer Elements group. This view 
will display as &[Page] until printed or until 
you return to normal view. 

• Click any cell location outside the header 
or footer area. The tab and ribbon for 
creating headers and footers will 
disappear. 

• Click the Normal view button in the Excel 
Status Bar’s lower right side. 

◦ Or, you can instead choose the View 
menu ribbon, and in the Workbook 
Views group click the Normal view. 

• SAVE your work. 

Spell Check for Corrections 

Before you distribute your workbooks, it is good 
standard practice to check them for spelling 
errors. This can be tricky in workbooks with a lot 
of customer names, and addresses with unique 
spellings. However, there is no substitute for 
spell checking when your work needs to be 
proficient and clean. 
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With the spell check / editor, you can go 
through Excel’s selected misspellings one at a 
time to determine if you want to keep the 
existing item, or to make changes to it. Excel 
will offer options, or you could click into the 
worksheet where the misspelling appears and 
manually change it. You can ignore it once or 
ignore all. 

Keyboard Shortcut: Spell Check. Press 
the F7 function keyboard button. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Spell Checker. 
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Cleanup with Find/Replace 

Sometimes you might realize that you have 
some data that is using different formats for 
how it is expressed in a cell, such as different 
spelling or abbreviations. In some cells of a 
Column of US States, for instance, you might 
see the state referred to by its full spelling, and 
other times by its abbreviation. The Find and 
Replace option is an easy way to align this 
information to one version. 

The Find and Replace is in the Home tab/
ribbon’s Editing group, in the Find & Select 
icon’s dropdown. You would select only the 
column you want to look in, then choose 
Replace from the Find & Select dropdown. A 
dialog box will open in which you would input 
the item you want to find and the item you 
want to replace it with, like (example, not an 
activity for our working file): 

Find what: Washington 

Replace with: WA 

156  |  Chapter 6: Distribution



Then select Replace (for one at a time), or 
Replace All (for all instances). 

Accessibility Review 

Another standard practice is to check the 
accessibility of your workbook content before 
you release it. The Accessibility Checker is a 
tool that reviews content and flags accessibility 
issues it encounters. It notes why each issue 
might be a potential problem for someone 
with a disability, and also suggests how you can 
resolve the issues. 

The default setting is for the Accessibility 
Checker to run in the background while you 
work. 

• Select the Review ribbon’s Check 
Accessibility icon, then to manually launch 
the Accessibility checker. This will open an 
Accessibility contextual ribbon, as well as a 
docked Accessibility panel that shows 
specific issues. 

• In our CH6–Distribute.xlsx file, the only 
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accessibility issue seems to be that the 
second worksheet is named Sheet2. An 
explanation is given in the panel. 

Other things the Accessibility checker might 
reveal in varying worksheets include: 

• Images, icons, shapes, WordArt, SmartArt, 
and other graphic elements that need Alt 
text added to them for screen readers. 

• Tables, including header rows, table 
names. Excel default to to names like 
Table1, Table 2, etc., which can be 
confusing for people relying on screen 
readers and which should be named 
specifically for the purpose and work they 
are used for in the document. Example: 
Table1 should be renamed to something 
like SalesRepRegions. 

• Issues with color contrasts that the 
checker might pick up in custom 
conditional formatting or text/cell styling. 

• You can check the Microsoft® support 
pages for information on making Excel 
documents accessible. 
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Notes and Comments 

Before you release your work, especially if it is 
going to colleagues who are also working on 
a project related to the workbooks, you might 
want to add notes or comments to a 
worksheet. 

Notes are for adding annotations in cells, like a 
reminder, and they don’t have any interaction. 
Comments are used if you are working with 
others and want to interact in the document to 
discuss data and analysis. Each can be inserted 
by using the Review menu ribbon. Let’s make 
a comment in our CH6–Distribute.xlsx file’s 
Distribution worksheet. 

• Click on cell E1, since this seems to be a 
nice, central open area where a comment 
could be easily seen. 

• In the Review ribbon’s the Comments 
group, choose New Comment. 

• When the comment panel opens, type the 
following into the text field: Let’s consider 
deleting the Sheet2 since it duplicates 
some information from the Distribution 
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sheet. 
• Then, click the green Enter arrow in the 

comment panel. The comment itself will 
not show, but in the upper right corner of 
the cell E1, a little flag is attached. It can be 
hovered over to view and reply to the 
comment. 

• SAVE your work. 

Protecting Workbooks and 
Worksheets 

If you need to protect the data in your 
workbooks from being edited, you can easily 
protect the full workbook, protect specific 
sheets, and open only specific ranges of data to 
editing. 

There are two places you can choose from to 
manage your protections: 

• The Review menu ribbon’s Protect group, 
and 

• The Backstage’s Info page. 
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For this activity, we’ll work with the Review 
menu. 

• In our file, choose Sheet2. 
• Choose the Review ribbon, then the 

Protect group. 
• In the Protect group, click Protect

Workbook. When you click that, you’ll see 
a dialog box that asks for a password. 
When you do this, assign something you 
will remember. We will not do this task. 

• In the Protect group, click Protect 
Worksheet. This will protect only the 
worksheet named Sheet2, which you 
should still be in. This will open a more 
detailed Protect Sheet panel. The two top 
items are already checked by default, 
which means that users of the worksheet 
will only be able to select locked and 
unlocked cells. 

• In our activity, let’s give users the ability to 
also sort the worksheet’s data by checking 
the Sort checkbox. 

• Then, enter the word password (all small 
letters) in the Password field. If asked to re-
enter the password, use the same one. 
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• Click OK. 
• Click on cell A1, and attempt to delete the 

contents. You should see a warning 
message that the worksheet is protected. 

• Click on the worksheet tab for Distribution 
to go to your main sheet. 

• Then, choose the Review ribbon’s Allow 
Edit Ranges icon, which will open the 
Allow Users to Edit Ranges panel. 

• In the Edit Ranges panel, click New to set a 
specific range to allow to be edited with a 
password. 

• In the ‘Title’ text field input Taxes. In the 
‘Refers to cells’ text field, input =I4:I90 (that 
is a capital I, not the number 1). In the 
Range password field, input okay (all small 
letters). Then click OK. 

• When you click OK, the Allow Edit Ranges 
panel should show that you have one 
range that allows editing by users if they 
have the password. Click Apply. 

• Before you exit this panel, you still need to 
protect this worksheet. At the bottom left 
of the panel, click Protect sheet. In the 
resulting Protect Sheet panel’s password 
field, input password (all small letters). 
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Click Apply, then OK to exit the Protect 
sheet. 

• Click OK again to exit the Allow Edit 
Ranges panel. 

• Now, if you try to edit any cell in the 
Distribution workbook, you will get the 
protection message. If you try to edit any 
of the numbers in the Taxes column, you 
will be offered the chance to give the 
password to edit the information. 

• SAVE your work. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Protect Worksheet panel. 

Backstage Info Page 

• With all these steps and considerations, 
you’d think we’d be done, right? Well, 
there is one more thing you should be 
aware of: the Excel Backstage Info page. 
The Info page is a section gives you an 
overview of information about your 
document: its properties, its version 
history, browser view options, a place to 
inspect for any issues prior to distributing 
it, and the document’s protection/locked 
status. 

• Let’s see what CH6–Distribute.xlsx has for 
us to know. 

• Choose File to get to the Excel Backstage 
(PC for windows). 

• Then, click the Info icon on the left-side. 
This takes you to the Info page. 
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• 

MedAttrib: author-generated. MS Excel 
Backstage Info page. 

From this, we can see the name of the 
CH6–Distribute.xlsx file and its location on my 
computer. We can see that I am the author and 
editor of this workbook and the modification 
dates. When YOU look at YOUR copy, your own 
name should be listed at the Last Modified By 
information because you have been making 
changes to the original document for this 
activity. 

In Properties, we also see blank fields, which 
are for metadata that would be built into the 
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documents coding and would stick with it 
when the document is uploaded, saved as a 
PDF, etc. Let’s fix these. 

• Under the Properties heading, click in the 
Title field, and input: Bootcamp Distribute 
example file 

• In the Tags field, type your own name, and 
also the words/phrases Excel Bootcamp 
file, printing, accessibility, workbook 
layout. Each phrase should be separated 
by a comma. 

• In the Categories field, type input 
Education, OER, Excel. Each phrase 
should be separated by a comma. 

• Near the bottom of the Properties area, 
under the Related Documents heading, 
click the link See All Properties. This will 
expand the Properties info area. We don’t 
need to add anything to the Properties 
although in the Subject field, we could 
add Excel learning. 

Now, look at the Protect Workbook 
information. After our tasks above, you should 
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see that each worksheet (Distribution, Sheet2) 
is protected. You could change that here. 

• Click the Protect Workbook “Unprotect” 
link beside the reference to Sheet2. In the 
dialog box asking for your password, type 
the one you chose.  This will unlock that 
sheet. Note how after this, the Protect 
Workbook section shows only one 
protected worksheet: Distribution. 

• Look at the Inspect Workbook section. This 
lists some things to be aware of, like 
“Content that people with disabilities find 
difficult to read.” 

• Click the Check for Issues icon. This offers 
the Check for Accessibility task we already 
reviewed above, and also Check for 
Compatibility. 

• Click Check for Compatibility. The image 
below shows the resulting Compatibility 
Checker panel, expanded. You have the 
choice to select all or only a couple of 
versions of Excel in the Select Versions to 
Show dropdown. The summary of issues 
shows what the issues are, what their 
impact might be, and which version of 
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Excel they stem from. 
• Click OK to exit the checker. 
• SAVE your work. 

TIP: Expanding open panels/dialog 
boxes. If you see a small diagonal 
triangle at the lower right corner of an 
open panel or dialog box, this means 
you can click on that triangle and drag 
your cursor to enlarge the panel for 
more viewability of the content. 

MedAttrib: author-generated. MS Excel 
Compatibility Checker panel. 
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Distribution Methods 

Excel has many ways you can distribute your 
work: 

• Printed document. 
• PDF for printing or adding to a website. 
• Shared document in the cloud through 

OneDrive. 
• Linked into a SharePoint site. 
• Exported to PowerBI (a business enterprise 

application). 
• Exported as content into a database or 

other spreadsheet. 
• Linked to a Word or Excel document (such 

as for graphs in a PowerPoint. 
presentation. 

Whichever you need or choose, having your 
work properly formatted for layout helps other 
people experience and analyze the 
information. Checking for accessibility and 
compatibility helps catch and remove barriers 
for other users who need screen readers, have 
visual color issues, etc. Protecting data 
worksheets that you want viewed but not 
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edited helps keep the worksheet’s content 
integrity. 

With CH6–Distribute.xlsx open, go to the File/
Backstage area and look at the options for 
distribution. The Backstage lists several, but the 
same task(s) can be accomplished in more 
than one of those areas, like print to PDF, 
export to PDF, save as PDF, etc. 

• You can SAVE your workbook. 
• You can Save As your workbook – save it as 

a different version of Excel, a CSV (comma 
delimited format), as a PDF, or as another 
type. You can save it to a different location. 

• You can print the workbook and make 
printing-level changes, such as which 
specific sheets to print, collated or not, and 
scaling changes to fit the paper available. 

• You can share the workbook to the cloud, 
attach it to an email directly from Excel 
(assuming you have the full installed 
version of Microsoft® Outlook® on your 
computer / work server). 

• You can publish to Power BI (advanced). 

We are finished, so you can close your file. 
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Part 2: Data 
Ranges and 
Tables 

Excel is application for storing, managing and 
analyzing data, with the emphasis on analyzing 
data through calculations and organizing it. 
Actual collection of big data (thousands-to-
millions of records) is usually managed in 
databases. 

A database is an organized collection of data, 
generally stored and accessed electronically 
from a computer system. In a way, a database 
is like a huge warehouse of information that 
is necessary for data acquisition, analysis, 
reporting and computations, but the database 
itself does not do that work. It holds the data for 
exporting to other applications that can do the 
work, like Excel for computations. 

We will explore how to generate, import, 
organize, and analyze data effectively. To 

172  |  Part 2: Data Ranges and Tables



manage and analyze a group of related data, 
we will learn how to understand and manage 
ranges of data, and later how to convert data 
ranges into an Excel table for easier analysis, 
maintenance, and reference in calculations. 
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Chapter 7: Data 
Ranges 

What We’ll Cover >>> 

• Datasets 
• Data Ranges 
• Named Ranges 
• Moving Ranges 
• Sorting Data 
• Filtering Data 

Datasets 

Excel is all about data. The data is for viewing, 
organizing, sorting/filtering, analyzing, and 
calculating so that business problems can be 
considered and solved. The more organized 
the data is, the better you will be able to use 
it, analyze it, and get the needed calculations, 
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graphs, and pivot tables to answer your 
questions. 

A dataset is a range of contiguous cells on an 
Excel worksheet, which contain data to 
analyze. In a worksheet, cells with data on a 
spreadsheet would be a data set. However, a 
dataset doesn’t really mean anything until you 
determine what it exists for and what kind of
analysis needs to happen. 

ACTION: Quick Task 

Let’s look at an image of some Excel work. In it 
the cells A1 through D7 have data that seems 
related to each other. Cells E1-E6 is a column 
of data, as is the column of G1-G5. This is all 
part of a dataset, although only cells A1 – C7 
seem to meet the dataset definition of being 
contiguous. 
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MedAttrib: author-generated. MS Excel 
dataset. 

Data Ranges 

The phrase data range tends to be a statistical 
term to refer to the spread of data from the 
lowest to the highest value in the distribution. 
However, Excel refers to named data sets as 
a named range, so for the purposes of this 
textbook, we will refer to dataset and data 
range (in nonstatistical analysis) as the same 
thing. As a reference to data in a sheet or a 
table, range of data is simply a set of data, a 
designated range of cells in tabular format. A 
whole spreadsheet would be a dataset; a data 
range would be a group of cells that are being 
specifically worked with. 

• Cell contents: As discussed before, all data 
in Excel (other than inserted objects like 
pictures) is input into cells. Each cell is 
something that, as part of a row and 
column, can be sorted, calculated, and tell 
a story. 

176  |  Chapter 7: Data Ranges



• Cell addresses: Data are entered and 
managed in cells by entering numeric and 
non-numeric data. Each cell in an Excel 
worksheet contains an identification 
address, which is defined by a column 
letter followed by a row number. For 
example, the top left cell A1. This would be 
referred to as cell location A1 (or cell 
reference A1). You can navigate in an Excel 
worksheet with your mouse pointer or 
using the arrow buttons on your keyboard. 

• Column Headings: In Excel, data rarely 
means anything to a viewer if there is no 
context attached to it. Commonly this is 
done through column headings, which 
identify what the content in the column is 
supposed to be. This can also be done as 
row headers instead, but in this course 
we’ll mostly use the standard column 
headings. 

• Rows and columns: These make up the 
range of data in a dataset, with or without 
column headings. 
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Data range activities 

A range of data in a dataset can be: 

• Resized: You can resize columns from the 
Home tab Cells group to reveal 
information that looks cut off, or to narrow 
them if there is too much space. Same 
with rows if the row is too tall or seems to 
have cut off anything other than the first 
line of text. 

• Inserted/Deleted: Rows and columns can 
be inserted as needed from the Home tab 
Cells group, in order to expand for data to 
be added. Existing columns and rows can 
also be deleted. 

• Hide/Unhide: You may have a worksheet 
with a lot of columns, but really only need 
to see some of the data to decision. Hiding 
columns or rows can help you focus. 

• Sorted: In addition, information in a range 
of data can be sorted from the Data tab 
Sorts & Filters group, so that one or more 
column)s) shows information in an 
alphanumeric order or in some more 
customized order. 
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• Filtered: A range of data may have 
information about more customers or 
other content than you need: using a filter 
from the Data tab Sorts & Filters group lets 
you temporarily hide unwanted 
information so you can get a snapshot 
view. 

• Freezing Panes: If a range of data is made 
up of hundreds of records – long enough 
that you need to scroll down several pages 
to see it all, or over enough columns that 
you can’t see the important left-most 
columns, you can freeze a column or two, 
or the header row, so that the information 
remains in view no matter how much you 
have to scroll. 

ACTION: Quick Task 

Back to the image again: 
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MedAttrib: author-generated. MS Excel 
dataset. 

In here, all three batches of data are ‘ranges’ of 
data. This is important, because we may want 
to actually reference them in a tidy way for 
formulas and general reference. As they exist 
now, they are simply designated by the cell 
collections. A1:C7, E1-E6, G1-G5. 

Named Ranges 

As noted above, a range of data is simply a
dataset that can and will have work done with 
it. However, what needs to happen with data 
is what is important. Formulas that calculate 
data for specific purposes need to be able to 
find the data and easily add it to the formula. 
Sometimes the data will be all the contents of 
a table. Sometimes it will be only a column or 
two, or a few rows in a larger data range. In 
these cases, being able to “set aside” the data 
range in an identifiable way can make writing 
and fixing formulas easier. You can do this by
identifying/naming data ranges. 
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• Selecting: You select a data range by 
choosing a selection of row and column 
cells, such as dragging your cursor to 
select A1 through D10, or typing A1:D10. 

• Naming: To make that data range useful 
and easy to refer to in a formula, you need 
to name it. This can be done in the 
Formulas tab’s Defined Names group by 
using the Name Manager panel to give the 
data range a name. Once this is done, you 
can see a list of every named data range in 
the Excel Address field. 

• Use in formulas: In a formula, you can use 
the named range as the data range 
reference in the formula, such as 
=SUM(Totals) 

ACTION: Try Me activity 

Let’s now work with an Excel file: 
Ch7-DataRanges.xlsx. This is a dataset from 
our friend Taste du Monde that we can use for 
looking at a dataset, identify ranges of data, 
and set names for two or three of them. 

Save a copy of Ch7-DataRanges.xlsx to your 

Chapter 7: Data Ranges  |  181



Examples folder, then open it for work. It 
already includes the Taste du Monde logo icon 
and WordArt and link to their website. It also 
includes records of customer data including 
names, addresses, emails, and opt-in decisions. 

The whole set of A6 through J36 is a data set – 
a range of data / data range. 

• Select only cells A6 – C36. This is a range of 
data of that range of cells of customer first 
and last names and their customer IDs. 

• Deselect it. 
• Select only cells A6 through J9. This is a 

range of data of the first three customer 
records and the header row. 

• Deselect it. 

Now, let’s choose a range of data and name it 
for possible later use. 

• Select only cells F6 – H36. 
• With these cells selected, choose the 

Formulas menu tab/ribbon. 
• In the Formulas ribbon, look at the 

Defined names group. Select the 
dropdown arrow of the Defined Name 
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button. 
• Click on “Defined name”, which will open a 

dialog box. 
• In the dialog box, in the Name field, type 

TM_Region. 
• In the dialog’s Scope, leave the default of 

workbook. 
• In the comment field, type: Taste du 

Monde customer regions. 
• In the Refers to field, note that Excel 

recognizes that you selected 
=Customers!$F$6:$H$36, which is 
referring to the worksheet called 
Customers, and the range of data from F6 
– H36. 

• Click OK. 
• Now, click on the dropdown arrow of the 

Name field in the Excel UI (above cell A1), 
which usually shows the address of the 
Cell you have clicked in. When you click on 
the arrow, you should see TM_Region 
listed. This is a named data range. 

• Click on TM_Region in that Name field. 
Excel will select the range of data you just 
named – cells F6 – H36 – for you. 

• SAVE your work as you go: Keybind is 
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CTRL S / Mac CMD S. 

Let’s practice another one. 

• Select the range of cells from I6 – J36. 
• With the selection active, go to the 

Formulas ribbon, Defined Names group, 
and select the Name Manager icon. This 
will open a panel which already lists the 
TM_Region named data range we already 
created. 

• In this panel, click the button New. In the 
Name, type TM_OptIn. In the comment, 
type Taste du Monde newsletter opt-in. 

• Look at the data range given: 
=Customers!$I$6:$J$36. 

• Click OK. You should now see both named 
ranges listed in the Name Manager panel. 

• Click OK again to exit the panel. 
• SAVE your work as you go: Keybind is 

CTRL S / Mac CMD S. 
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MedAttrib: author-generated. MS Excel Name 
Manager panel. 

Editing Ranges 

Next, we’ll find out what happens when we 
delete some data from a named range. 

• With the Ch7-DataRanges.xlsx file still 
open, select Column G and delete it. 

• In the Name field above cell A1, click on the 
named range TM_Region. Excel now 
should select only the range F6-G36. The G 
column now contains the data from the 
Region, since the zip code data has been 
deleted. It seems as if Excel has no issue 
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with the deletion of a column that was in 
the named range. 

• In the Formula ribbon, Defined Names 
group, select the Name Manager icon. 

• In the Name Manager panel, double-click 
the TM_Region range. Look at the “Refers 
to”, which now reads 
=Customers!$F$6:$G$36. 

• Click Cancel to exit TM_Region. 
• Double-click on TM_Optin, and look at the 

“Refers to”, which now reads 
=Customers!$H$6:$I$36. This happened 
because a column was removed from the 
worksheet, and Excel adapted by adjusting 
even the TM_OptIn selection for the 
named data range. 

• Cancel out of that, and cancel out of the 
Name Manager panel. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

Moving Ranges 

Let’s move a named range. 
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• If you have not yet saved 
Ch7-DataRanges.xlsx, DO IT NOW, please. 
We will do a task we may not want to keep 
but you don’t want to lose any previous 
work. 

• With Ch7-DataRanges.xlsx still open, use 
the Name field above cell A1 to choose 
TM_OptIn. Excel will select the cells that 
make up that named range. 

• Right-click and choose Cut (or use the 
shortcut of CTRL X / CMD X for Mac), which 
will ‘cut’ the selection. 

• Place your cursor in cell L6, right-click, and 
choose Paste (or CTRL V / CMD V). 

• The named range has been moved. This is 
just demonstration, which we are not 
keeping. 

• Close the Ch7-DataRanges.xlsx without 
saving it. 

Sorting Data 

Let’s work with sorting and filtering data 
ranges. We actually do want to work with the 
Ch7-DataRanges.xlsx file again. We just didn’t 
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want to save the last set of changes made. 
Please open the Ch7-DataRanges.xlsx file. 

The dataset has a header row, which has been 
emphasized with bold text. This will help us 
identify what we want to sort and filter. 

The important thing to know about datasets 
and named data ranges is that, although they 
display data in columns and rows, the data is 
not actually connected. Let’s see what this 
means. 

• Select the contents of column I, cells
I6-I36. Copy it, then move your cursor to 
Cell J6. 

• In cell J6, paste the data you just copied. 
Now you have two columns of Opt-In 
responses. 

• Select the data of column J’s cells J6-J36. 
Use the fill color paintbucket in the Home 
ribbon to paint the cell backgrounds a 
light color, like gray. 

• With this J column J6-J36 data still 
selected, choose the Data tab ribbon. In 
the ribbon, choose the Sort & Filter group, 
Sort A to Z button. 
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• You should see a sort warning message: 

MedAttrib: author-generated. MS Excel Sort 
warning. 

• What to do? Let’s choose “Continue with 
the current selection” then click the Sort 
button to observe what happens. 

• Review the two Opt-In columns. The J 
column one is out of order compared to 
the original I column. That is a problem. 

Why did we go through this? Well, back in the 
Bronze Age when the author first worked with 
Excel, there were no warnings about sorts of 
data in relation to a dataset that wasn’t actually 
connected as an Excel table object. The author 
hangs her head in shame at the data sorting 
mistakes that occurred. Now, even with the 
Excel sort warning, it can still be easy for an 
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inexperienced data analyst to accidentally sort 
only part of a dataset, which would corrupt a 
batch of data when some information 
becomes untethered from its proper record. 
This would affect the data accuracy, the results 
of pivot summary tables, and definitely skew 
charts based on the data. 

Let’s be more careful and try again. 

• First, delete all of column J – the 
incorrectly sorted column. column J will 
now be blank and unformatted again. 

• Next, select data from column C, cells 
C6-C36. This will give us the last names of 
customers. 

• With this selection, again go to the Data 
ribbon, and select the Sort icon. 

• Again, we will get the Sort warning. In this 
case, leave the default selected response 
of “Expand the selection”, then click the 
Sort button. 

• Now, Excel will select – for us – the entire 
contiguous range of data from cell A6 
through I36. 

• In addition, the Sort panel gives us a 
choice of what to sort. In the Column Sort 
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By field, choose CustLName. 
• In the Sort By field, leave the default of Cell 

Values – Excel will sort based on the 
content rather than some other method. 

• In to Order field, keep the default of A to Z. 
• Click the OK button to generate the sort. 

MedAttrib: author-generated. MS Excel Sort 
panel. 

The whole data range of Cells A6-I36 should 
have been properly sorted, in A-Z order, based 
on the customer’s last name. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 
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Filtering Data 

Can we also filter data in a data range? Filtering 
allows you to hide items in a column based on 
some reason you have to exclude it. Let’s find 
out. 

• Place your cursor on any cell in the data 
range of cells A6-I36. 

• Choose the Data ribbon Sort & Filter group, 
and select the Advanced Filter button. 

• An Advanced Filter panel opens, which 
Excel already displays the List range of 
A6-I36 because the program “sees” a 
contiguous range of data that seems 
related. That is efficient. So is the default 
option to filter the list in place. However, 
the filter requires some Criteria range to 
filter in or out things for specific reasons. 
That requires us to give a specific data 
range – like one of the columns. 
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MedAttrib: author-generated. MS Excel 
Advanced Filter panel. 

• Click inside the Criteria range field, then 
type F6:F36. This should select the State 
column’s contents in our dataset. Then 
click OK. 

Hmmmm. Looks like nothing happened. Why? 
Well, in the end, we asked for a filter, yet the 
advanced filter didn’t really know what to filter 
for, and given that we were working with an 
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unconnected dataset of rows and columns, 
Excel couldn’t comply. Let’s try something else. 

• Place your cursor on any cell in the data 
range of Cells A6-I36. 

• Choose the Data ribbon Sort & Filter group, 
and select the larger Filter icon. 
Something interesting happens. In the 
header row of our dataset, a bunch of 
small dropdown arrows appears. This 
tethers together the columns and rows, so 
that a filter can work with the range of 
A6-I36. 

• Click the dropdown arrow in cell F6. 
• When you look at the filter arrow’s 

dropdown, you can see that the column 
can actually be SORTED, like a basic 
alphabetical sort. Yay! Let’s click the Sort A 
to Z. 

• Nice! Even by clicking A-Z in F6, the whole 
dataset sorts to the A to Z of the States. 
Now, let’s filter out all states but California 
(CA). 

• Click the dropdown arrow in Cell F6. In the 
dropdown, Uncheck the Select all box. 
Then, put a checkmark only in the CA 
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checkbox, and click OK. 
• There we have it; the dataset has had every 

state (and the related state’s records) 
filtered out except for those of California 
(CA). All the data still exists, but we can 
review only these two records until we 
clear the filter. 

• To clear the filter, click the dropdown 
arrow in Cell F6. In the dropdown, choose 
the Clear Filter from “State”. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

• Close your saved file – we are finished. 

Here is the really great news. As easy as all this 
is, in the next chapter, we will work with Excel 
table objects, so that we can utilize Excel’s 
connecting of data in a range without having 
to go through some of these manual steps. 

Chapter 7: Data Ranges  |  195



MedAttrib: author-generated. MS Excel 
unfiltered and filtered dataset. 
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Chapter 8: Data 
imports 

What We’ll Cover >>> 

• Basic Data Sources 
• Import Preparation 
• Import From Database 
• Import From CSV file 

Basic Data Sources 

Data analysis is the practice of cleaning, 
transforming, and analyzing raw data to 
acquire usable information so businesses can 
make informed decisions. Analysis can be 
performed with summary tables, charts, 
graphs, and other reporting tools. Data comes 
from many sources, including databases, 
surveys, quantitative research, human entry, 
collected, software use, etc. For years, data has 
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been acquired and fed into databases, with 
more automated means directly capturing and 
pushing data into huge datasets. Pulling that 
raw data to that it can be used is part of what 
Excel can do. 

Excel (PC & Mac), using PowerQuery, can grab 
data from huge databases, as well as basic 
imports from simpler databases and files. For 
bigger database work – like mySQL, web 
databases,  Azure, JSON, and others, you may 
need connectors, components, and drivers (like 
ODBC) before Excel can identify and connect 
with the database you want to import tables 
from – and that is more the purview of working 
with databases and with the more advanced 
Excel PowerQuery, which this book does not 
cover. Since that can get fairly advanced, this 
chapter will focus on a couple of basics: 
comma-separated-values .csv file, and Access 
database .accdb. 

With the rapid deployment of AI tools, 
especially Microsoft’s CoPilot, you will find that 
more intermediate-to-advanced Excel 
trainings will focus more on those tools. The 
point here, for this class, is that we will not be 
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dealing with AI tools bit rather the basics. Also. 
Microsoft has been making changes in Excel’s 
Data Ribbon. 

MedAttrib: author-generated. MS Excel Data 
ribbon. 

Note: Unfortunately, MAC users cannot import 
data from an Access database because 
Microsoft does not have that capability 
programmed for the Mac OS. If you are 
working on a MAC for your class or at home, 
you won’t be able to do the Access DB activity. 

Import Preparation 

Now, we are going to grab some data from 
a non-Excel source instead of inputting it 
ourselves. This data will be from a small 
company, called Prisvard Tech. which has a 
focus on computing technology products. To 
offer a taste of Excel’s import capabilities, we 
will import some data from an Access 
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database. Then we will do an import from a 
Comma Separated Values (CSV) file. 

ACTION: Try Me activity 

Let’s now work with an Excel file: 
Ch8–Import.xlsx. This is a dataset from Prisvard 
Tech, and it has almost no information in it. 
That’s because we are going to import the 
information from other files. 
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MedAttrib: author-generated. Chapter 8 
Activity after imported data. 

Save a copy of Ch8–Import.xlsx to your 
Examples folder. BEFORE you open it for work, 
you should also use your File Management 
utility to also grab a couple of other files from 
your DataFiles folder, and copy/paste these 
copies into your Examples folder. These two 
files are: 

• Prisvard.accdb (an MS Access database, 
not for MAC users) 

• Ch8-Import.csv (a comma-separated-
values, for any user) 

Then, open the Excel file Ch8–Import.xlsx for 
work. It currently includes a merged and 
centered Title Row with the name Prisvard 
Tech in it. It has a second pale yellow merged 
and centered row, which we will deal with a 
little later. Finally, it has one sheet named 
Sheet1. Let’s set this file up for our work. Your 
planned starting place for importing the data 
will be the already yellow-colored cell A6. 

We will attempt to import customer data into 

Chapter 8: Data imports  |  201



the first, currently existing sheet. We will then 
import more data into a second sheet, referring 
to sales reps by region. Finally, we will import 
data into a third worksheet which refers to 
some products and categories. However, in 
order to have somewhere TO import, we need 
to make and name more worksheets, and for 
efficiency, we want the sheets to have the 
same format at the Customers’ sheet. 

• Double-click the name tab of the first 
sheet and rename it Customers. 

• Right-click on the sheet’s tab, and from 
the context panel, select Move or Copy. 

• Put a checkmark in the box for Create a 
Copy. 

• In the “Before Sheet” field, click (move to
end). 

• Click OK. You should now see a second 
sheet, named Customers (2). 

• Then, follow the same process as above 
from the Customers sheet to make 
another copy of the sheet and copy it to 
the end so that you have a third sheet. 

• The third sheet tab will read Customers (3). 
• Rename the second sheet to SalesReps. 
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• Rename the third sheet to Products. 

Let’s make the sheets stand out more by 
assigning a color to the worksheet tabs. 

• Go back to the Customers worksheet tab, 
and right-click, then choose Tab color. In 
the offered palette, choose a medium 
orange. 

• On the SalesReps tab, right-click, then 
choose Tab color, and choose a medium 
yellow. 

• On the Products tab, right-click, then 
choose Tab color, and choose a medium 
blue. 

We’ll finish prepping these worksheets for 
incoming data. 

• In the Customers sheet, in cell A2, type 
Customer List. The cell is already merged 
and centered from cells A2 – I2. 

• In the SalesReps sheet, in cell A2, type 
SalesReps by Region. 

• In the Products sheet, in cell A2, type 
Product Categories. 

• SAVE your work as you go: Keybind is 
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CTRL S / Mac CMD S. 

Import from Database 

Now, we are going to grab some data from 
another source. It is also from Prisvard Tech. 
What we will do is a little importing of data 
from an Access database. 

We are going to bring in a dataset from a 
database prepared in Microsoft Access. The file 
name is Prisvard.accdb and has a bunch of 
tables in it. We won’t need to have MS Access 
to actually open and work with, although in a 
job you would likely be able to work and get 
inside the database. Here we are simply going 
to pull data from the database and populate 
the Ch8–Import.xlsx Excel workbook with it. 

• In the Ch8–Import.xlsx Excel file, go into 
the Customers worksheet, and click into 
Cell A6 (which has a medium yellow color 
in it). It is good to know where you would 
like your imported data to go. 

• Look on the Data tab ribbon for the Get & 
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Transform Data group. 
• In the group, choose Get Data to see a 

dropdown menu of choices. 
• Choose From Database, and then choose 

From Microsoft Access Database. 
• Excel will open an Import Data window, 

which is essentially the same as the one 
we use when looking for a file. That is what 
we will do: look for the Prisvard.accdb file, 
which should already be in your Examples 
folder. 

• Select the Prisvard.accdb file, and click 
Import. 

• On a Windows OS PC, Excel will “connect” 
with the database, and open a Navigator 
panel so that you can see the various items 
in the database. This database has only 
tables in it. 

• We want to import information from only 
the tbl_Customers table. Select that one. 

• The Navigator will then open a preview of 
the selected database table’s contents on 
its right-hand side. 
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MedAttrib: author-generated. MS Excel data 
importing Navigator with preview. 

• Click the Load button. 
• The Navigator panel for the database will 

disappear, and a new worksheet will have 
appeared in your Ch8-Import.xlsx file. 
Interestingly, the data will not have loaded 
into an existing worksheet where you 
clicked cell A6, but instead imported by 
creating a new worksheet. 

• The default for Excel is for the use of 
default Query Load settings, which 
includes importing into a new worksheet. 
The default is also for Excel to detect 
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column types and headers, which Excel 
loads as a table object rather than a plain 
dataset. 

• In addition, the data that loaded will have 
imported as an already created Excel 
Table. We won’t be modifying this table 
here, but in Chapter 9. However, we can 
combine the table with the Customers 
worksheet. It is a bit of a pain, but keeping 
information collected and organized will 
help us later. ALSO, alongside the 
imported table, Excel will have opened a 
Queries & Connections panel, which we 
will ignore for now. 

• In the new worksheet with the imported 
table, select all the cells in the table: cells 
A1-L251. Cut them, then move to the 
Customers sheet and place your cursor in 
cell A6. 

• In the Customers worksheet’s yellow-
colored cell A6, paste the table. 

• Delete the now mostly empty 
tbl_Customers worksheet that was the 
imported info. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 
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Let’s get one more practice at importing from 
Access. 

• In the Ch8–Import.xlsx Excel file, go into 
the SalesReps worksheet, and click into 
cell A6 (which has a medium yellow color 
in it). 

• Again, look on the Data tab ribbon for the 
Get & Transform Data group. 

• In the group, choose Get Data to see the 
dropdown menu of choices. 

• Choose From Database, and then choose 
From Microsoft Access Database to get 
the Import Data window. 

• Double-click the Prisvard.accdb file, which 
should already be in your Examples folder, 
which will bring up the Navigator again. 

• In the Navigator, click once on the 
tbl_Reps in the list, which will preview a 
small table. Click Load, which will load the 
small table into another new Excel 
worksheet in our Ch8–Import.xlsx Excel 
file. Alongside the imported table, Excel 
will have again opened a Queries & 
Connections panel. 
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MedAttrib: author-generated. MS Excel data 
importing Navigator with tbl_Reps preview. 

Before we clean up and get the newly 
imported table into the proper worksheet, let’s 
review the connections. Alongside the 
imported table, Excel will have opened a 
Queries & Connections panel, which we will
now deal with. 
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MedAttrib: author-generated. MS Excel Queries 
& Connections panel. 

This Queries & Connections panel is a tool to 
let us know that there are linked connections 
in this workbook from another source. In this 
panel, we should see two items listed: 
tbl_Customers with 250 rows loaded, and 
tbl_Reps with 11 rows loaded. Note: In earlier 
versions, we would also see a second copy of 
tbl_Customers that represented the table/
sheet we already deleted, but this should not 
show up now. 

Both of the tables are linked to the database 
we imported them from. The information can 
be refreshed if changes are made to the 
database. We are not going to do that. At this 
time, we have to accept the existence of these 
links to an external file, which we can choose 
to ignore by later closing the Queries & 
Connections panel. 

First, though, let’s discover if we can easily 
break the link. We can do this as we also cut 
and copy the tbl_Reps from its newly created 
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worksheet into a position on our pre-formatted 
SalesReps worksheet. 

• First, in the still-opened Queries & 
Connections panel, right-click the 
tbl_Reps in the list. In the dropdown 
menu, we do not see an option to break 
the link to the original database that the 
table was imported from. That is 
unfortunate, and seems kind of inefficient. 
Hmm. . . 

• Second, let’s click on the actual table of 
sales reps in the tbl_Reps worksheet. 
When you click on it, the table behaves 
like other Excel inserted items – the 
activated table opens a contextual Table 
Design tab ribbon. 

• In the Table Design ribbon, look at the 
External Table Data group. There is an 
available (not grayed out)  button of a 
broken link named Unlink. Click on it. 

• At the Warning that opens, stating “This 
will permanently remove the query 
definition from the sheet. Continue?,” click 
OK. 

• This unlinks the table data from the 
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database, so that even if the database is 
updated, this table will not be affected. 
This IS what we want, 

• Close the Queries & Connections panel. 
• Finally, in the tbl_Reps worksheet, cut the 

cells A1-C12, then paste them in the 
SalesReps worksheet in cell A6 (colored 
medium yellow). 

• Then, delete the worksheet named 
tbl_Reps. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

Import from CSV file 

Now, we are going to grab some data from 
another source. This is more Prisvard Tech info, 
saved into a raw format called comma 
separated values (CSV). This is like a text file, 
with no formatting except commas between 
“fields” of data like: 
LJ,Bothell,lbothell@shoreline.edu,Instructor,ha
ppy 

• In the Ch8–Import.xlsx Excel file, go into 
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the Products worksheet, and click into Cell 
A6 (which has a medium yellow color in it). 

• Again, look on the Data tab ribbon for the 
Get & Transform Data group. 

• In the group, this time choose the From 
Text/CSV button. 

• The Import Data window will open so that 
you can look for the Ch8-Import.csv file in 
your Examples folder. 

• Click the file name, then click Import. 
• In the resulting pop=up window, we can 

see a 3 column table that Excel has 
interpreted based on a comma delineator. 

• Click Load, and again, we’ll get a table 
imported in its own worksheet, named 
CH8-Import. 

• The Queries & Connections window opens 
again, listing this new import. 
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Before Import when still a .csv 
file: 

MedAttrib: author-generated. MS Excel CSV in 
raw format. 
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When using Excel Import of the 
.csv file: 

MedAttrib: author-generated. MS Excel CSV 
import panel. 

Given that we need to get this new table into 
the existing Products worksheet, let’s find out if 
we can break the link to the source in another 
way. 

• In the CH8-Import worksheet, look at the 
imported table. Unlike the Access 
database imports, this table did not come 
in with a column of numbers before the 
first column of actual data. Second, notice 
that the header row reads only Column1, 
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Column2, and Column3, even though the 
row below it does read column head 
names. We’ll have to fix those things later. 

• Click anywhere in the table, and go to the 
Table Design ribbon’s External Table Data 
group. Click on the button of a broken link 
named Unlink, then click OK at the 
warning to unlink the table data from the 
database. 

• In the CH8-Import worksheet, COPY the 
cells A1-C52, including the row reading 
Column1. Column2, etc. 

• Right-click in the Products worksheet Cell 
A6 (colored medium yellow). 

• On the dropdown menu, look at the Paste 
Options, and select Values. The data from 
the CH8-Import table will paste in without 
any Excel table format. Note: this Paste 
Values, which eliminates formatting, can 
not be done while the CH8-Import table 
was still actively linked to the CSV file. 

• Once you paste in the values, then delete 
the row 6 that reads Column1. Column2, 
etc. 

• Delete the CH8-Import worksheet that 
came from the CSV import. 
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• Close the Queries & Connections panel. 
• Save and close your Excel file. We are 

done with it. 

MedAttrib: author-generated. MS Excel CSV 
imported content after Paste Values. 
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Chapter 9: Table 
Creation 

What We’ll Cover >>> 

• Table Properties 
• Table Design 
• Table Object Creation 
• Entering and Deleting Data 
• Total Row 

In Chapter 8, we got a taste of MS Excel tables 
when data imported from an Access Database 
and from a CSV file imported in the Excel table 
format. In this chapter, we will work on the 
result from Chapter 8. We previously worked 
with datasets, then discovered how simple 
sorts and filters needed extra attention to avoid 
corrupting the data. 

However, Excel tables behave independently 
from the rest of the information on a 
worksheet. There are several advantages of 
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Excel treating the data independently. For 
example, using integrated filters and sort 
functions you can effortlessly drill down data 
based on questions and in return get results. 
Excel will also automatically expand the table 
to accommodate new data entries and allows 
for automatic formatting, such as recoloring of 
banded rows or columns. 

You will also notice Excel treats formulas and 
calculations differently in a table, showing 
structured column names, along with 
automatically filling a calculated field to the 
entire table or offering quick and easy table 
totaling tools. This is where naming your data 
range – in this case a table object – is efficient. 

When graphing and charting table data we will 
also see Excel automatically adjusts off 
associated charts and ranges based on what 
the user is sorting or filtering at the time. 

Table Properties 

Turning a range of cells into an Excel table 
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makes related data easier to analyze, visualize, 
and report. Structuring and planning table 
layouts are vital for data integrity. Below are 
guidelines to consider when designing and 
building a table from scratch. Your goal should 
be relating similar data so that summarizing 
and reporting out with graphs/charts makes 
sense. Table data should be easy to read. Tables 
that are expected to be bigger than the 
maximum column and row numbers for Excel 
should instead be stored in a database, then 
imported into Excel for calculations and 
analysis work. 

MedAttrib: author-generated. MS Excel Tables 
info. 
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Table Design 

ACTION: Try Me activity 

Let’s open the file Ch9-Tables.xlsx from the 
Datafiles folder. This is mostly the same result 
we had when we finished Chapter 8, but I 
deleted a bunch of customer rows to keep our 
work simple and streamlined. The Page Layout 
theme should already be the Office theme, 
which will give us the colors to use in this 
activity. 

Here is what we are going to accomplish. 

 

MedAttrib: author-
generated. MS Excel 

finished Prisvard Tech customers table. 

In the Ch9-Tables.xlsx file, we have three 
worksheets: Customers (orange tab), SalesReps 
(yellow tab) and Products (blue tab). The 
Customers and SalesReps sheets have an Excel 

Chapter 9: Table Creation  |  221



table that was created when we imported data 
from an MS Access database. The Products 
sheet has a dataset that was imported from a 
CSV file then modified. 

• Let’s work with the Customers table first. 
The Customers worksheet has blues, black, 
and yellows in the title and subtitle rows of 
the sheet. The table you imported may 
have appeared in any color in your Excel 
themes color palette. Mine came in as a 
table of green coloring. That sure doesn’t 
go with the Prisvard Tech theme of 
medium blues, yellow, black text, etc. 

• Click anywhere in the Customers table. 
• When you activate a table, a contextual 

Table Design tab ribbon opens near the 
top right of your Excel UI. Click on that tab. 

MedAttrib: author-generated. MS Excel Table 
Design ribbon. 

The ribbon has several groups: 
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• Properties: Allows for naming and table 
resizing. 

• Tools: Contains some table analysis tools. 
• External Table Data: For use with linked 

live data sources, like a database that may 
have changes happen to it. 

• Table Style Options: Basic table parts 
designation items. 

• Table Styles: Color and layout styles for 
tables based on the Excel theme, color 
palette, and font palette you choose. 

• For our purposes, we will use the groups of 
Properties, Table Style Options, and Table 
Styles. 

Name a table 

First, let’s name the table so that if it is ever 
used in a calculation, Excel can identify it more 
easily. Then we’ll change the table’s color 
design, then add a little more detail. 

• With the table selected and active, look at 
the Table Design ribbon’s Properties 
group. The Table Name reads 
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tbl_Customers. Let’s make this easier to 
use by overtyping with PTcustomers. This 
refers to Prisvard Tech customers. 

Change Table Design 

Next, let’s change the color scheme of the table 
to be an orange base to coordinate with the 
worksheet’s orange name tab. 

• In the Table Styles, click the double-down 
arrow for a dropdown panel of table color 
options. In review, we should be using the 
default Office design theme for our color 
palette and font selections. 

• In the Table Styles dropdown, choose the 
Orange, Table Style Medium, 17. This will 
change the table to a combination of a 
medium orange header row and light gray 
banded rows. 

Let’s explore the table tools now. Notice the 
specific checkboxes to turn on table options, 
for example, you can choose to display banded 
rows or banded columns, or a total row etc. 
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Currently, the Header Row, Banded Rows, and 
Filter Button selections are all turned on. 

• Click on the table, and make sure the 
Table Design ribbon is active. Uncheck all 
three checkboxes that have a check, and 
look at what happens to the table. 

• We clearly have a plain table without 
much visual definition, and no sorting or 
filtering capabilities. The Filter checkbox is 
grayed-out; the Excel table requires a 
header row to sort and filter information. 
Click to add a checkmark to the Header 
row checkbox. 

• The Header row shows up again as orange, 
and the Filter button is also by default 
turned back on. 

• Click the checkbox by First Column. Excel 
adds an orange fill to the whole of the 
table in Column A. Ugh. That is too hard on 
the eyes; uncheck that First Column 
checkbox. 

• For visual definition, click the Banded 
Rows to add the gray bands again. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 
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Delete Table Columns 

Before we move into the second worksheet for 
SalesReps, let’s do a little content cleanup of 
this Customer table. Part of this will include 
deleting a column or two and some other 
maintenance. 

• Click in cell A10. Then click on the Home 
Tab, and look for the Cells group. In this 
group, click the Delete dropdown arrow, 
and from the list, choose Delete Table 
Columns. The ID column disappears. 

• Let’s do the same for the Zip column in 
column G. Click anywhere in the Zip 
column in the table, then repeat the Home 
Tab, Cells group, Delete dropdown, Delete 
Tables Columns. the G column zip codes 
should disappear. 

Fix Merge and Center conflict 

Now, we have fewer columns, but the title and 
subtitle row of the worksheet are still shorter 
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than the width of the table by one column. 
Let’s fix this. First, clink into cell A1, which is 
actually merged and centered across columns 
A – I. 

• After clicking cell A1 which selects the 
merged cells, hold down the shift key and 
also click cell J1. 

• Then, with seemingly all of A1-J1 selected, 
go to the Home ribbon’s Alignment group, 
and click the Merge and Center button 
once, then again. 

• The first click will unmerge and uncenter 
Cells A1-I1, and the second click will merge 
and center all of Cells A1-J1. 

• Repeat this task with row two to unmerge/
uncenter cells A2-I2, and then merge and 
center cells A2-J2. 

Tidy-up table data 

• In Column H, which now has the Phone 
column, right-click on Cell H7. Choose 
Format Cells from the dropdown, and in 
the Format Cells panel’s Number tab, 
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choose Special. In Special, select Phone 
Number, then click OK. 

• Use the Home ribbon’s Clipboard group 
Format Painter to apply the style of cell H8 
down through cell H101. 

• Auto-resize the Column H phone numbers 
(or manually resize to about 12.5.) 

• Auto-resize the Column I emails (or 
manually resize to about 24.) 

Let’s sort the table so that we can modify a few 
of the email addresses to be hyperlinked. 

• Click the Filter arrow in the Opt-In column 
J. Sort A-Z. This will sort by No and Yes 
responses. 

• Select cell J7, and use Conditional 
Formatting for Highlight Cell Rules. The 
rule should be for equal to yes with the 
Yellow fill with dark yellow text. 

• Then, use the format painter to paint that 
style over cells J8-J101. The last handful of 
responses – yes – will stand out. 

These Yes opt-in responses need the email 
addresses in the column to their left to be 
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hyperlinked. This is a manual task, but it is one 
worth practicing. 

• Right-click on cell I87 which, assuming 
you sorted Column J so that the cells are at 
the top and Yes cells are at the bottom, 
should have the email 
lolombardo@lastname.com. 

• Scroll down the menu from your Right-
Click until you see Link, then click that. You 
should get an Insert Hyperlink dialog box. 

• In Link To, select Existing File or Web 
Page. 

• In the Text to Display, copy the contents, 
which should read 
lolombardo@lastname.com. Then, paste 
this email name to the Address field. Excel 
will automatically add a mailto: prefix to 
the pasted email address. 

• Click OK. This will give you an active 
hyperlink. 

• You can practice this a time or two, but the 
real answer to a situation with more than 
one or two links is to instead use a 
hyperlinking formula, which a more 
complex step for another chapter. 
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• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 

ACTION: Quick Task 

Let’s do a quick refresher of changing the Table 
Design with the second worksheet for 
SalesReps. 

MedAttrib: author-generated. MS Excel 
Prisvard Tech salesreps table. 

• In the SalesReps worksheet, click in the 
table of Regions / SalesReps. 

• Go to the contextual Table Design tab, and 
use the Table Styles group to change the 
table design to Gold, Table Style Medium, 
19. This gives us a gold bar header row that 
goes with the worksheet name tab’s 
yellow color. This one also has the gray 
banded rows in it. 
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• In the Table Design tab’s Properties group, 
overwrite tbl_SalesReps with PTregions. 

• Right-click somewhere in the table’s A 
column. In the dropdown menu, choose 
Delete, then Table Columns. This should 
leave you with two columns. 

• Auto-size the width of the two columns, 
which means that the content should not 
look cut off. 

• Sort the Region column in order of A-Z 
using the table’s header row filter button. 

• Use the header row filter button for the 
SalesReps column to filter with a text 
filter. Click the button, and in the 
dropdown, choose Text Filters, and in the 
flyout options, choose Begins With. 

• In the Begins With field, type R then click 
OK. 

• Now you can observe that the table shows 
only four sales rep names in alphabetical 
order of their regions. 

• SAVE your work as you go: Keybind is 
CTRL S / Mac CMD S. 
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Table Creation 

MedAttrib: author-generated. MS Excel 
Prisvard Tech products table. 

In the Ch9-Tables.xlsx file, the third worksheet 
has a plain dataset. We need to convert this 
into an Excel table object – like those in the 
first two worksheets. Then we need to style it so 
that it follows the conventions of the rest of the 
workbook. 

Click the Products worksheet tab which is the 
worksheet with the dataset. What do we see? 

Right now, we see a dataset with a row that 
reads Column1, Column2, and Column3. The 
row below this reads Category, Sub-Category, 
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and ProductName. If this data is going to make 
sense for later analysis, then row 6 needs to be 
deleted since Column1, 2, 3, etc. are not useful 
header names. 

What we will be doing is converting the data 
range to an Excel Table object. 

• Delete Row 6. Now, let’s make a table! 
• Select the data in cells A6 – C56. 
• With this range of data selected, go to the 

Insert ribbon, Tables group. 
• In the Tables group, click the Table icon. 
• A Create Table dialog box should open, 

which should already have entered the 
data range of cells you selected into the 
‘Where is the data for your table?’ field. 
This should read:  $A$6:$C$56 

• Click the checkbox next to My table has 
headers, then click OK. 

The data range will now be encased in an Excel 
table. Now, let’s name the table, then change 
the table design. 

• Click in the table, and then go to the Table 
Design ribbon. In it, overwrite the name 
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Table1 with PTproducts. 
• With the Design ribbon still active, use the 

Table Styles group to choose Blue Table 
Style Medium 16. This one has the gray 
banded rows in it. 

• Adjust the width of the three table 
columns so that the content doesn’t 
overflow. 

• SAVE your work. 

Entering & Deleting Records 

Tables require constant updating and may 
need calculations. When your table needs 
updating you can add/delete data, by adding/
deleting rows, or columns. Excel adjusts the 
table automatically to the new content if you 
add it to a row or column after an existing one. 
The format applied to the banded rows 
updates to accommodate the new data set 
size. 

When calculations are needed you can create 
a calculated column or use the built-in Total 
Row tool. Excel tables are a fantastic tool for 
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entering formulas efficiently in a calculated 
column. Excel allows you to enter a single 
formula in one cell, and then that formula will 
automatically expand to the rest of the column 
by itself. There’s no need to use the Fill or Copy 
commands. This feature can be incredibly 
time-saving, especially if you have a lot of rows. 
And the same thing happens when you 
change a formula; the change will also expand 
to the rest of the calculated column. 

For now, we’ll just add a little data. 

In the Ch9-Tables.xlsx file, we’ll work more on 
the 3rd worksheet: Products. Currently, the 
table ends at row 56. 

• Click into Cell A57, and type the word 
Technology, then click your keyboard’s Tab 
button. 

• In the next cell, type Power, then click Tab 
again. 

• In the third cell, type Battery 5hr then hit 
Enter. The table should have automatically 
expanded its format and range down to 
accommodate the new row of text you 
entered. 

Chapter 9: Table Creation  |  235



TIP: Adding Rows. It can be tempting to 
insert blank rows further up in a table 
and add data, yet with the ease of 
sorting and filtering, that isn’t really an 
efficient way of adding data. 

Next, let’s add a column. We’ll want to add 
some pricing information for the Products. 
We’ll just do the simple thing and add a 
repeating default price so that we can move 
quickly. 

• Click in cell D6, which is to the right of the 
3rd header column title. 

• Type Prices then click your Enter key. 
Whoa! Excel just added a whole column of 
formatted space to our table. Cool. 

• In cell D7, type 20, then press Enter. 
• Click on cell D7, then use the Home ribbon 

Numbers group, and choose Currency. 
The Cell should show $20.00. 

• Copy the contents of Cell D7, and paste the 
data into cells D8 – D57. 

Why did we do this? We want to add a total row 
to the table using the Table Design tab options. 
A total row needs something to total. 
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Total Row 

A useful table tool for quick data analysis is the 
Total Row. You can quickly total data in an Excel 
table by enabling the Total Row option, and 
then use one of several built-in functions 
provided in a drop-down list, per column. The 
Total row, which is added to the end of the 
table after the last data record, can calculate 
summary statistics, including the average, 
sum, minimum, and maximum of select fields 
within the table. 

The Total row is formatted with values 
displayed in bold, the double border line option 
is separating the data records from the Total 
row. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel total row. 

• Click anywhere in the Products table, then 
choose the Table Design ribbon. 

• In the Table Design, click the Total Row 
checkbox in the Table Style Options group. 
This will add a table Total Row. 

• Excel redirects you to the bottom of the 
table to view the total row, where a SUM 
was just calculated by default in the Prices 
column. 

Before we close this activity, let’s filter the 
Products table for only computers and power 
products. 

• Click anywhere in the Products table. 
• Filter the Sub-Category column with the 

Filter button by opening the dropdown 
filter options. 

• In the options, uncheck the box for Select 
All. 

• Then check the checkboxes for only 
Computer and Power. The table will then 
“collapse” rows to show only the Computer 

238  |  Chapter 9: Table Creation



and Power sub-category products, and the 
total for only those products. 

• SAVE your work, then close the file. We’re 
done! 
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Chapter 10: Table 
Management 

What We’ll Cover >>> 

• Freeze Panes 
• Basic Sorts 
• Custom Sorts 
• Custom List Sorts 
• Basic Filters 
• Criteria Filters 
• Slicers 

ACTION: Try Me activity 

In this chapter, we’ll work with a mid-sized 
table from Taste du Monde again. Make sure 
you make a copy of the Ch10-TableMgmt.xlsx 
file from your DataFiles folder and save it into 
your Examples folder. 

This is our goal for this work. 
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MedAttrib: author-generated. MS Excel Slicers. 

Open the Ch10-TableMgmt.xlsx file from your 
Examples folder. It has one worksheet and a 
table with 17 columns and 174 rows. The table 
has already been formatted, named, 
calculated, and is ready for us to practice views 
and sorts. 

Let’s look at various things we can do with 
tables. 

Freeze Panes 

We have worked a bit with simple sorts and 
filters, and we’ll practice more detailed 
versions. Before that, however, let’s find out a 
way to see some key data without quite so 
much scrolling. When one scrolls up and down 
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in a big table (and loses sight of the header 
row), or across more columns than can fit on a 
single screen view, it can be easy to get lost. 

Data sets can bridge thousands of records with 
dozens of fields and extend beyond a 
workbook window. It can be difficult to 
compare fields and records in widely separated 
columns and rows. One way of dealing with this 
problem is by dividing the workbook window 
into viewing panes by using the Split view 
option, then freezing certain rows or columns 
to keep them in place no matter where we 
scroll. 

In our specific file the data set is manageable 
– barely – so freezing the first column, and the 
top header row could be useful when scrolling 
through data. 

Using Freeze panes, or splitting windows, does 
not have any effect on calculations, a total row, 
or how a worksheet will print out. It is only a 
view aid. 

• Click in Cell A5. 
• Go to the View tab ribbon, and find the 
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Window group. 
• Click the Freeze Frames dropbox arrow, 

then select Freeze first column. 
• Now, scroll to the right of the worksheet. 

Notice how the first column remains 
frozen in place while the rest of the sheet 
scrolls past. 

• Click in Cell A5 again. 
• Go to the View ribbon’s Window group, 

click the Freeze Frames dropbox arrow, 
then select Unfreeze panes. This clears the 
frozen panes view. 

• Next, click the click the Freeze Frames 
dropbox arrow again, then select Freeze. 

• Now, scroll down and see how the header 
row remains in place while the rows scroll 
up. 

Now, what if we want to freeze both the header 
row and first column? This is a 2-frozen-pan 
operation, and takes a little more skill. We get 
to use the Split, then Freeze Panes options. 

• Go to the View ribbon’s Window group, 
click the Freeze Frames dropbox arrow, 
then select Unfreeze panes. This clears the 
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frozen panes view that froze the table’s 
header row. 

• Click anywhere in the table, then in the 
View ribbon’s Window group, click the 
Split button. This will reveal a cross-section 
that seems to split the worksheet window 
into four panes. 

• Use your cursor to grab and drag the 
horizontal line up until it rests just 
between the header row and the first data 
row (between Rows 4 and 5). 

• Then, use your cursor to grab and drag the 
vertical line left until it rests just between 
the first and second columns (between 
Columns A and B). 

• Next, click the click the Freeze Frames 
dropbox arrow, then select Freeze. 

• Your document should allow for scrolling 
while leaving the first column frozen, and 
the header row also frozen. 

This is efficient for very long and very wide 
tables. 
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MedAttrib: author-generated. MS Excel 
splitting frames before freezing them. 

Basic Sorts 

Sorting is one of the most common tools for 
data organization. By arranging data 
sequentially the information becomes more 
meaningful. Arranging records in a specific 
sequence is called sorting. If you sort by one 
column this is considered a single sort, which 
we worked on in Chapter 9. If you need to sort 
by more than one column, this is considered 
a custom sort. We already did a little sorting 
in earlier chapters, but sorting can be more 
complex than choosing one column and 
choosing A-Z. 
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The field or fields you select to sort are called 
sort keys. In Excel, you can easily – in one step 
– sort your table by ascending or descending 
order. Data in ascending order appears lowest 
to highest, earliest to most recent, or 
alphabetically from A to Z. Data in descending 
order in arranged by highest to lowest, most 
recent to earliest, or alphabetically from Z to A. 

Excel will sort a range of data that is not in 
a table., which we reviewed in the chapter on 
data ranges. However, when working with 
large sets of information it is wise to make the 
data a table for integrity, and we have also 
covered. Excel locks the row of information 
creating a record, thus when sorted, the record 
remains intact, just reorganized. For example, 
when you sort the table by last name, all of the 
records in each row move together. It is always 
a good idea to save a copy of your worksheet 
before applying sorts. There are multiple places 
you can find and use sorting tools: 

• When you first create a table, Excel 
automatically enables AutoFilter buttons; a 
tool used to sort, query, and filter the 
records in a table. The filter buttons appear 
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to the right of the column headings. When 
you click the filter button sorting options 
appear on the menu options. 

Sorts and filter options can be found in two 
ribbons. In the Home tab, in the Editing group, 
you can use the ‘Sort & Filter’ button, and then 
click one of the sorting options on the Sort & 
Filter menu. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Sort and Filter Menu. 

Also, from the Data tab, you can use the ‘Sort A 
to Z’ or ‘Sort Z to A’ buttons or for multiple levels 
select the Sort button to open the Custom Sort 
dialogue. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Data Tab Sort options. 

Finally, you can right-click anywhere in a table, 
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and then point to Sort on the shortcut menu to 
display the Sort sub-menu. 

Let’s review with a single level sort. 

• Click the Date column heading. 
• Using the Home ribbon’s Editing group, 

click the Sort & Filter button, then A to Z. 

Notice Excel arranges in chronological order all 
the Dates, keeping each record together. The 
filter button in the header row’s Date cell now 
displays an up arrow denoting an ascending 
sort. 

Custom Sorts 

Next, let’s try a 2-criteria sort. This allows us to 
sort a table by two important pieces of data 
(2 columns). The analyst looking at the 
Ch10-TableMgmt.xlsx file wants to consider 
data in the Region column, then in order of a 
dessert for that region. 

When you need to sort by more than one level, 
you must use the Custom Sort option. 
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• Click anywhere in the table. 
• Select the Data tab, and click the Sort 

button, which will open a Sort dialog box. 
Notice the last column sorted by is listed. 
We don’t want that, so we need to change 
the column heading name by dropping 
down the Sort by menu and selecting 
Region. Leave it at A to Z. 

◦ NOTE: For the Mac, the custom sorting 
is available instead in the Excel/
Preferences area. You specifically need 
to choose your Mac’s Excel button 
when in the Excel program, then 
choose Preferences, the Custom Sorts, 
and a window should open that allows 
you to add a new custom list. 
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MedAttrib: Screenshots from Mike Thomas 
Excel for Mac YouTube video. MS Excel for MAC 
Custom Sort access. 

• Then, while still in the sort dialog box, click 
Add Level. 

◦ Mac Users: click the + symbol. 
• Click the down arrow in the Then by

section, and choose the column heading 
for Dessert. Leave it at A to Z. 

• Click OK. 
• SAVE your work as you go: Keybind is 

CTRL S / Mac CMD S. 

Now the table is sorted by Region, and within 
the context of each Region, sorted also by the 
names of desserts from A-Z. 
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MedAttrib: author-generated. MS Excel Sort 
Dialogue Box 2-level. 

This can be done for several sort levels, 
although in order to do that, an analyst needs 
a specific reason to sort data by more than a 
couple of criteria. Common combos in basic 
tables (not just this one) can be things like: 

• Sort by region, then state 
• Sort by state, then by city 
• Sort by email, then opt-in 
• Sort by salesrep’s last name, then region 
• Sort by product, then category 
• Sort by sales date, then product sold 

Custom List sorts 

When sorting you can create custom lists that 
allow sorting by characteristics that do not sort 
alphabetically. Example, text items such as 
high, medium, and low – or S, M, L, XL. Dates 
commonly require custom lists so you can vary 
in the way data is sorted by days of the week or 
months of the year. 
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In our case, we want to create a custom list 
that sorts regions, which is not in ascending or 
descending order. The analyst likes to order the 
regions based on the part of the country and 
wants to focus on the West US. And, the analyst 
wants to see the desserts related to these, and 
their prices. 

Follow the below steps to create a custom list 
ordering: 

• While clicked in the table, choose the Data 
tab and click the Sort button. 

• In the Sort by row, click the drop-down 
menu in the Order Column for the Region 
heading. Choose Custom List. 

MedAttrib: author-generated. MS Excel 
Custom List Dialogue Box 3-level. 
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• Click in the List entries: box and type West 
and press enter. Type Midwest, then enter. 
Type Southwest, then press Enter. Once all 
locations are entered, click Add. Then 
choose Ok. 

• The second level sort can remain the 
same, because we want to still see the 
yummy desserts. 

• Add a third level sort by clicking on the 
second level, then clicking Add Level. 

• For the third level, choose Total from the 
list so that we can see the costs of the 
desserts. The Order will default populate 
Smallest to Largest. Instead, change that 
to Largest to Smallest. 

• Click OK to close the Sort dialogue box. 
• SAVE your work as you go. 

The custom sort is applied, and the table is now 
sorted by Region, using the custom order, then 
the dessert, and then by the Total column. The 
interesting thing is that we listed only three of 
the regions in our specific sort; the remaining 
regions simply sorted alphabetically after the 
sort list for Regions was applied. This allows us 
to see the three region areas as the priority of 
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the whole table but also includes the 
remainder afterward. 

Basic Filters 

If your worksheet contains a lot of data, it can 
be difficult to find information quickly. 
Applying Filters is an effective way to 
temporarily and only show the information 
needed. Typically when filtering you are 
searching the data for specific information to 
filter the remainder out. Generally speaking, 
you are searching the data based on a 
question, or in other words, querying the data, 
and returning only the information that 
satisfies the question. The process of filtering 
records based on one or more filter criteria is 
called a query. Filtering data hides the rows 
whose values do not match the search criteria 
– but note – it does not delete the data of the 
hidden rows, and some actions you take may 
still try to affect those hidden rows, so be 
careful. The information that does not display 
is not deleted, it is just hidden, and will be 
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redisplayed by removing the filter or applying a 
new filter. 

An additional note is that when filtering rows 
that contain calculated numbers (such as in a 
total row), the calculated number will change 
to reflect only the calculations based on the 
visible rows. 

Like sorting, Filter options are located in the 
filter button in each field name. By clicking the 
filter button, you can choose which values in 
that field to display, hiding the rows or records 
that do not match that value. The filter lets you 
choose to display only those records that meet 
specified criteria such as color, number, or text. 
In this situation, criteria is defined as; a logical 
rule by which data is tested and chosen. We 
applied a simple filter in Chapter 9 using the 
table header row filter buttons. 

For example, you can filter the table to display 
a specific name or item by typing it in a Search 
box. The name you selected acts as the 
criterion for filtering the table, which results in 
Excel displaying only those records that match 
the criterion. The selected checkboxes indicate 
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which items will appear in the table. By default, 
all of the items are selected. If you deselect an 
item from the filter menu, it is removed from 
the filter criterion. Excel will not display any 
record that contains the unchecked item. As 
with the previous sort techniques, you can 
include more than one column when you filter 
by clicking a second filter button and making 
choices. After you filter data, you can copy, find, 
edit, format, chart, or print the filtered data 
without rearranging or moving it. 

Example: if you have a table full of cities in 
Washington State, and you want to only see 
Seattle and Spokane rows, you can filter out the 
rest by clicking only the filter button for those 
two cities. 

Criteria Filters 

The filters created are limited to selecting 
records for fields matching a specific value or 
set of values. For more general criteria, you can 
use criteria filters, which are expressions 
involving dates and times, numeric values, and 
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text strings. Excel will identify what criteria filter 
to display based on the information in the 
column. For example, you can filter the 
employee data to show only those employees 
hired within a specific date range. Notice the 
criteria filter changes to Date Filters. If we were 
looking at the Current Salary column, the filter 
would be a Numbers Filter. 

Using criteria filters, follow the steps below to 
search for customers who have spent a total 
greater than $7.00. 

Identify customers by last name who spent 
more than $7.00 in the total column. 

• While clicked in the table, clear any sort or 
filter applied by clicking the Data tab. In 
the Sort & Filter group choose the Clear
button. 

• Click the Filter button in the Total column. 
Select Number Filters, and choose the 
Greater Than criteria. 

◦ Mac Users: uncheck the Select All
checkbox before choosing the 
Between option. 

• In the “Is greater than” field, type the 
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number 7, then click OK. 
• Sort the filtered table from A-Z by LName. 

Notice the filter button displays a filter symbol 
and an up arrow indicating the column is 
filtered and sorted in ascending order. Also, 
notice that fewer rows are showing, and that 
the total row shows the total for only the 
displayed rows. Let’s narrow down the bigger 
spenders. 

• Click the Filter button in the Total column, 
select Number Filters, and choose the 
Greater Than criteria. Type in 12. The result 
reveals fewer rows, and an adjusted Total 
in the total row for the spending of greater 
than $12.00. 

• SAVE your work as you go. 
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MedAttrib: author-generated. MS Excel 
Custom Autofilter. 

Slicers 

Another way to filter an Excel table is with 
slicers. Slicers, generally speaking, are visual 
filter buttons you can click to filter the table 
data. Slicers show the current filtered category, 
which makes it easy to understand what 
exactly is displayed. For example, a slicer for a 
field listing stores in several cities would have 
buttons for the Seattle, San Diego, Portland, 
and San Francisco locations. 

When slicer buttons are selected, the data is 
filtered to show only those records that match 
the criteria. Multiple buttons can be selected at 
the same time, and a table can have multiple 
slicers, each linked to a different field (column 
contents). When multiple slicers are used at 
the same time, Excel uses the AND logical 
operator so filtered records must meet all of 
the criteria indicated in the slicer. When 
selecting multiple buttons in a Slicer, use the 
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shift key to select adjacent field names. If the 
field names are not adjacent, use the non-
adjacent selection method, pressing the CTL 
button, and selecting the field names needed. 

The cool thing about slicers, though, is that 
they are a more easily visible way to change 
filters in a table instead of having to use the 
normal table header row filter buttons. By 
looking at the activated slicers, you can see at a 
glance what the filtering is, and at a touch, you 
can quickly change the criteria. 

Note: See finished chapter activities image 
above to see slicers. 

Follow the below steps to filter the table using 
visual Slicer buttons. 

• Click in the Taste du Monde table area. 
From the Data tab, choose Clear to 
remove the current sort and filter applied 
to the data. 

• Also, let’s clear the frozen view panes. Go 
to the View ribbon’s Window group, click 
the Freeze Frames dropbox arrow, then 
select Unfreeze panes. This clears the 
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frozen panes view. Why? Because we will 
be adding rows, and row 4 will no longer 
be the header row. 

• To make room for the Slicer buttons at the 
top of the table, we will add 7 rows 
between the title and the table area. 
Right-click cell A3. Choose Insert. Select 
Entire Row. Repeat these steps until the 
table header row starts in row A11. 

◦ Mac Users: should hold down CTRL 
key and click cell A3. Then repeat until 
the table heading starts in row A11. 

• Click back into the table area. Choose the 
Table Design tab, and in the Tools group, 
click Slicer. When the Insert Slicers 
dialogue box opens, click the Region and 
Dessert field names to display as slicers. 
Click OK. 

• Move, and re-size the two created Slicer 
boxes to fit in the approximate areas: 
Region around G/H 1-9, and Desserts 
around J/K 1-9. Make sure the buttons 
remain visible. Below is a visual example. 

• From the Region slicer, click the West 
button. Notice the data filters to only show 
the data for the West region. 

Chapter 10: Table Management  |  261



• From the Desserts slicer click Birthday 
cake. Notice the data filters to only show 
the data for Birthday cake in the West 
region. If there had been no matches, the 
table would appear empty except for the 
header row. 

• Return to the Region slicer and clear it by 
clicking on the filter icon with the red x. 
Then choose both NorthEast and East. 
Note the non-adjacent selection method is 
needed. Select Northeast first, then press 
and hold the CTRL button on the 
keyboard, and then select East. 

◦ Mac Users: hold down the CMD key 
not the CTRL key before you click on 
East. 

• Change the Desserts slicer selection to 
Apfelstrudel, Beignets, and Brownies,
using the same control/select as you did 
for the Region slicer. 

The table results show there are 7 customers 
in the NorthEast and East regions who ordered 
those three desserts. 

• SAVE your work, and close the file. We’re 
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finished! 
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Part 3: Workbook 
Management 

Excel workbooks often contain a large amount 
of data, and worksheets can quickly become 
overwhelming. When one worksheet becomes 
cumbersome, data can be broken out into 
smaller subsets and placed in separate 
worksheets within the same Excel file. 
Separating out spreadsheet data into smaller 
pieces can lead to better data organization 
within a file and increase its ease of use. When 
a retail company needs to track overall sales, 
as well as individual store sales, it makes sense 
to place each store’s sales data in a separate 
sheet within a file. Adding a summary sheet 
that sums across all the sheets will allow for 
total company sales data in the same file. This 
chapter will show how to set up a workbook to 
make multi-sheet formulas quick and easy. 

Other examples of when multiple sheets make 
the most sense are when you are comparing 
regional data for a salesforce and wish to 
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evaluate individual salesperson performance 
along with overall sales, and data over a period 
of time where sheets can be broken out by year 
or by month. When comparing data across 
several sheets, it is essential that all the sheets 
are laid out in the same way. To facilitate this, a 
template can be used. A template is the basic 
pattern for each new sheet that can be used 
repeatedly to make sure each new sheet has 
the same setup, formatting, formulas, etc. as 
the existing sheets in a file. In section, we will 
create examples from scratch to meet the 
specific needs of our work. 
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Chapter 11: 
Workbook Basics 

What We’ll Cover >>> 

• Adding/Deleting Worksheets 
• Renaming Worksheets 
• Copying Data to Another Worksheet 
• Copying Worksheets 
• Moving Sheets 
• Grouping/Ungrouping Sheets 
• Grouped Sheet Layout Settings 
• Grouped Sheet Headers/Footers 
• Worksheet Protection 

We have already worked with a couple of Excel 
workbook files that included multiple 
worksheets. Depending on the version of Excel 
you are using, a new Excel workbook file may 
open with a default of one or several sheets. 

TIP: Default sheets number. In the File 
Backstage Options area, under the 
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General tab. You can also set the default 
number of sheets that new files will 
open with. 

In this chapter, we will be working with a 
business file that contains information for an 
entire year. The file contains a worksheet for 
each quarter of the year, as well as a Summary 
sheet that will add info from all four quarterly 
sheets of data together. To begin with, we’ll get 
comfortable with moving through the sheets, 
organizing them, and making sure that all 
quarterly sheets are consistent. 

ACTION: Try Me activity 

Ihoosha Online Training is a sole 
proprietorship business with a freelance online 
trainer. The data is about students from around 
the US, who enrolled for online asynchronous 
trainings in 2022. The data contains learner 
contact information, enrollment information, 
costs per credit, and a space (uncalculated) for 
grades. 
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Here is what we are aiming for (5 worksheets 
sheets total): 

MedAttrib: author-generated. MS Excel 
workbook with multiple sheets. 

Their Ch11–Workbooks.xlsx file currently has 
four worksheets. The 2022 table has already 
been formatted, named, and manually 
separated into three quarterly worksheets, and 
is ready for us to work on. We need another 
quarterly worksheet, and will learn a manual 
method of acquiring that information. One 
useful thing to know: Ihoosha is focused on a 
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fiscal year of January-December of 2022, not 
an academic year of Fall 2021-Summer 2022. 
This will affect the order of things. 

• Open the Ch11–Workbooks.xlsx file and 
save a copy to work on. 

• Click on the different sheets at the bottom 
of the screen to move through the sheets. 
Notice also that all the quarterly sheets are 
identical in layout and format. Currently, 
2022 is first, then Winter, Spring, and 
Summer. 

• Fall – the last academic quarter that fell in 
2022, has no sheet. It needs to be added. 

Adding/Deleting Worksheets 

Now, for practice, let’s add then delete new 
worksheets in this same file (workbook). 

• Make sure you are in the 2022 worksheet, 
which has the full annual table. Click 
anywhere. 

• In the worksheet’s name tab section, click 
the + button to add another worksheet 
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tab, which should default name itself 
Sheet1. Sheet1 should appear just to the 
right of 2022. 

• Click the + button to add a third worksheet 
tab, which should default name itself 
Sheet2 and appear to the right of Sheet 1. 

• Click the + button to add a fourth 
worksheet tab, which should default name 
itself Sheet3 and appear to the right of 
Sheet 2. 

• We actually do not need all of these 
sheets. Choose Sheet1, so that you are in 
that blank sheet, then look in Home menu 
ribbon for the Cell group. 

• Click the down arrow on the Delete button 
and choose the Delete Sheet option from 
the drop-down list. This removes the 
Sheet1 worksheet. 

◦ Click the Delete button on the Delete 
warning box (if a warning box 
appears). 

• Alternate method: RIGHT-click on the 
name tab of Sheet2, which will offer a 
contextual menu. On the menu, click 
Delete. 

• This should still leave you with Sheet3. 
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• SAVE your work. 

Keyboard Shortcut: Inserting New 
Worksheets. Press the SHIFT key + F11 
key. 

Renaming Worksheets 

The default names for new worksheet tabs at 
the bottom of any workbook are Sheet1, 
Sheet2, and so on. However, you can change 
the worksheet tab names to identify the data 
you are using in a workbook. Additionally, 
using you can change the order in which the 
worksheet tabs appear in the workbook, and 
using that same process add a worksheet, 
delete one, protect one, etc. 

The following steps explain how to rename 
and manage the worksheets in a workbook: 

• Double-click the Sheet3 worksheet name 
tab at the bottom of the workbook. Type 
the name Fall. 

• Press the ENTER key on your keyboard. 
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Now we have a nice, empty sheet named 
Fall. We need to add some things into it. 

Copying Data to Another 
Worksheet 

First, this sheet should look like the others. 
Ihoosha already uses a specific Theme and 
color palette, and has a logo icon plus the 
company name at the top of worksheets. We 
need to copy that information from another 
sheet to this one. 

• Enter the 2022 sheet, and in cell B1, copy 
the name Ihoosha Online Training. Then 
move to the Fall worksheet, cell B1, and 
paste the name into it. 

• Re-enter the 2022 sheet, and copy the 
icon, then move to the Fall worksheet and 
paste it. You will likely need to drag it to 
the Fall sheet’s A1 cell space so it 
resembles the placement of other sheets. 

Now, we need to acquire data from the 2022 
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sheet and copy/paste it into the Fall sheet. Let’s 
start with the header row of the table. 

• In the 2022 sheet, select Cells A5-Q5, and 
copy them. Then move to the Fall sheet, 
place your cursor at cell A5, and paste. You 
should get a header row – without filter 
buttons – since this paste did not make 
this an Excel Table object. 

We need to copy only the Fall records from the 
2022 sheet to the Fall worksheet. How can we 
make this easier to find so we can grab the 
correct info? 

Pre-determining info to copy 

Let’s do some conditional formatting in the 
2022 worksheet to help visually determine 
what that data is before we actually copy/paste 
it elsewhere. Yes, we can and will sort the 
information, but assuming that Ihoosha 
chooses to use this sheet for 2023 later on, the 
conditional formatting can be even more 
efficient over the longer term, especially if the 
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student base (number of rows of students) 
triples or more. 

• Enter the 2022 sheet. Go to Cell K6, which 
is the first date in the Enrollment Date 
column. Let’s add conditional formatting, 
which will have to be created since it may 
not be a default Excel offering. 

• On the Home tab Styles group, click the 
Conditional Formatting dropdown. 

• Choose New Rule. 
• Choose “Format only cells that contain”. 
• In the Rule description, choose Format 

only cells with Cell Value. 
• Make sure the second field reads 

Between, and in the third field type 
October, and type December in the fourth 
field. 

• Click the Format button, which will open 
the Format Cells panel. In the panel, 
choose the Fill tab. 

• In the fill tab, choose the light green from 
the 7th column of the palette, second light 
green from the top. Click OK. 

• Click OK in the Formatting Rule panel to 
accept it. Click OK on the Rule Manager if 
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it is also still open, to apply the rule. 
• SAVE your work. 

Let’s find out what happens. Before we can get 
a result for the applicable dates, we need to 
apply this conditional formatting down the 
column. 

Use the Home tab Clipboard group format 
painter to paint the format of cell K6 over cells 
K7 – K166. 

Hmmm. . . that did not work. Why? It is likely 
because we looked at the value of the date 
cells, and Excel didn’t recognize that as a value 
that could be interpreted as October, 
December, etc. Well, mistakes are the stuff of 
learning! 

• Select cells K5-K166. 
• Open the Conditional Formatting 

dropdown and select Manage Rules to 
open the list of Conditional Formatting 
rules we have. There should be only the 
one we just created. 

• Click Edit Rule, which will open up our rule 
instructions. Instead of October, replace 
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that text with 10/01/22. Instead of 
December, replace that text with 12/31/22. 
Then click OK, then OK again to close the 
Rules Manager and apply the rule. 

MedAttrib: author-generated. MS Excel Edit 
Formatting Rule panel. 

Yay! That worked. And, since we applied the 
change in the rule formatting criteria to all cells 
in the table’s K column, the dates that met the 
rule complied and now have a light green 
background. 

Now, let’s sort! 

• Use the Enrollment Date table header’s 
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filter button to Sort the column from 
Oldest to newest. Because the Fall quarter 
dates are the final months of the year, this 
sort puts them all at the bottom of the 
table, bunched together. 

Now that we have the 2022 worksheet’s Fall 
months sorted together, we can easily see and 
choose to copy only the needed records and 
paste them into the Fall worksheet. 

• Select only the records at the bottom of 
the table, with the green-background 
dates, which are for October-December 
2022. 

• Copy only the records from columns A-Q. 
• Go to the Fall worksheet, and put your 

cursor at cell A6, then paste the 
information. This should paste in all the 
data you copied, starting at cell A6 and 
ending at Q66. 

• Finally, we need this to be a real Excel table 
object, to make sorting/filtering smoother. 
Select cells A5-Q66, then use the Insert 
ribbon’s Table icon to insert a table with 
the header row checkbox checked. 
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• Click anywhere in the new table object, 
then use the Table Design tab Table Styles 
to select Turquoise Table Style Light 10. 
This will format the table like those on the 
other sheets. 

• SAVE your work. 

Copying Worksheets 

Can’t we do this faster, with fewer steps? – says 
any student everywhere. Why yes, yes we can. 
Sometimes you will inherit a spreadsheet 
which requires more piecemeal tasks like we 
just finished, so that was of value to learn. 
However, we can also use a worksheet copy 
process instead of all these manual steps. 
Luckily, in this file, we already have done the 
work on the 2022 sheet with the conditional 
formatting for the date column, so that will 
help. 

• First, click on the name tab of the existing 
Fall worksheet, and change the name to 
TEMP-Fall. We don’t want to lose our work 
until we are certain we don’t need it any 
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longer. 
• Then, enter the 2022 sheet. Right-click on 

the 2022 worksheet tab name. 
• Select Move or Copy from the dropdown 

menu. 
• In the Move or Copy panel, first put a 

checkmark in the Create a copy checkbox. 
This is so that the 2022 sheet will be 
copied, not simply moved. 

• The To book field will show the name of 
the current file, since we are copying/
moving inside the same file. 

• Then, in the Before sheet, click (move to 
end) and click the OK button. 

A copy of the 2022 worksheet is now at the 
right side of all the other worksheet name tabs. 

• Double-click the 2022 (2) worksheet name, 
and type Fall to overwrite it. 

• Click into this “new” Fall worksheet. It is 
already formatted, and all we need to do is 
to separate out the Fall months of October, 
November, and December – meaning, in 
this case, that we need to KEEP those 
records, and eliminate the remainder. 
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• Review the worksheet. Currently, all the 
October, November, and December 
records should still be grouped at the 
bottom, which means you need to delete 
the other records between them and the 
header row (which is row 5). 

• Select Cells A6 through Q105, which are 
the record rows we need to delete. 

• In the Home ribbon Cells group, use the 
Delete dropdown list and select Delete 
Table Rows. 

• Now, the Fall sheet doesn’t need that 
conditional formatting. Select Cells K6 – 
K66, then in Home / Styles group / 
Conditional Formatting, choose Clear 
Rules, then Clear Rules from selected
cells from the flyout sub menu. The 
conditional formatting for this sheet goes 
away. 

• One more thing – let’s delete the TEMP-
Fall worksheet that we don’t need 
anymore. Right-click on the TEMP-Fall 
worksheet tab name, and choose Delete. 
Accept the warning and delete it. 

• SAVE your work. 
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Moving Worksheets 

There are a couple of ways you can move a 
worksheet. We’ll try both, since the annual 
2002 sheet should be at the end of the 
workbook, and the Fall worksheet should be at 
the beginning. 

• Right-click on the Fall worksheet’s tab 
name. In the dropdown menu, select Move 
or Copy from the dropdown menu. 

• In the Move or Copy panel, do NOT put a 
checkmark in the Create a copy checkbox. 
This is so that the Fall sheet will only be 
moved. 

• The To book field will show the name of 
the current file, since we are moving inside 
the same file. 

• Then, in the Before sheet, click 2022 (to 
move before that sheet) and click the OK 
button. The Fall worksheet should now be 
the first available worksheet tab at the left 
of all the worksheets. 

• Press your mouse cursor down on the 
2022 worksheet’s name tab, until you see 
a small icon of a sheet of paper floating 
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near your cursor. That is the indicator that 
you can, while still pressing down on the 
mouse cursor, drag the worksheet tab. 

• Drag the 2002 worksheet tab to the right 
of the Summer worksheet tab, then 
release the mouse/cursor. The annual 2022 
worksheet should now be at the end of the 
row of worksheet name tabs. 

• SAVE your work. 

Grouping/Ungrouping Sheets 

Most of your work will usually be one sheet at 
a time, but there will be times when you wish 
you could combine some work on multiple 
sheets at once. For a few things, like preparing 
for a print job, setting up all page layouts in a 
workbook, or selecting only some of the sheets 
for protection, you can. We will want to add 
headers and footers to our workbook on all the 
sheets, so temporarily grouping them for this 
work would be effective. 

However, grouping worksheets in Excel is 
temporary. It can be ungrouped if you click on 
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the name tab of one of the worksheets to 
navigate to the sheet to work on it. They will 
not ungroup if you work on the worksheet that 
is currently open in your workspace, but when 
you need to navigate away, they will ungroup. 
Let’s try this out. 

• We are still working with the 
Ch11–Workbooks.xlsx file. Click once on 
the Winter worksheet’s name tab. Then, 
hold the control / command (Mac) key 
down, click on the Spring tab, then release 
the control/command key. Notice that 
both of those worksheet tabs change 
color, to indicate they are grouped. 

• Click only on the 2002 name tab, and this 
will ungroup the other sheets. 

• Now, click once on the Fall tab, then hold 
your shift key down and click once on the 
2002 tab. This will group all five of the 
sheets. 

• Click on any of the worksheet name tabs 
to ungroup them. Alternate method: right 
click on one of a group of name tabs, and 
choose Ungroup from the dropdown 
context menu. 
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Grouped Sheet Layout Settings 

Let’s put grouping sheets to work for us by 
using this while creating header and footer 
content that should appear on every worksheet 
in the workbook. In this case, we want the Logo, 
company name, page number, and current 
date to show up on every page of the 
workbook. 

Header: A header in Excel is the top-of-the-
sheet area between the top of the margins for 
the sheet data, and the top edge of the sheet 
of paper/page itself. The space allowed is 
designated when setting up the page layout of 
a document. 

Footer: A header in Excel is the bottom-of-the-
sheet area between the bottom of the margins 
for the sheet data, and the bottom edge of the 
sheet of paper/page itself. The space allowed 
is also designated when setting up the page 
layout of a document. 

TIP: You can work on Headers and 
Footers through the Page Layout 
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ribbon’s Page Layout group’s Page 
Setup panel, OR you can work on them 
directly in the worksheet(s) by changing 
the sheet(s) view from the Normal view 
to the Page Layout view. 

There are no side-of-page data fields like the 
header and footer. 

Let’s group everything first, then check our 
margins, page size, and page orientation. This 
is covered in more detail in our chapter on 
Distribution. Enter the 2022 worksheet. 

• Group all the worksheets by selecting the 
Fall tab, holding the shift key down, then 
clicking in the 2022 tab. All sheets should 
be grouped. 

• You can work inside the 2002 sheet 
because it is the “open” sheet for editing in 
your workspace. Click once inside the 
sheet (not on the name tab). 

• Go to the Page Layout tab, and in the Page 
Setup group, select the Margins icon. This 
will open the Margins dropdown. 

• Click Custom margins, to see what the 
settings are. 
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MedAttrib: author-generated. MS Excel 
Custom Margins. 

We already have a top margin of 1.25 inches, a 
bottom margin of .75 inches, and side margins 
of .5 inches. The header and footer can be as 
close as .3 inches to the edge of the sheet of 
printed paper. Also, the content of any 
worksheet will be centered on the page when 
printed, even though in normal view we won’t 
be able to see that. We will keep these settings. 

• Click Cancel to close the panel. 
• With all the worksheets still grouped, click 
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Orientation in the Page Setup group. It 
should show that Horizontal/Landscape is 
selected. We will keep this. 

• With all the worksheets still grouped, click 
Size in the Page Setup group. It should 
show that Legal (8.5 x 14) is selected. We 
will keep this. 

• Now, with all the worksheets still grouped, 
look in the Page Layout ribbon tab, Sheet 
options group. Click the little button at the 
lower right of the group that will open the 
Sheet Page Setup panel. 

• In the panel, click the Header/Footer tab. 

Grouped Sheet Headers/
Footers 

Right now, the header and footer panel shows 
no header/footer content. Each has a 
dropdown arrow, which allows you to choose 
pre-set Excel content for either. Let’s 
personalize the header, and use a preset for 
the footer. This is covered in more detail in our 
chapter on Distribution 
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• In the panel, choose the Header button, 
which will open a custom Header panel. 

• In the Header panel, click in the Left 
section, and type Ihoosha Online Training. 

• While still in the Left section, select all 
three words, then click the Format Text 
button, which will open the Excel Font 
panel. 

• In the panel, choose Font style Bold, and 
size 16, then click OK. 

• Click OK again to exit the custom Header 
panel. Note how the Page Setup panel, 
which is still open, now shows your header 
information in the Header preview. 

• In the Page Setup panel, click the 
dropdown arrow for the footer for a 
different way to approach the footer. 

• Select the option Page 1 of ?, then click 
OK. 

• In the Page Setup panel, the footer 
preview will show Page 1 of 1. 

TIP: Excel update fields. In Excel header 
and footer content, some items may 
need to update to reflect the number of 
a page, or the current date. Excel adds 
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code to do this in its date, page number, 
file name, and file path header/footer 
options. S, Page 1 of ? means that Excel 
will replace the ? with the proper page 
number when the worksheet is viewed 
in print or in Page Layout view. 

• Click OK to exit the Page Setup panel. 
• Ungroup your worksheets. 
• Choose any worksheet, then choose the 

Page Layout view icon for it in the Excel 
status bar’s view option icons. In this view, 
with a little scrolling, you should be able to 
see the header and footer information on 
the sheet. 

• On the same worksheet, return to Normal 
view. 

• SAVE your work. 
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MedAttrib: author-generated. MS Excel custom 
header panel. 

MedAttrib: author-generated. MS Excel Page 
Setup panel for headers/footers. 

Workbook Protection 

Let’s do one more task. This workbook is for all 
of 2022, and Ihoosha just finished Fall quarter, 
which means some work might be added to it. 
The other quarters are finished, and should be 
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view-only, or protected from editing. Let’s do 
that. 

• You would already have ungrouped the 
worksheets at the end of the last task. 
Now, shift click on the Winter, Spring, and 
Summer worksheets to group them. 

• Right-click on your newly grouped 
worksheet tabs, which will offer a 
contextual menu. Interesting – the Protect 
Sheet option is grayed out. 

• With the sheets still grouped, let’s go to 
the Review ribbon, Protect group, and. . . 
Hmmmm. The Protect Sheet is grayed out 
there too. The only available option is to 
protect the whole workbook. 

In Excel for home and professional use, Excel 
only allows the protecting of one sheet at a 
time, or of a whole workbook. The Enterprise 
version has a multiple worksheet selection 
option, and there are macros that can do it, but 
for easy use, we’re stuck with one sheet at a 
time. 

Learning from things we can’t do can be useful 
too. 
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• Ungroup the three worksheets. Then right-
click on the Winter sheet, and choose 
Protect sheet. 

• In the password field, type the word safe 
• Don’t add any checkmarks in the list of 

choices,. Then click OK. 
• When asked to repeat the password, type 

the word safe in again. 
• Do the same steps to the Spring and 

Summer sheets. 
• SAVE your work and close the file. We are 

done here! 

TIP: Protecting work. Whenever you 
protect a worksheet in Excel, it usually 
means no one else can edit the 
worksheet (or workbook, if you protect 
the whole file). Be sure to know your 
protection password so you can unlock 
the sheet or workbook again. 
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Chapter 12: Data 
Linking 

What We’ll Cover >>> 

• Data Linking Formula 
• Click-Linking 
• Linking Between Workbooks 

An additional way to get data from one place 
to another is to use a Cell-linking method. This 
is when a workbook cell references data from 
another cell in a way that copies it in and also 
links it to the original cell. For instance, a 
master sheet may be updated, and have 
several other sheets dependent on it. If the 
original data is manually added to each 
worksheet, then new changes need to also be 
manually updated on each worksheet. Sigh. 

However, if data is entered into one worksheet, 
and cells in one or more locations on other 
worksheets need that data, Cell-Linking to that 
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data will bring it in. And, the only place the data 
needs to be updated is in the original sheet 
that the other sheets have linked to. Change 
that data – such as correcting a spelling or 
changing a date, and that data will 
automatically change on the other sheets 
referencing that data as well. Cool, huh? 

ACTION: Try Me activity 

We will work with Ihoosha Online Training 
again. In this case, we will work on the 
Ch12–DataLinking.xlsx file, and we will also 
need to reference the Ch12–DLSupport.xlsx file. 
You should make a copy of these from your 
DataFiles folder and put them into your 
Examples folder so you can work on the copies. 

Open the Ch12–DataLinking.xlsx file from your 
and look it over. There are four sheets: 
MarchLeads, 2023Students, GraphicsClass, and 
2022Fees. 
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Data Linking Formula 

The Data linking method is as simple as telling 
a cell where to get data from. Essentially, you 
will be telling a specific cell in Excel to look 
for data in another location, so that this cell 
populates with that same data in a way that is 
linked to the other cell the data came from. 

We can do that using a simple Excel formula 
method. The first thing we want to do is to add 
the leads from the MarchLeads sheet (host) to 
the end of the 2023Students sheet’s table 
(already populated). 

Enter the 2023Students sheet. The dataset in 
here is not an actual Excel table object, 
because this can have trouble adding rows of 
new data into the table object structure we will 
be applying here. Data needs to be added, then 
we can create an Excel table object. 
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MedAttrib: author-generated. MS Excel data-
linking process. 

In 2023Students, click on Cell A66. We need 
to tell that cell where to find some data. The 
cell is at the bottom of a column of student 
first names, and we want to add another first 
name of a student – which happens to be in the 
MarchLeads worksheet. 

• Now, in Cell A66, type this specific formula: 
=MarchLeads!A4 then press your enter 
button immediately. (Do not return to the 
other sheet or click anywhere else until 
after you hit Enter.) This should bring in 
the first student’s First Name from the 
worksheet called MarchLeads cell A4. That 
name is Hugh. 

• In cell B66, again type the linking formula, 
this time for the MarchLead sheet’s first 
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student’s LastName. The formula is 
=MarchLeads!B4 then immediately press 
enter, which populates the 2023Student 
worksheet’s cell B66 with the last name 
Culber. 

• In the 2023Student worksheet’s cell C66, 
type =MarchLeads!C4 and immediately 
press enter. 

• In 2023Student worksheet’s cell D66, type 
=MarchLeads!D4 and immediately press 
enter. 

Now you should see one record of a new 
student, which was “imported” / linked – in 
from the host MarchLeads sheet to the bottom 
of the already populated 2023Students sheet. 
Let’s make a change to see why this is useful. 

TIP: Always press Enter immediately 
after clicking into the cell you are 
getting data from, so that Excel will 
flawlessly link to the specific cell you 
clicked. If you do not, and instead travel 
back to the worksheet in which you 
started the formula, OR you accidentally 
click somewhere else, the datalinking 
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formula will get corrupted. 

• Enter the MarchLeads worksheetsheet, 
and go to Cell B4. We have the incorrect 
last name, which should be Colbert. 
Overwrite the name Culber with Colbert. 

• Enter the 2023Students sheet, and look at 
cell B66. The change we made in the other 
worksheet is also updated here: Culver 
changed to Colbert. 

• SAVE your work. 

Data Click-Linking 

There is an even easier way that doesn’t require 
you to type that little formula, and it is a little 
more accurate, especially when typing can 
bring in errors. (Your instructor has typing 
butterfingers).  This allows you to let Excel grab 
the info from another cell in the same sheet or 
another sheet (or even another workbook!) and 
bring it in for you with a CLICK. 

In order for data click-linking to work, you 
always need to have the destination cell (the 
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cell the linked d=data will appear in) begin with 
the Equals sign.  = 

• In the 2023Students sheet, click in cell 
A67. 

• In cell A67, type only the equals sign: = 
• Then, while still in the cell, enter the 

MarchLeads worksheet, and find cell A5, 
and CLICK on that cell then immediately 
press Enter. Excel will automatically finish 
the formula with the cell’s address (which 
is MarchLeads!A5) and link the cells. 

• In the 2023Students sheet, click in cell B67
and type only the equals sign. 

• Then enter the MarchLeads sheet, and 
find cell B5, and CLICK on that cell, then 
immediately press Enter. 

• In the 2023Students sheet, click in cell 
C67 and type only the equals sign. 

• Then enter the MarchLeads sheet, and 
find cell C5, and CLICK on that cell, then 
immediately press Enter. 

• In the 2023Students sheet, click in cell 
D67 and type only the equals sign. 

• Then enter the MarchLeads sheet, and 
find cell D5, and CLICK on that cell, then 

Chapter 12: Data Linking  |  299



immediately press Enter. 
• SAVE your work. 

ANNNND now, you are asking “Are we there 
yet??” Almost, yes. Because, we now get to 
apply the formulas to the cells below the ones 
we just input. 

• In the 2023Students sheet, click cell A67 
and copy it. Then, paste it down to  cell
A68. 

• Check the formula in Cell A68. It should 
read =MarchLeads!A6. 

Given that there are 47 more first names in 
the MarchLeads sheet, you can safely copy the 
contents of Cell A68 down 47 more cells in 
Column A, from cell A69 – cell A115. All the 
relevant student first names from the 
MarchLeads sheet column A will populate the 
2023Students sheet column A. Let’s try. 

• In the 2023Students worksheet, copy 
cell A68, and paste it into cells A69 – A115. 

I think I can guess what you are thinking. It 
is either time to go hydrate with your favorite 
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beverage, or you can try this fast linking in an 
even more efficient way. 

• In the 2023Students sheet, select all three 
cells B67, C67, and D67, and copy them. 

• Place your cursor at cell B68, and select all 
the cells from B68 – D115, then Paste using 
either CTRL / CMD V (Mac), or the Home 
tab’s Clipboard group’s Paste icon. 

• WHOOSH! All those cells should populate 
with the click-linked formula for you. 

• Are we THERE yet? 
• Yes. 
• SAVE your work. 

You should see that all the student last names, 
states, and email addresses from the 
MarchLeads sheet have now populated the 
2023Students sheet Columns B through D. 

One more important thing: This click linking 
is good to keep active in the populated 
worksheet if you plan to make minor data 
changes in the host sheet. However, this means 
that if the order of the data in the MarchLeads 
sheet changes, like if that sheet is sorted, the 
data references in the 2023Students sheet will 
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repopulate with the new data from the host 
sheet. In a small spreadsheet, this might not 
be a real issue. However, imagine a sheet with 
hundreds of click-linked rows of data suddenly 
had massive changes in the data, especially if 
other data in the records did not change with 
it. 

If you are at all concerned about your 
populated data getting changed on you, you 
can “break” the link easily, while keeping the 
data you just click-linked in. Let’s do that here. 

• In the 2023Students sheet, select all the 
data from Cells A66 – D115. 

• Copy all the data in that selection, then 
Paste VALUES of the data over itself ( the 
same cells A66 – D115). 

• Using the Home tab’s Clipboard group’s 
Paste icon, click the down arrow for the 
dropdown paste options menu, and 
choose Paste VALUES. 

• Then, click in cell A66, which had the click-
link value, and you can observe that it no 
longer has the formula, just the results. 
The data is safe from any changes, resorts, 
filters, or other big changes that could 

302  |  Chapter 12: Data Linking



happen in the MarchLeads worksheet. 

Let’s do a bit more work with this particular 
sheet, to clean things up. 

• Click anywhere in your 2023Students 
sheet, then use Insert to convert the 
dataset into an Excel table object with 
headers. 

• Use the Table Design tab’s Table Styles 
group to select the Turquoise Table Style 
Light 10 to apply it to the table. 

• In the Table Design tab, click the checkbox 
for Total Row. 

• Scroll to the bottom of the table, so that 
you can see the total row below the final 
student LastName. 

• Click in cell B116, and you should see a 
filter down arrow. Click it, and choose 
Count. This gives the count of students 
listed in the table. 

• Now, go up the worksheet to cell F3. In the 
cell, type the equal sign = then click in cell 
B116 and press Enter. The number 110 
appears in cell F3. 

• SAVE your work. 
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This is a really useful way of grabbing a lot of 
data from one place and bringing it over to 
another. Let’s practice it a little more. We’ll 
populate the GraphicsClass worksheet with 
information from the 2023Students worksheet. 

• In the GraphicsClass worksheet, click on 
cell B6. In it, type = then click on one of the 
cells in the 2023Students worksheet that 
shows the Comp203 course, like in the 
record for Sonora Vargas. In my sheet, that 
is cell F50. 

• In the GraphicsClass worksheet, click on 
cell B7. In it, type = then click the 
2023Students cell G50. 

• In the GraphicsClass worksheet, click on 
cell B8. In it, type = then click the 
2023Students cell H50. 

If you would like, you can use the rest of the 
GraphicsClass worksheet to practice 
populating the class with names from records 
in the 2023Students worksheet of students 
who are taking the Comp203 – Graphics Suite 
course. 
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MedAttrib: author-generated. More click-
linking. 

Linking Between Workbooks 

Another way to get data is to use a similar 
process but with an external workbook. This 
isn’t quite like importing from a database, 
though it is a little more complex than the 
click-linking we have been doing here. 

You need to have easy access to the file you 
want to link to for accessing the specific data. 
And, the file should be saved into the directory 
you link from, because if the file is moved, the 
links could break the current spreadsheet. 
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In our case, we will use the other Chapter 12 file 
you hopefully also put into your working folder: 
Ch12–DLSupport.xlsx. 

Look at the currently open 
Ch12–DataLinking.xlsx file, for the 2022Fees 
worksheet. That worksheet only needs two 
pieces of information, likely from a 2022 file: the 
total number of students, and the total amount 
of fees. 

• Open the Ch12–DLSupport.xlsx file. There 
is only one worksheet. Scroll to the bottom 
so that you can access row 167, where 
there is a count of student last names and 
a currency number. 

• In the Ch12–DataLinking.xlsx file’s 
2022Fees worksheet, Click cell C5, then 
type = 

• Then, navigate to the Ch12–DLSupport.xlsx 
file, and click in cell C167 and immediately 
press your Enter button. Excel will 
immediately return to cell C5 in the 
2022Fees worksheet, and display the 
count in it. 

• Now, In the Ch12–DataLinking.xlsx file’s 
2022Fees worksheet, Click cell C6, then 
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type = 
• Then, navigate back to the 

Ch12–DLSupport.xlsx file, and click in cell 
H167 and immediately press your Enter 
button. Excel will immediately return to 
cell C6 in the 2022Fees worksheet, and 
display the currency amount in it. 

• Close the Ch12–DLSupport.xlsx file 
without saving it so that only your 
2022Fees worksheet is still open, with the 
two important numbers. 

• Click on each cell that you populated with 
the imported numbers, and look at the 
formula contents. This displays the name, 
sheet, and cell of the external file the data 
is linked to. 

• Click on cell C6, and use the Home tab 
Number group to convert the amount to 
Currency, with a decimal point and two 
zeros after it. 

• SAVE your work, and close the 
Ch12-DataLinking.xlsx file. We’re finished! 
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MedAttrib: author-generated. MS Excel data-
linking process from an external file. 
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Part 4: Formulas 
and Functions 

Perhaps the most valuable feature of Excel is its 
ability to produce mathematical outputs using 
the data in a workbook. This section reviews 
several mathematical outputs that you can 
produce in Excel through the construction of 
formulas and functions. The section begins 
with a chapter on the construction of formulas 
for basic and complex mathematical 
computations. Another chapter reviews 
statistical functions, such as SUM, AVERAGE, 
MIN, and MAX, which can be applied to a range 
of cells. Another chapter addresses functions 
used to calculate mortgage and lease 
payments as well as the valuation of 
investments. This section also shows how you 
can use data from multiple worksheets to 
construct formulas and functions. 
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Chapter 13: 
Formulas - 
Operations 

What We’ll Cover >>> 

• Formula Basics 
• Parts of a Formula 
• Basic Formulas 
• Auditing Formulas 
• Quick Analysis Tool 
• Common Error Codes 

This section reviews the fundamental skills for 
entering formulas into an Excel 
worksheet. Excel is used for many kinds of 
calculations: mathematical, statistical, 
financial, scientific, reference lookups, and 
more. It is useful in many types of business, 
and is a key tool in cleaning, calculating, and 
analyzing data. 
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Formula Basics 

A main strength of Excel is that you can use 
it to calculate data in many ways. Calculations 
allow for the development of additional data 
for analysis and decision making. A 
spreadsheet full of employees, their salaries, 
and the value of their benefits packages is 
useful. Calculating the annual and quarterly 
costs can be more useful in using for 
comparisons, preparing for taxes, etc. 

Excel formulas are an expression that operates 
on values in a range of cells and return a result. 
They let you do calculations like addition, 
subtraction, multiplication, and division. 

Excel functions are also formulas, but they are 
predefined by Excel for particular business 
purposes and perform calculations by using 
specific values, called arguments, in a 
particular order, or structure. 
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Formula bar 

We’ve used the formula bar a bit when not 
directly inputting data into Excel cells. The 
formula bar reflects what is in a cell. However, 
its power comes from the ability to write and 
process formulas, to display named ranges and 
how the formula is organized, and in helping 
identify errors. 

In the example, the formula bar is displaying 
a simple calculation for Cell A1. To the left of 
the field, the small fx icon is a way to open 
the Functions panel and access to the Excel 
functions library. The checkmark (green when 
it is active) is a way to approve a formula instead 
of simply pressing Enter. The X icon (red when 
it is active) is important because it allows you 
to back out of the formula bar without saving 
what is in it. Why is that useful? It can be all 
too easy to accidentally click in the wrong cell 
and corrupt a working formula, and the red X 
lets you stop before you can save and exact the 
corruption, error, etc. 
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MedAttrib: author-generated. MS Excel 
formula bar. 

Formula Ribbon 

In Excel, you can manually input formulas, as 
we did in the earlier chapter on click-linking to 
data cells. You can also use the Excel Formula 
tab/ribbon to access common predefined 
functions and to look up a wide variety of pre-
built formulas in the Excel function library. This 
is also where we have found the Name 
Manager tools for naming ranges in a dataset. 
Those named ranges show up in formulas in 
a way that keeps a formula from seeming to 
access random and long strings of cell range 
information. The named ranges add context in 
a formula, especially for troubleshooting. 
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MedAttrib: author-generated. MS Excel 
Formula ribbon. 

The Excel Function Library 

Users can access the Function Library from the 
Formulas tab by clicking on the Insert Function 
icon. The Insert Function panel opens and 
allows for a search of formula-related keywords. 
You can also try to browse through the 
category dropdown. This is useful to people 
who work in specific industries in which they 
use a lot of calculations and know just what 
to look for, whereas for basic workplace talent, 
most of the available functions won’t mean 
anything or be useful. The use is in context of 
one’s training in specific career areas requiring 
calculations. 
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MedAttrib: author-generated. MS Excel Insert 
function / Function Library access. 

TIP: Faster Function library access. Click 
the FX symbol to the left of the Formula 
Bar, which opens the Insert Function 
dialog box. Or you can press SHIFT F3 
(function button). 

Thinking out formula scenarios 

A key part of succeeding in using any formula 
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or function is to know exactly what you want 
to accomplish. Students in numbers and data-
heavy fields are usually learning the skills for 
what calculation processes are needed for their 
field (scientific, accounting, higher-level math, 
research, etc.), and Excel is a tool to accomplish 
that. Students in fields that don’t work with a 
lot of data or computations can have trouble 
formulating the scenario, or words, for what 
needs to be calculated and why/how. Yet, we 
need to be able to do this to decide what 
formula to write or find in the Functions. 

Steps 

First, keep in mind that any calculation is a kind 
of combination of a story problem (UGH!) and a 
test of logic. 

• How much is a “service”? 
• What is a bonus for a high achieving real 

estate agent? 
• How many products were sold in the last 3 

months? 
• How many days are in a class quarter? 
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• If you know someone’s name and look it 
up in a table, can you tell what region they 
represent or how much property they sold 
or what grade they earned? 

SO, the first thing you have to do is make sure 
you understand exactly what is being asked. 
Then you need to figure out what exactly you 
are trying to reference – to look at – so you can 
pull out the information you need. Then you 
need to ask Excel the right kind of question in 
terms Excel can calculate from. 

Here’s something I learned when I first took a 
class in basic programming: 

• Write out what I think that I’m being asked 
to do. 

• Drink coffee (or fave beverage). 
• Write out what steps I think I would need 

to do to get at the information. 
• More coffee. 
• Look up / research Excel information to see 

what the types of calculations I need to do 
might require. 

• Think about stronger coffee, but likely go 
for calming tea or water. 
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• Study the basic logic and format of a 
calculation to see if it can do what I need. 

• Take a break for a serious treat or rest. 
• Experiment. 

Say you are being asked to get a total of the 
sales from the 8 sales reps who sell coffee to 3 
cafes. You would figure (rightly) that you need 
to see a list of all their sales, then get a total of 
those numbers. You would be looking to get a 
grand totals response in terms of currency. 

Say you need to find out which coffee roasts 
sold well over Fall 2022? You would need to 
figure out how to ask Excel to look up the 
column of roast flavors, see the quantities sold, 
and look at this info for only the months of 
September, October, November, and 
December 2022. You would need more 
information to find out if you are supposed to 
find the count for each coffee, or the dollar 
amount sold, etc. Then you would need a way 
to either do a subtotal table, or a lookup table, 
etc. 

Say you (as a teacher) have 30 students who 
have finished the class and need you to 
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calculate their final grades. You need to know 
the students’ names, their final points, and 
some table of what points are equal to what 
publishable numeric grade. You would need to 
do some kind of lookup and have the response 
calculate into your student roster next to their 
point count so you could accurately update the 
school grades with the right numeric grade 
(4.0, 3.8, etc.) 

You usually have to logically process what is 
being asked, and carefully decide what is 
needed. Take your time, map it out if you need 
to, and even write a layman’s English (or your 
own first) Language process. Then figure out 
how to ask Excel to calculate it for you. The 
Excel Functions menu tab/ribbon and 
Functions lookup provides wizard windows for 
every function, so if you know what I need to 
look for, you can use those quite handily. 

Parts of a Formula 

When you make a formula in Excel, there are 
several different components that supply the 
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source data to the formula and express what 
operations should be performed on that 
information. Depending on the formula 
type, you may need include any or all of the 
following items: 

• Starting the formula: In order for Excel to 
know the cell content will be a formula to 
be calculated, you need to start by typing 
the EQUAL sign = This tells Excel that the 
contents of the cell will be an answer to a 
question (equal to), rather than a string of 
text or a basic numbers to format in some 
way. 

Your mandatory BFF for all formulas – the 
EQUAL sign. 

• Constants: Numbers or text values that 
you enter directly in a formula, like =2*3. 
This is a manual way of telling a formula 
what to calculate with. 
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• Cell reference: A reference to a cell that 
contains the value (item) you want to use 
in your Excel formula, e.g. =SUM(A1, B2, 
C3). This allows you to create formulas that 
can be copied and reused, rather than 
requiring a manual input of the numbers 
yourself. 

• Range reference: To refer to data in two or 
more contiguous cells, you use a range 
reference like A1:A5. For example, to sum 
values in all cells between A1 and A8, 
inclusive, use this formula: =SUM(A1:A8) 

• Named range reference: A defined name 
for a cell range, constant, table, or function, 
such as =SUM(TaxCol). In earlier chapters 
we created and used named data ranges 
in part to prepare for working with 
formulas. 

Operators 

Operators: These are special symbols that 
specify the type of operation or calculation to 
be performed, such as +, *, etc. They tell Excel 
what the operation, or calculation method, is 
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to be, like sum, quotient, division, etc. For this 
chapter, we’ll only look at arithmetic. 

• Addition: + (plus sign) 
• Subtraction: – (minus sign) 
• Multiplication: * (asterisk) 
• Division : / (forward slash) 
• Percent: % (percent sign) 
• Exponentiation: ^ (caret) 
• Equal to: = 
• Greater than: > (greater than sign) 
• Less than: < (less than sign) 
• Greater than or equal to: >= (greater than 

or equal to sign) 
• Less than or equal to: <= (less than or equal 

to sign) 
• Not equal to: <> (not equal to sign) 

The order in which calculation is performed can 
affect the return value of the formula, so it’s 
important to understand the order, and to use 
parentheses to change the order to obtain the 
results you expect to see. If a formula contains 
operators with the same precedence — for 
example, if a formula contains both an addition 
and subtraction operator — Excel evaluates the 
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operators from left to right. Otherwise, you will 
want to use parentheses to separate/clarify 
sections of a formula. For instance, 
multiplication and division happen before 
addition and subtraction. 

=12+5*3  would be 27 

=(12+5)*3 would be 51 

Excel uses the standard mathematical order of 
operations. When writing complex formulas it 
is important to remember this order of 
operations. You want to be sure that your 
formulas will calculate in the order you intend. 
To help you remember which operations will 
be performed first, you can use the acronym 
PEMDAS. 

P – parentheses 

E – exponents 

MD – multiplication and division 

AS – addition and subtraction 
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Cell References 

Cell References are a way to refer to the 
contents of a cell. 

• Absolute: Absolute references 
remain constant, no matter where they 
are copied. 

• Relative: Relative references change when 
a formula is copied to another cell. This 
allows a formula to be reused and to pick 
up the contents of the record around it so 
that you don’t have to manually input all 
numbers (constants) yourself. 

• Selection: You select one or more cells 
while creating a formula or a location 
reference in another table and/or 
worksheet. 

• Named: You can Define a Name of a cell 
so that the cells remain stable in a formula 
that you copy and paste for further use in 
other cells in a column. This would be an 
Absolute reference. Otherwise, the pasted 
formula will change the cell’s location 
reference to be relative to the new row it is 
seeking to create the formula for. Example: 
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=Fee*20, where the cell I5 has been named 
FEE, is more stable than =I5*20. Other 
formulas needing the contents of cell I5 
would use the named reference FEE 
instead. 

• Circular Reference: This happens when a 
formula is trying to calculate itself, and you 
have an Excel feature called iterative 
calculation turned off. It can also happen 
during indirect references in a formula. It 
results in errors. 

Note: Formulas can be written with only 
relative references, with only absolute 
references, or with mixed references. 

Basic Formulas 

In this chapter, we will keep things 
straightforward and will work with basic 
mathematical formulas. 
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ACTION: Try Me activity 

We will work with the Taste du Monde 
workbook, named Ch13–Calculations.xlsx. 
Make a copy of the file for your Examples folder, 
then open that copy. 

Here is what we are aiming for: 

MedAttrib: author-generated. MS Excel Ch13 
finished calculations. 

The workbook has only one sheet, which is 
more of a worksheet than a practical company 
ledger. 
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Let’s start with the basic manual math. 

The formulas begin with the = sign, to tell Excel 
something is being calculated, an answer will 
be provided. 

Remember: Your mandatory BFF for all 
formulas – the EQUAL sign. 

• Cell B15 needs to add 72 and 64, which is a 
sum. In B15, type =72+64 with no spaces. 

• Cell C15 can use this function instead: 
=SUM(72, 64) 

• Cell B16 needs to subtract 678 from 1734, 
which is a difference. = 1734-678. 

◦ NOTE: There seems to be no 
comparable subtraction function in 
Excel. 

• Cell B17 needs to multiply 228 and 34, 
which is a product. =228*34 

• Cell C17 can use this function instead: 
=PRODUCT(228, 34) 

Chapter 13: Formulas - Operations  |  327



• Cell B18 needs to divide 279 by 10, which is 
a quotient. =270/10 

• Cell C18 can use this function instead: 
=QUOTIENT(270, 10) 

• Set the data format in cells B15-C18 to 
Comma, NO decimals. 

• SAVE your work. 

Relative References 

Relative: Relative references change when a 
formula is copied to another cell.  What this 
means is that if you create a formula to sum 
up the total numbers of a row, then paste that 
same formula down one cell to sum up the 
total numbers of the next row, Excel will 
assume you want the references to the cells 
with the numbers in the new row to change 
inside the pasted formula. 

Row 1’s Cell D1: cell A1 + cell B1 + cell C1 would 
equal the total of the numbers in those 3 cells. 
The formula in cell D1 would be =A1+B1+C1 

Then, pasting  =A1+B1+C1 into Row 2’s cell D2
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would automatically change it to =A2+B2+C2,
because Excel assumes you want the formula 
to calculate the proper total for Row 2 
information. This is what a “relative” reference 
in a formula in Excel means. 

Relative references in a formula allow a formula 
to be reused and to pick up the contents of 
the record around it so that you don’t have to 
manually input all numbers (constants) 
yourself. 

Now, let’s add some of the things in the Taste 
du Monde table. 

• Cell F6 needs to add cells B6-E6, and 
because there are several numbers, the 
Excel formula that uses a Relative 
reference to those cells will do the job: 
=SUM(B6:E6) 

• Cell F7 needs to add cells B7-E7. Let’s copy 
the formula from cell F6 and paste it into 
cell F7 and learn what happens. 

NOTE: Relative Reference. Copying the 
formula from Cell F6 and pasting it Into 
Cell F7, and having that change the 
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formula to calculate the sum of Cells 
B7-E7, is an example of Relative 
References. Excel was able to adjust the 
formula to be relative to the data 
related to Cell F7, instead of simply 
copying the exact numbers from Cells 
B6-E6. 

• Cell F8 needs to add cells B8-E8. Copy the 
formula from cell F6 and paste it into cell 
F8. 

• cell F9 needs to add cells B9-E9. Copy the 
formula from cell F6 and paste it into cell 
F9. 

• Now, we cannot do this for cell F10. Why? 
Because cell F10 is supposed to be the 
sum of Cells F6-F9, the cells above it in the 
column. 

• Type =SUM(F6:F9) 

Let’s get a little more experience and range. 
Rows 17-22 ask for a little more, and we’ll need 
to think about the order of operators – the 
order of what we calculate – when more than 
one calculation is happening in the formula. 

• Cell B20: =F6-E6 
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• Cell B21: =F10*0.055 
• Cell B22: =F10/3 
• SAVE your work. 

Before we calculate the next three, it would be 
useful to create a named data range instead of 
referring to the range of cells more manually. 

• Select Cells F6 through F9, then use the 
Formulas tab, Defined Names group, 
Define Name dropdown, Define Name 
selection, and type RegionSums in the 
Name field, then click OK. 

Now these three functions should work 
properly as typed: 

• Cell B23: =AVERAGE(RegionSums) 
• Cell B24: =MIN(RegionSums) 
• Cell B25: =MAX(RegionSums) 
• Then, lets also try B27: =SUM(B6:B9)*0.96 
• B28: =SUM(C6:C9)/3 
• SAVE your work. 
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Absolute References 

Absolute references remain constant, no 
matter where they are copied. This means that 
the number inside a specific cell (like a tax rate 
or a specific discount percentage) should 
remain the exact same info in every instance of 
a formula it is used in. This is useful if you need 
one value (number) in a formula to remain the 
same no matter what rows of data are being 
calculated against it. We’ll do this with the Tax 
Needed cells in column G. 

An absolute reference is referred to differently 
in a formula / function. The idea is the tell Excel 
to freeze the reference so that it remains static 
– the same cell, no matter how it is used in 
a column that might otherwise auto-calculate 
relative references for you. 

The Absolute reference format uses a dollar 
symbol ($) before the cell’s coordinates to 
make the cell reference fixed/absolute. An 
example would be referring to the Cell G12 – a 
tax amount – as $G$12 in a calculation. Let’s try. 

• Cell G6: =F6*$G$12    This is to calculate the 
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tax needed for the New York currency 
sum. 

• Cell G7: Copy cell G6 and paste in cell G7. 
Notice the formula still refers to the tax 
info in $G$12, which is absolute to Cell G12, 
which is what we want. Yet, the relative 
reference to cell F6 changes to F7 to let 
Excel calculate the tax needed relative to 
the San Fransisco currency sum. 

• Cell G8: Copy cell G6 and paste in cell G8. 
• Cell G9: Copy cell G6 and paste in cell G9. 

Again, we cannot do this for cell G10. Why? 
Because cell G10 is supposed to be the sum of 
cells G6-G9, the cells above it in the column. 

• Type =SUM(G6:G9) 
• SAVE your work. 

TIP: Use Universal Constants. There will 
be times when you are writing formulas 
that you will need to use universal 
constants, or numbers that do not 
change, such as the number of days in a 
week, weeks or months in a year, and so 
on. For example, if you are calculating 
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the monthly cost of an item when you 
know the yearly cost, you will always 
divide by 12 since there are 12 months in 
a year. In this case, you use the constant 
of 12 instead of a cell reference because 
the number of months in a year never 
changes. 

Auditing Formulas 

Excel provides a few tools that you can use to 
review the formulas entered into a worksheet. 
For example, instead of showing the outputs 
for the formulas used in a worksheet, you can 
have Excel show the formula as it was entered 
in the cell locations. This is demonstrated as 
follows: 

• With the Ch13Calculations.xlsx file open, 
click the Formulas tab of the ribbon. 

• Click the Show Formulas button in the 
Formula Auditing group of commands. 
This displays the formulas in the 
worksheet instead of showing the 
mathematical outputs. 
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MedAttrib: author-generated. MS Excel Ch13 
finished calculations showing formulas. 

• Click the Show Formulas button again. The 
worksheet returns to showing the output 
of the formulas. 

You can also toggle Show Formulas on and off 
using the keyboard. Hold down the CTRL key 
while pressing the ` key. 

Keyboard Shortcut: Show Formulas. 
Hold down the CTRL key while pressing 
the accent symbol. 

Two other tools in the Formula Auditing group 
of commands are the Trace Precedents and 
Trace Dependents commands. These 
commands are used to trace the cell references 
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used in a formula. A precedent cell is a cell 
whose value is used in other cells. The Trace 
Precedents command shows an arrow to 
indicate the cells or ranges (precedents) which 
affect the active cell’s value. A dependent cell 
is a cell whose value depends on the values 
of other cells in the workbook. The Trace 
Dependents command shows where any given 
cell is referenced in a formula. The following is a 
demonstration of these commands: 

• Click cell G12. 
• Click the Trace Dependents button in the 

Formula Auditing group of commands in 
the Formulas tab of the ribbon. A blue 
arrow appears, pointing to cell G6. This 
indicates that cell D3 is referenced in a 
formula entered in cell F3. 

• IF NEEDED for an instructor’s 
assignment, SCREENSHOT HERE. 

• Click the Remove Arrows command in the 
Formula Auditing group of commands in 
the Formulas tab of the ribbon. 

This removes the Trace Dependents arrow. 
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• Click cell F10. 
• Click the Trace Precedents button in the 

Formula Auditing group of commands in 
the Formulas tab of the ribbon. A blue 
arrow with dots in cell F6, and pointing to 
cell F10 appears. This indicates that cells 
D3 and E3 are references in a formula 
entered in cell F3. 

• Click the Remove Arrows command in the 
Formula Auditing group of commands in 
the Formulas tab of the ribbon. 

This removes the Trace Precedents arrow. 

• SAVE your work. 

Quick Analysis Tool 

The Quick Analysis Tool allows you to visualize 
data with a couple of steps. For instance, it 
is meant to be a quick way you can add the 
visual of sparklines of in-cell charting to pair 
your info in a table with a visual enhancement. 
However, it now seems to be an add-on pack, 
which we won’t do now. If you do want to add 
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this to your Excel for PC or MAC, you will need 
to: 

• Click the File tab then click Options. 
• Click the Add-Ins category. 
• In the Manage box, select Excel Add-ins 

then click Go. 
• In the Add-Ins available box, select the 

Analysis ToolPak checkbox, then click OK. 

To use the Quick Analysis, Be sure to press CTRL 
~ to return your spreadsheet to the normal view 
(the formula results should display, not the 
formulas themselves). 

• Select the range of cells B6:E9. 
• In the lower right corner of your selection, 

you will see the Quick Analysis tool (see 
Figure 3.4). 
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MedAttrib: author-generated. MS Excel Quick 
Analysis pop-up. 

When you click on it, you will see that there 
are a number of different options. Alternatively, 
you can right-click on the selected range and 
choose QuickAnalysis from the  dropdown list. 
This time we will be using the Totals option. 

• Select Totals, and then the SUM option. 
Selecting that SUM option places =SUM() 
calculations in row 10. 

• SAVE your work and close the file. We’re 
done with it. 
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MedAttrib: author-generated. MS Excel Quick 
Analysis Totals/Sum result. 

 

Common Error Codes 

Excel presents a number of error codes when a 
formula doesn’t work properly. And, for learners 
who work with Excel for standard/casual 
practice, the codes may not mean a lot or tell 
you exactly how to fix the problem. Excel tends 
to be somewhat obtuse in explaining a 
problem, because the explanation is general to 
the “type” of issue the program can’t resolve, 
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not the exact nature of your actual formula and 
formula data. SUPER ugh! 

However, when you get one of these, Excel 
does offer you a small green or yellow icon right 
by the error formula that you can click for a link 
to some help. There also tend to be Microsoft 
error code info pages, and responses to doing 
an Internet search. 

These codes should give you something to 
start with, 

• #DIV/0! Trying to divide by 0 
• #N/A! A formula or a function inside a 

formula cannot find the referenced data 
• #NAME? Text in the formula is not 

recognized 
• #NULL! A space was used in formulas that 

reference multiple ranges; a comma 
separates range references 

• #NUM! A formula has invalid numeric data 
for the type of operation 

• #REF! A reference is invalid 
• #VALUE! The wrong type of operand or 

function argument is used 
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Chapter 14: 
Functions - Data 
Management 

What We’ll Cover >>> 

• Concatenation 
• Proper Function 
• Text to Columns 
• Left/Right Functions 
• Hyperlink Function 

A lot of data you will use in Excel may be text, as 
well as numbers. You may inherit spreadsheets 
with data in inconsistent formats, such as when 
it is imported from other sources or added 
manually from data entry. You may be tasked 
with making existing data which works very 
well in the workbook appear differently to be 
better able to be viewed in charts and output 
materials. Various functions exist that allow you 
to do these things, without actually being 
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functions that calculate number. These 
functions are for Data cleanup. Here are a few 
common ones: 

MedAttrib: author-generated. MS Excel data 
management functions. 

An important thing to learn about 
Concatenation and other text/dummy info 
formulas like those in the image above is that 
you are essentially changing, blending or 
separating contents of cells so that your 
spreadsheet can use the same information 
differently. 

• For instance, if you have a column of 
customer names with both the first and 
last name in it, and you want to be able to 
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sort the sheet by last name, you may not 
be able to do so unless you separate out 
the first and last names in that single 
column into two separate columns. Text to 
Columns can do this. 

• Conversely, you may have two-three 
columns of information that would be 
more useful if they were combined into 
one column. Concatenation (blending) can 
do this. 

• You may have a spreadsheet with columns 
that have all the letters in all capitals, and 
want them to appear in upper and lower 
case instead; text-changing functions like 
UPPER, LOWER, and PROPER can help 
with that. 

• Adding or removing spaces, or specific 
characters in a column of cells, can be 
done with the LEFT, RIGHT, REPLACE, 
TRIM, CLEAN, and their variants. 

NOTE: Static Value/Dummy Text is when you 
need a part of a formula/function to be treated 
exactly a specific way, rather than allowing 
Excel to convert it automatically as if it was a 
number or a calculation portion of a formula. 
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For instance, if you want numbers, or a space, 
or a symbol like a dash to be treated as a piece 
of static text in a concatenation formula, you 
will need to add that piece inside of quotation 
marks or else Excel might try to autoformat the 
result as a number format or not recognize the 
space or symbol. Example: using the number 
001 in a concatenation or other formula would 
be autoformatted as 1, whereas “001” (with the 
quotes around it) will appear in a formula’s 
results (like concatenation or splitting 
columns) as 001. A space meant to be a static 
value/dummy text should be input as ” “ and a 
symbol as “@”  . 

In this chapter, we’ll practice four common 
text-based formulas so that you can get a feel 
for what you can accomplish. 

Proper Function 

ACTION: Try Me activity 

We will work with a Prisvard Tech workbook, 
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named Ch14-Concat.xlsx. Before you start 
working, go to your DataFiles folder and make 
a copy of the file for your Examples folder, then 
open that copy. Let’s see what we are aiming 
for: 

MedAttrib: author-generated. MS Excel Data 
Management results. 

The workbook has only one sheet, named 
SalesReps. It is mostly empty, and needs us to 
create new email addresses for the reps. The 
names are currently in uppercase, and in two 
columns, which will be hard to make email 
addresses from. 

We’ll work from left to right to accomplish 
several data conversion tasks until we can 
create the email address for each rep. 

Like numeric/calculation formulas and 
functions, these formulas begin with the = sign, 
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to tell Excel that something is being changed 
and that an answer will be provided. 

First, lets change the Sales Reps names from 
being upper case to a proper case. 

• Click on cell C5. We need to convert cell A5 
from allcaps to a proper format, from 
SHANE to Shane. We will do this in cell C5 
which is the column called  PropFName. 

• We’ll use the Proper function, which 
changes the case of letters in text data for 
us. We’ll need to find the function. 

• While in cell C5, click the FX insert 
function symbol just to the left of the 
Formula bar. 

A dialog box opens: 
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MedAttrib: author-generated. MS Excel data 
Insert Function dialog box. 

• In the “Search for a function” field, type 
Proper, then click GO. 

• From the list of resulting functions, choose 
Proper, then click OK. 

Another dialog box will open: Function 
arguments. 
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MedAttrib: author-generated. MS Excel data 
Function Arguments dialog box. 

This dialog box asks you to tell you want should 
be converted. The easiest way is to either type 
the name of the cell to be converted, or to click 
on the cell. 

TIP: Cell referencing in Function dialog 
fields. While building a function/
formula, including while in a Function 
dialog box, you can click on a cell in 
your worksheet to reference it in a cell. 
Leave the dialog box open, find the cell 
in your workbook, click on it, and the 
reference will appear in the dialog box 
field. 

• While in the dialog box, click on cell A5. 
The dialog box will populate the field with 
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the contents of A5 (SHANE), preview what 
it looks like, and preview what the results 
of the function will be (Shane). 

• Click OK to finish the function calculation. 

We need to do the same thing to Shane’s last 
name in cell D5. 

• Click on cell D5, and click the FX insert 
function symbol just to the left of the 
Formula bar. The Insert Function dialog 
box will open, and the first item in the list 
will likely be PROPER since we just used it. 
Click that top open the Function 
Arguments box. 

• In the dialog’s Text field, type B5, and 
review the previews before clicking OK. 

• Let’s copy this function through the 
remaining C and D column. 

• Select cell C5 and D5, CTRL C to copy (CMD 
C for Mac), then paste them into cells 
C6-D15. This will populate the proper first 
and last names for us. 

Cell D8 has a problem, which we will have to 
handle manually. Mccandless should be 
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McCandless per conventional spelling of a 
name beginning “Mc”. 

• Select cell D8, copy it, and use Paste 
Values to replace the formula with the text 
results of the formula. This way, you can 
change the cell contents manually without 
interfering with a formula. 

• In cell D8, change Mccandless to 
McCandless. 

Concatenation 

Next, we need to merge the contents of the C 
column cells and D column cells together so 
that we can have both the first and last name 
of the Sales Reps in the same column. This will 
allow us to use them to build and email 
address. We will use the Concatenate function, 
which lets us set up a formula that also 
accounts for adding space between the first 
and last names. 

• Click in cell F5, and use the FX symbol by 
the formula bar to open the Insert 
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Function Dialog. 
• In the search field, type concate, and click 

GO. 
• Choose Concatenate, which opens the 

Function Arguments dialog. 

In this case, the function starts with 2 fields, 
since the function is about combining more 
than one cell/piece of data. I our case, we will 
need 3 (three). Pay attention below. 

• In the first field, type C5. 

In the second field, we actually have to specify 
that we need a space between the first and 
last name in the function results, or the first 
and lastname will appear as ShaneMorgan. We 
also have to use quote marks to reference the 
space, because Excel expects that all 
arguments in a function are the data contents 
of a cell, not something you insert from 
another source. 

• In the second field, type “ “ which is an 
open quote, a space, and a closed quote. 

Note that a third field appears as you use the 

352  |  Chapter 14: Functions - Data Management



second field. Excel can string together several 
items to make a concatenation, and adds fields 
as you use one so that you have the option to 
populate them with needed data. 

• In the third field, type D5, then click OK. 

MedAttrib: author-generated. MS Excel data 
Function Arguments for Proper dialog box. 

Cell F5 now should show Shane Morgan, which 
is the joining of the contents of cells C5 and D5. 

• Copy the contents of Cell F5 into cells 
F6-F15 to populate them with the data. 

• SAVE your work. 
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Text to Columns 

This is a good time to find out how to separate 
data in one column into two columns. For this 
to work, however, Excel needs the data to be 
separated to be a static value, not the results of 
a formula. This static value is ‘dummy text’ that 
Excel can’t autoformat for us, as noted at the 
beginning of this chapter. 

• Select cells F5-F15, copy, and paste the 
range over itself as Paste Values. This 
removes the formula while retaining the 
results of the formula. 

Next, let’s separate the contents of cell F5 into 
cells G5 and H5. 

• Select cell F5, the go to the Data ribbon, 
Data Tools group, and click the Text to 
Columns icon. 

A Wizard will open. We need to tell this wizard 
that Shane Morgan (2 words with a space 
between them) needs to be separated into one 
word for each of Cell G5 and H5. 
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TIP: Excel Wizards. Excel has a few 
Wizard mini apps that are like built-in 
action macros, They have several steps 
that allow you to make choices so that 
Excel can perform an otherwise 
complex action for you. 

In the Wizard, you are in Step 1, which asks for 
you to interpret the original data type. Ours is 
delimited, because the text has been delimited 
(positioned) by a space. 

• Click Next. 
• Choose the Delimiter (item that affected 

the placement of Shane and Morgan, 
which is the space between them). You 
may have to uncheck every one, then 
choose only the Space delimiter. 

• Click Next. 

The third step needs you to tell Excel where the 
new data will go. Because the data will be split 
into 2 columns (first and last name), it will need 
2 empty columns already available to put the 
split into. We have them, with columns G and 
H. However, Excel needs you to only specify the 
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first of the columns and it will populate both 
columns for us. 

• In the Destination field, type $G$5 to 
specify a fixed place. An Absolute 
reference is needed so only that one cell is 
referred to. 

• Click Finish. 
• SAVE your work. 

MedAttrib: author-generated. MS Excel Text to 
Columns wizard. 

Observe that cell G5 should have Shane in it, 
and H5 should have Morgan in it. 

There is one problem. The contents of cells G5 
and H5 are not actually formulas for you to copy 
and paste down. The column split worked for 
only one row. 

Let’s do the rest. 
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• Select cells F6-F15. 
• Click the Data ribbon’s Text to Columns 

icon. 
• In Step 1, make sure that Delimited is 

selected, then click Next. 
• In Step 2, make sure that only Space is

check marked, then click Next. 
• In Step 3, in the Destination, type $G$6, 

then click Finish. 

Cells G6-H15 should now be populated. 

• Because they default populated in a 
centered text alignment, use the Home 
tab Format Painter to select the Format of 
cell D5 and apply it to Cells G5-H15. 

• SAVE your work. 

LEFT/RIGHT Functions 

Next, we want to capture only part of a Sales 
Rep’s last name in column H for a new creation 
of a RepID. We’ll put the formula for this into 
column I, and use the LEFT function to capture 
the first 3 letters of the SalesReps last names. 
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In order to do this, we need to tell Excel exactly 
which letters we need it to pull and put in the 
column I. 

• Select Cell I5. 
• Click the FX symbol by the Formula bar, 

and in the search, type left. 
• Double-click the LEFT entry in the 

resulting list. 
• In the Function Arguments dialog, type 

the needed Cell you plan to get the letters 
from, which is H5. 

• In the Num_Chars field, type 3, so that we 
can get the first 3 letters of the last name. 

• Click OK. 
• SAVE your work. 
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MedAttrib: author-generated. MS Excel LEFT 
Function Arguments dialog. 

• In Cell I5, you should see Mor. It is centered 
text, so left align it. 

• Copy Cell I5 into I6-I15. This should 
populate the working formula down the 
rest of the data range’s column. 

Let’s concatenate the Column I partial names 
with a number to make a SalesRep ID number 
in column J.   An example of what we mean 
by this is to create a SalesRep ID number that 
looks like Mor-001. 

• Click cell J5, and then click the FX symbol 
by the formula bar (or choose Formulas 
ribbon, Insert Function icon). 

• In the search field, type concat, and click 
GO. 

• Choose Concatenate from the list and 
click OK. 

• In the Function Arguments, type I5 in the 
first text field. 

• In the second field, type “-“ (quote dash 
quote). 
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• In the third field, type “001”   Note that this 
number needs to be inside quote marks so 
that Excel does not autoformat the 
number to the digit 1. 

• Click OK. You should now see Mor-001 in 
cell J5. 

• Left-align cell J5. 
• Copy cell J5 to J6-J15. This will populate 

these cells with the relative SalesRep ID 
numbers. 

Finally, let’s create the email address. This will 
also be a concatenation of several fields this 
time. We are ‘stringing’ pieces of static data 
together into one column so that each sales 
rep has a unique email address built in part 
from their first and last name and the Prisvard 
email address. 

• Click cell K5, and then click the FX symbol 
by the formula bar. 

• Choose Concatenate from the list and 
click OK. 

• In the Function Arguments, type G5 in the 
first text field. 

• In the second field, type “.“ (quote period 
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quote). 
• In the third field, type H5 
• In the fourth field, type “@prisvard.com” 

with the quote marks. 
• Click OK. This should give you 

Shane.Morgan@prisvard.com in cell K5. 
• Left-align cell K5. 
• Copy Cell K5 to K6-K15. tot populate these 

cells with their relative email addresses. 

MedAttrib: author-generated. MS Excel 
CONCATENATE Function Arguments dialog. 

• SAVE your work, and close the file. We’re 
done! 
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Hyperlink Function 

Hyperlinks are active links to different locations, 
like to a website, to an email address, and to 
another location in a existing file. We see them 
frequently in websites – their navigation links, 
their link to their comment and sign-up forms, 
their links to other websites and online 
resources, etc. Hyperlinks can be and are used 
in documents off the web, too. For instance, in 
a master’s thesis or a novel written in a Word 
document, the table of contents will link to 
‘anchors’ in the paper’s pages that begin 
sections or chapters. In Excel, hyperlinks are 
useful to link to external websites, as an 
example. 

Excel has multiple ways of adding/editing 
hyperlinks. You can set Excel to default to 
automatically changing a text URL (website or 
email address) to an active clickable link. You 
can manually add hyperlinks as you need 
them. Or, you can use a function that will allow 
you to add or edit multiple hyperlinks at one 
time. 
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Default Hyperlinks 

In Excel, you can set the program to 
automatically change the text for a website 
URL or online email address to a clickable 
hyperlink. Actually, this is already the default, 
but sometimes you might want to turn it off. 
Why? 

When an Excel cell has an active hyperlink in it, 
the whole cell act like the clickable hyperlink. 
When you select the cell to edit it, the hyperlink 
will click and try to pen your computer’s default 
browser then go to the hyperlinked URL. This 
can get annoying. 

In Excel’s backstage area – accessed on the PC 
through the File tab, you can find the hyperlink 
setting under Options / Proofing / Autocorrect 
Options, and in the resulting Autocorrect 
dialog window, under the Autoformat as you 
type tab. The actual command is “Internet and 
network paths with hyperlinks “, and when this 
is check-marked, it is active. To stop Excel from 
doing this, uncheck the box. 
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MedAttrib: author-generated. MS Excel default 
hyperlink option. 

Individual Hyperlinks 

When in a worksheet, you can select a cell that 
has an un-hyperlinked URL/email address in it, 
and make it active manually. We noted this in 
Chapter ___. To refresh: 

• Select the needed cell A3. 
• In the Inserts ribbon, click the Hyperlink 

button (near the middle right). There may 
be a list of recent documents you have 
used, but ignore those for now; click Insert 
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Link which is listed at the bottom of the 
dropdown. 

Insert Link will open an Insert Hyperlink panel, 
which offers the options to link to: “an existing 
file or web page”, a “place in the same 
workbook”, a “new creation of another 
document”, or “an email address”. 

MedAttrib: author-generated. MS Excel Insert 
hyperlinks. 

• Choose the Existing File or Web Page 
option. 

• Then, in the Address field at the bottom of 
the panel, type the URL or Email address. 
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Keyboard Shortcut: Add Hyperlink. 
Hold down CTRL key while pressing 
letter K on your keyboard / Mac 
CMD K. 

Function for Mass Hyperlinks 

Sometimes, you may need to change a whole 
column of static text showing hyperlinks into 
active, clickable ones. There is a fairly basic 
function for that. Keep in mind that this will 
definitely be a formula using relative references 
– if you use a version to refer to specific cells. 

HYPERLINK(link_location, [friendly_name]) 

• Link location (required) is the web page, 
email address, file location, or document 
anchor location. 

• Friendly name (optional) is the name of 
the web page, or the person who owns the 
email, or the document being linked to. 

Examples: 
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=HYPERLINK(“http://www.shoreline.edu”, 
“Shoreline Community College”) 

=HYPERLINK(“#Sheet2!A1”, “Sheet2”) 

=HYPERLINK(“C:\SCHOOL\BUS150\DataFiles\
Links.xlsx”, “Excel Links File”) 

=HYPERLINK(B2, A2) 

MedAttrib: author-generated. MS Excel mass 
hyperlinks. 

NOTE: This is an example – if you want to 
practice, you can reopen the Ch14-Concat.xlsx 
file, and try this mass hyperlink formula for the 
emails in Column K. If you do, be sure create a 
new column in Column L, and call it something 
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like EmailLinks, do the formula in there, and 
when finished to SAVE your file before closing 
it again. 

Remove Mass Hyperlinks 

This question here is whether to remove the 
clickable hyperlink, or the field altogether. 

IF you want to remove the clickable hyperlinks 
in a column, you can select the whole column, 
copy it, then paste values over itself to keep 
only the text content, not the formula. This 
problem here is if you do this over a column in 
which all the hyperlink addressed are displayed 
as Friendly Names, the actual URL address will 
be stripped out of the cell when the formula 
is removed. So, ONLY use this on columns in 
which you can read the actual URL address. 
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Chapter 15: 
Functions - 
Statistical 

What We’ll Cover >>> 

• Average Functions 
• Count Functions 
• Sum Functions 
• Round Functions 
• Value-finding Functions 
• Time Functions 

In this chapter, we will cover some statistical 
functions. Many of these are routine to general 
support functions in a number of businesses, 
and may also appear in some academic/
training courses. Statistical functions are about 
calculating things like averages of data, counts 
of items, and sums of values. They are also basic 
mathematical functions that need additional 
criteria to clarify what is being calculated. 
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In review, formulas are various forms of 
calculations that can be developed and written 
as needed. 

Functions are predefined formulas, of which 
Excel has many to make getting work done 
more efficient. Functions tend to fall into 
various areas of focus, like statistics, scientific, 
mathematic, financial, data retrieval, and more. 

The components of a function are as follows: 
=FunctionName(Arguments) 

• The Arguments are the criteria, such as the 
cells you are pulling data from, or the fixed 
values you type in (like numbers). 

Functions are a type of formula, therefore they 
always start with an equal sign = 
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Your mandatory BFF for all formulas – the 
EQUAL sign. 

The next component is the name of the 
function. After the function name comes the 
arguments for the function, which are always 
enclosed in parentheses. The arguments are 
the cell locations and/or values that will be 
used in the function. The number and type of 
arguments varies based on the function being 
used, although in this section we will only work 
with a range of cells for the function 
arguments. Here are a few common ones for 
statistics: 
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MedAttrib: author-generated. MS Excel 
Statistical Functions table. 

In Excel, there are several methods for adding a 
function to a worksheet: 
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• Typing the function directly into a cell 
• Using the Function Library on the ribbon 
• Using the Insert Function button 

ACTION: Try Me activity 

We will work with a combination activities 
workbook, named Ch15-Stats.xlsx. Before you 
start working, go to your DataFiles folder and 
make a copy of the file for your Examples 
folder, then open that copy. 

Our goal for this work is in two parts, and is 
shown further in the chapter. 

The workbook has three sheets. The first is 
named Stats, and we can practice some of 
these functions unrelated to an example 
project. The second is named Ihoosha, and has 
a table of test scores for one of its online classes. 
The third is just a non-working  information 
sheet with a table of common statistical 
functions you can use for your reference. 

Like previous formulas and functions we’ve 
worked on, these formulas begin with the = 
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sign, to tell Excel that something is being 
changed and that an answer will be provided. 
Note that in some cases, the functions below 
may include the header row of the required 
table – but in others, the data part of the table, 
NOT the header row info, will be used. 

Average Functions 

Average functions are used to find the average, 
or arithmetic mean, of data. They are useful for 
looking at scores or other data that needs 
some kind of averaging. 

Let’s consider Ch15-Stats.xlsx’s first worksheet, 
named Stats. We will use data from some or all 
of the tables on the sheet to calculate things 
requested in cells B15 through B31. 

• Click on cell B15. To get the average of the 
list of numbers in the Amount table of 
numbers (cells A4-A13), use the AVERAGE 
function: =AVERAGE(A4:A13) 

Note that, because the table of cells A4-A13 has 
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been given the name tbl_Amount in the Table 
Design ribbon, the formula will interpret your 
A4:A13 instead as tbl_Amount[Amount]. This 
will happen in the rest of these tasks since in 
the Practice Worksheet all of the tables were 
given names in the Table Design ribbon. You 
can type in the cells I list, or you can select the 
range of data I list so that Excel picks up the 
range and adds it to the formula. 

Click on cell B16. To get an average of only the 
numbers in the Amount table cells A4-A13 that 
are over 500, we need the AVERAGEIF function, 
which looks for one specific criteria (greater 
than 500) before it can calculate. 

• Type =AVERAGEIF(A4:A13,”>500″) 

Click on Cell B17. For this we will consider 
another table of mixed data – the Values table 
in column E. To get an average of only the 
numbers in cells E4-E13 fall between 55 and 
1000, we need the AVERAGEIFS function, which 
looks in the whole one-column table for values 
of more than 55 and for values of under 1000 
before it can calculate the answer. 
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• Type 
=AVERAGEIFS(E4:E13,E4:E13,”>55″,E4:E13,”
<1000″) 

• SAVE your work. 

Count Functions 

Count functions are used to do counts of data 
locations, like the number of items in a long 
spreadsheet meeting some specific condition. 
They are different than simply using filters, 
because they are about looking for data in the 
context of other data, not just sorting or 
filtering cell values. The data can be in numeric 
or text formats. 

Click on Cell B18. To get a count of only the 
numbers in G column’s Counts table of mixed 
text and numeric data (cells G4-G13), use the 
COUNT function. It will count only the 
numbers, not the text. 

• Type =COUNT(G4:G13) 

Click on Cell B19. To get a count of the cats 
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in the C column table of Items (Cells C4-C13) 
– which are strings of text, not numbers – we 
need the COUNTA function. 

• Type =COUNTA(C4:C13) 

Now we will work with a more complex multi-
column table of movie information: the Sales 
table of columns I-N. 

Click on Cell B20. To get a count of Sandy’s 
appearance in the movie Sales table – which is 
full of strings of text and numbers – we need 
the COUNTIF function. The COUNTIF needs to 
look for one specific criteria (Sandy’s name) 
before it can calculate. 

• Type =COUNTIF(I4:I13,”Sandy”) 

Click on Cell B21. To get a count of specific 
movies that sold for $9.99 in the Sales table, 
we need the COUNTIFS function. This looks for 
more than one specific criteria: the quantity of 
the films, and the price of the films) before it 
can calculate. 

• Type 
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=COUNTIFS(K4:K13,”>100″,L4:L13,”=9.99″) 
• SAVE your work. 

Sum Functions 

Sum functions are used for adding data. Some 
of the data may need to meet specific 
conditions beyond just being a sum field at the 
end of a row or column of numbers, and a 
couple of more complex Sum-related functions 
can draw these out. 

• Click on Cell B22. To get the SUM of the 
prices listed in the Sales table ( including 
the header), use the SUM function: 
=SUM(L4:L13) 

Click on Cell B23. To get an SUM of only the 
quantities of films sold by Shanon in the  Sales 
table, we need the SUMIF function. This looks 
for one specific criteria (Shanon in the 
Salesperson column) before it can calculate her 
quantity of sales from the K column. 

• Type =SUMIF(I4:I13 ,”Shanon”, K4:K13) 
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Click on Cell B24. To get an SUM of only the 
DVDs of Good quality, we need the SUMIFS 
function. This looks for more than one specific 
criteria before it can calculate. It will look at the 
quality of the film type DVD and return a sum 
of the related prices from the Price column. 

• Type =SUMIFS(L4:L13,M4:M13 
,”DVD”,N4:N13,”Good”) 

• SAVE your work. 

Round Functions 

Round functions are simply used to present 
data in some form of rounding of to a specific 
number of digits. In math, numbers aren’t just 
whole; calculations can take numbers to 
several or dozens of numbers past a decimal 
point, and rounding can bring this under more 
manageable control. This is how we get that 
the value of PI seems to represent 3.14, rather 
than 3.14159265359. 

• Click on Cell B25. To round up the contents 
of cell L10 with no decimal points, type 
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=ROUNDUP(L10,0) 
• Click on Cell B26. To round down the 

contents of cell L10 with no decimal points, 
type =ROUNDDOWN(L11,0) 

• SAVE your work. 

Value-finding Functions 

Value-finding functions in statistics are about 
determining the placement of data – high, or 
low, or median placement. This can be used 
in determining percentiles, like in assessing 
salaries, scores, demographics, etc. Our 
example is very simple, but these formulas are 
designed to be used with much longer ranges 
of data. 

• Click on Cell B27. To look for the minimum 
number that appears in the one-column 
Amount table, type =MIN(A4:A13) 

• Click on Cell B28. To look for the maximum 
number that appears in the one-column 
Amount table, type =MAX(A4:A13) 

• Click on Cell B29. To look for the median 
(middle-value) number that appears in the 
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one-column Amount table, type 
=MEDIAN(A4:A13) 

• SAVE your work. 

Time Functions 

While Excel offers time functions in its Header 
and Footer options (like in the footer the date 
of a document being opened), you may find 
a need to note a specific time or date in the 
content of a worksheet. 

• Click on Cell B30. To have Excel tell us 
what the exact time and date of right now 
is, type =NOW() 

• Click on Cell B31. To have Excel tell us what 
today’s date is, type =TODAY() 

• SAVE your work. 
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MedAttrib: author-generated. MS Excel 
Statistical Functions worksheet. 

Practical Use 

Let’s put some of this into practical use, so that 
we can see some outcomes of a valid table of 
data. Go to the 2nd worksheet in Ch15-Stats.xlsx 
which is named Ihoosha. This contains a table 
of some student test scores, course points, and 
class costs. We can do some calculations in the 
table, and then use the worksheet-like area 
below to consider some Count and Values-
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based functions that are relevant to this kind of 
data. 

First, let’s review the table to comprehend what 
is needed. There is the primary table of cells 
A4-H19 called Table1, with input data, which 
uses the Excel Turquoise table format. There 
is a portion of the table with a light gray 
background to separate the contents from 
most of the values that will be calculated with. 
There is the E column that has a light orange 
background, for calculation results of Student 
Averages. The F column has a light green 
background for more calculations, of Weighted 
Averages. 

NOTE: While this table has been set up with 
the data formats already in place, in real life 
you will usually need to format numbers in 
various columns yourself. 

Let’s get the average of student Latanya’s three 
test percentages. 

• Click on cell E5. 
• Type =AVERAGE(B5:D5) to calculate the 

average of her three scores. 
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• Copy the results of cell E5 down into cells 
E6-E17, so that the other student averages 
are also calculated. 

Click on cell F5. Here, we need to do a complex 
sum of three items in one calculation. This is 
actually just a sum; however, we need a mixed-
reference formula (some relative references for 
the scores, and absolute referencing for the 
specific test weights from row 19). These 
weights tell us that, regarding the importance 
of the tests in the student scores, test 1 and test 
2 are each worth 25% of the accumulated total 
test points, and test 3 is worth 50% (it is likely a 
final exam). 

• In cell F5, type 
=SUM($B$19*B5,$C$19*C5,$D$19*D5) 

This has us add the products of Latanya’s 1st 

test score to 1st test weight, 2nd test score to 2nd 

test weight, and 3rd test score to 3rd test weight. 
Next, let’s finish off for the remaining students 
in the table. 

• Copy the results of cell F5 down through 
cells F6–F17. 
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• SAVE your work 

Now the table is complete. Let’s get to the 
additional worksheet fields in cells A22 
through A31. This will allow us to gather more 
useful information about the students’ scores 
and performance from their table data and 
calculations. The cell ranges used in this 
section will refer to the actual data cells in the 
table, not the header row or the grayed-out test 
averages/weights rows. 

• In cell B22, calculate the Count of students. 
This should use a COUNTA formula (for 
text) and reference cells A5 – A17. 

• In cell B23, calculate a count of Test 1. This 
should use a COUNT formula (for 
numbers) and reference cells B5 – B17. 

• In cell B24, calculate the number of 
students whose Student Average was 
greater than 80%. This should use a 
COUNTIF formula and reference cells E5 – 
E17. 

• In cell B25, calculate a count of students 
whose Course Points fell below 250. This 
should use a COUNTIF formula and 
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reference cells G5 – G17. 
• In cell B26, calculate an average of student 

Course Points. This should use an 
AVERAGE formula and reference cells G5 – 
G17. 

• In cell B27, calculate the minimum 
percent received for Test 3. This should use 
a MIN formula and reference cells D5 – D17. 

• In cell B28, calculate the maximum 
percent received for Test 3. This should use 
a MAX formula and reference cells D5 – 
D17. 

• In cell B29, calculate the middle percent 
received for Test 3. This should use a 
MEDIAN formula and reference cells D5 – 
D17. 

• In cell B30, calculate the sum of the 
Student Costs. This should use a SUM 
formula and reference cells H5 – H17. 

• In cell B31, calculate the sum of the 
Student Cost for only students who passed 
with 220 points. This should use a SUMIF 
formula and reference cells G5 – G17 and 
cells H5 – H17. 

• SAVE your work and close the file. We’re 
finished! 
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MedAttrib: author-generated. MS Excel 
Statistical Functions table of test scores. 
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Chapter 16: 
Functions - 
Lookups / Logical 

What We’ll Cover >>> 

• VLOOKUP 
• HLOOKUP 
• XLOOKUP 
• IF / nested functions 

This chapter focuses mostly on lookup 
functions. We will also review a basic use of the 
IF function and a nested function. 

The LOOKUP function is a built-in function in 
Excel that is categorized as a reference 
function. It can be used when you need to fill 
in some data in a dataset that is referenced 
in another dataset – in the same worksheet, 
another worksheet or another workbook. It 
isn’t as simple as using the Click Cell method 
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to simply copy data from one place to another, 
because you might need to have to ask for the 
data to be found based on criteria in the 
existing dataset and where it is also referenced 
in another dataset. For example, you might you 
know the part number for a computer part in 
your dataset, and you need the price but your 
table doesn’t know it because it is listed in 
another table or dataset. 

VLOOKUP 

You need to use a VLOOKUP function to look 
up information in a table so that you can use 
that information in another table that needs it. 
It stands for Vertical Lookup, because the data 
is being looked up in reference to the columns 
of a table, not the rows. Is the information in a 
table’s column (default is yes, since most tables 
have their header rows for columns). If so, then 
you use a VLOOKUP. 

There are four pieces of information 
(arguments) that you will need in order to build 
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the VLOOKUP formula. These are the four 
arguments of a VLOOKUP function: 

• The Lookup_value, which is the value you 
want to look up in the table you are 
inputting your formula into. This would be 
what your calculation cell needs from its 
own table to look up in another dataset for 
the answer. 

• The Table_array is the range (table) where 
the lookup values and the values you want 
returned by the function are located. 

• The Col_index_num, which is the column 
number in the data range that contains 
the value (information you need) to return 
to your calculation cell. 

• The Range_lookup, which is your request 
for an exact match (false) or approximate 
match (true). It is best to use false so that 
your Lookup formula is exact. 

TIP: LOOKUP Columns = 2. VLOOKUPs 
are tricky if you try to use them for 
anything other than looking in two 
columns of a table. They are linear in 
processing, so you need to use them for 
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only 2 columns – the left column with 
the value that matches your 
Lookup_value, and the right column 
with the resulting data you want to be 
pulled over to your calculation cell. 
What if a lookup table has more than 2 
columns? Easy! Just make a named 
data range of only the two columns you 
need to look in. 

ACTION: Try Me activity 

We will work with a combination activities 
workbook, named Ch16-Lookups.xlsx. Before 
you start working, go to your DataFiles folder 
and make a copy of the file for your Examples 
folder, then open that copy. 

Our goal for our work has 3 parts, all of which 
are illustrated later in the chapter. 

The workbook has two sheets; the first is 
named Lookups, and we can practice some of 
these functions with simple examples. The 
second is a static information sheet with some 
common lookup and logical functions you can 
use for your reference. 
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Go to the Lookups worksheet. On it is a table, 
called Movies, from cells A5-I19 with row 5 
being the header row. Look at the empty cell 
D6. This cell needs to tell us what the Genre 
of the movie shown in cell B6 is. All we have 
is a Genre Code, though, and the actual Genre 
name is listed in another small table called 
Genre (Cells K6-L11) on the same sheet. How do 
we get that information into cell D6? 

Here is what needs to happen. We need to tell 
cell D6 to look at cell C6 for the Genre Code. 
We then need to tell cell D6 to look that same 
Genre Code up in the Genre table of cells K6-L11, 
and tell us what the Genre Code in the K 
column represents from the L column. 
What???? 

D6 should look at C6, then look over at K 
column for whatever genre code matches and 
what its associated L column genre name is. 
Ummmm. . . okay. 

Let’s try this: 
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VLOOKUP syntax: 

• Calculation cell with the VLOOKUP 
formula = D6 

• Lookup_value = C6 
• Table_array = K6 – L11 (a 2-column data 

range) 
• Col_index_num = 2  (which is the L column 

in a range of cells K6-L11) 
• Range_lookup = FALSE (which means an 

exact match) 
• Result = Adventure 

So, here we go: 

• Click Cell D6. 
• Type 

=VLOOKUP([@GenreCode],Genre,2,FALSE
) 

Genre refers to the name of the 2-column table 
that makes up the 2-column dataset we 
needed to look in. 

• Assuming your VLOOKUP worked and 
gave you Adventure in cell D6, IF Excel 
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does not auto-populate D7-D19 with the 
formula, then copy the formula of D6 
down through cells D7-D19. 

• SAVE your work. 

Let’s try another. 

Click Cell F6. We want this cell to show the 
quality of the movie product. To do this, we 
will need to figure out where this information 
is. The 2-column Quality table lists the Quality 
codes and their respective quality label (fair, 
good, new). 

Let’s use the function builder. 

• In cell F6, click the FX symbol to the left of 
the Formula bar. 

When the Function Arguments dialog box 
opens, do the following: 

• In the Lookup_Value field, type in cell E6. 
Because this is in a named table, Excel 
usually interprets it as [@QualityCode] 
However, if Excel only reads it as E6 in the 
formula, that will also be fine. 
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• In the Table_Array, type Quality. OR, if you 
choose instead to select the cell range of 
N6 – O9, make sure to make the reference 
ABSOLUTE in the function builder. 

• In the Col_Index_Num, type 2, which is 
column 2 of the Quality Table_array we are 
looking in. 

• In the Range_Lookup, type FALSE 
• Click OK. 

MedAttrib: author-generated. MS Excel 
VLOOKUP using Function Arguments dialog. 

• Then, assuming you got a correct response 
in cell F6 (Fair), copy the formula of F6 
down through cells F7-F19 if Excel does 
not auto-populate cells F7-F19 for you. 
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Click Cell H6. We want this cell to show the 
medium that the film is being sold on. To do 
this, you need to figure out where this 
information is. The 2-column Media table lists 
the Media codes and their respective medium 
(DVD, VHS, Blu-ray). 

• You know what to do. Craft a VLOOKUP 
formula for H6. You can do it by hand or 
use the Function Arguments builder and 
model your formula after what you see for 
the F column. 

• Once you complete the formula 
accurately, copy the formula of cell H6 
down through cells H7-H19 if Excel does 
not auto-populate those cells for you. 

• SAVE your work. 

MedAttrib: author-generated. MS Excel 
VLOOKUPs activity. 
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Errors 

Note: What if a VLOOKUP doesn’t work? What 
if we get a result different from the one 
predicted? In this case, we may have: 

• Made a slight mistake entering the 
VLOOKUP function 

• Tried to look in some other column instead 
of the second one in our data range 

• Might not have named a data range at all 
if our data was in a Table_array that has 
more than 2 columns. 

• The Lookup_value might not be in the 
Table_array 

To make repairs in the function, click in the 
formula cell to activate it. In the Formula bar, 
press the Insert Function button. That will 
reopen the dialog box so you can make your 
repairs. Did you forget to make the cell 
references for the Table_array absolute (like a 
named data range or the $N$6:$O$9)? Did you 
use the wrong cell for the Lookup_value? Then, 
press OK when you are done reviewing the 
Function dialog box and recopy the corrected 
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function down through the rest of the cells in 
the column. 

HLOOKUP 

You might need to use a lookup function to 
look up information in a table made up of rows 
(not columns) so that you can use that 
information in another table that needs it. 
HLOOKUP stands for Horizontal Lookup, 
because the data is being looked up in 
reference to the rows of a table, not the 
columns. Is the information in a table’s row. If 
so, then you use an HLOOKUP. 
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TIP: It is very important to specify a 
named range for the two rows you plan 
to look up your Lookup_Value in. AND, 
the named range contents – specifically 
the row headers, need to be EXACTLY 
like the columns headers of any table/
range of cells you are using the Hlookup 
formula in. HLOOKUPS can be a little 
sensitive without being clear as to why. 

In this example, we are working with a table 
called Students of cells A24 – C29. We want to 
populate the Notes column with notes listed 
in the range of cells E24 – H25, which already 
has a Named Rage name of Comments. Our 
common information point between the two 
data ranges is the number of points a student 
received in the Students table, and the points 
that a specific note falls under in the 
Comments range. 

HLOOKUP syntax: 

• Calculation cell with the HLOOKUP 
formula = C25 
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• Lookup_value = B25 
• Table_array = E24 – H25 (named 

Comments in the Formulas ribbon’s Name 
manager) 

• Row_index_num = 2 
• Range_lookup = FALSE 
• Result = On Target 

So, here we go: 

• FIRST, click on cell E24, and change the 
word Score to the word Points. 

• Click cell C25 
• Type =HLOOKUP([@Points],Comments,2) 

Do not add ,false or ,true after the 2. 

Comments refers to the name of the 2-row 
table that makes up the 2-row dataset we 
needed to look in. 

• Copy the formula of cell C25 down through 
cells C26-C29, assuming your HLOOKUP 
worked and gave you On Target in cell 
C25. 

• HOT TIP: If for some reason your HLookup 
is not working correctly, CHANGE the word 
Score in Cell E24 to the word Notes. 
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• SAVE your work. 

MedAttrib: author-generated. MS Excel 
HLOOKUP activity. 

XLOOKUP 

XLOOKUP is a fairly new lookup function in 
Excel, starting in 2021’s version/updates to MS 
Excel 365. Because of this, it is not backwards 
compatible with earlier versions of Excel. Many 
students and workers find themselves in 
workplaces that haven’t fully upgraded to 
current Office 365, and/or may be using other 
financial workbook tools from free and open-
source providers. 

XLOOKUP is able to search for data both 
horizontally and vertically while VLOOKUP 
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searches only vertically and HLOOKUP 
searches only horizontally. It searches a range 
or an array, and then returns the item 
corresponding to the first match it finds. It can 
be considered a more elegant function, with 
only 3 arguments needed in most cases 
because the default match mode is 0 (exact 
match). However, it can be less intuitive to learn 
because it can have additional logical 
arguments which make the formula seem less 
than intuitive for new learners. 

At this time, XLOOKUP is not being covered 
in this textbook, primarily because it is not 
backwards compatible. This may change as the 
function becomes more routinely used, and 
easier to interpret. 

IF and Nested functions 

IF Function 

The IF function allows you to make a logical 
comparison between a value and what you 
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expect by testing for a condition and returning 
a result of True or False. These decision results 
can be used to provide information, do 
different / additional calculations, and/or do 
further tests. 

The IF function is one of the most popular 
functions in Excel. It allows you to make logical 
comparisons between a value and what you 
expect. In its simplest form, the IF function says 
something like: 

IF the value in a cell is what you expect (true) 
– do this. If not (else) – do that. The IF function 
has three arguments: 

• Logical test – Here, we can test to see if 
the value in a selected cell is what we 
expect. You could use something like 
“B7=14” or “B7>12” or “B7<6” 

• Value_if_true – If the requirements in the 
logical test are met – like if B7 is equal to 14 
– then it is said to be true. For this 
argument, you can type text – “True”, or 
another message like “On budget!” Or you 
could insert a calculation, like B7*2 (If B7 
does equal 14, multiply it by 2). Or, if you 
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want Excel to put nothing at all in the cell, 
type “” (two quotes). 

• Value_if_false – If the requirements in the 
logical test are not met – if B7 does not 
equal 14 – then it is said to be false. You can 
enter the same instructions here as you 
did above. Let’s say that you type the 
double quotes here. Then, if B7 does not 
equal 14, nothing will be displayed in this 
cell. 

Nested Functions 

Nested functions are when a function needs to 
accomplish more than one thing, and needs 
the help or one or more functions added inside 
of its code. They allow you to test more than 
one thing in the same calculation, 

For instance, a nested IF function is an IF 
function within another IF function. It might 
refer to something like: 

• IF this, then that, else look this up, and IF 
this, then that, and. . . 
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You get the point. It is a calculation that 
behaves like a flowchart of choices and results. 

In Ch16-Lookups.xlsx, we’ll continue working 
with the Lookups worksheet. We’ll do a simple 
IF function, and also a little more complex but 
fun nested IF function. 

Cells A35 through E48 make up a table called 
Gens, including a header row. We need to do 
the formulas for column C to determine if the 
person in the record is an elder, and when we 
do the formulas for column E to determine if 
the person in the record is a GenX or Millennial, 
or in some other generation. 

Click cell C36. We need to determine if Joah, 
who is age 26, is an elder. If his age meets 
certain conditions, then yes, Joah is an elder. If 
his age does not meet certain conditions, then 
no, Joah is not an elder. 

Let’s use the function builder. 

• In cell C36, click the FX symbol to the left 
of the Formula bar. 
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When the Function Arguments dialog box 
opens, do the following: 

• In the Logical_Test field, type in B36 >64 
• In the Value_if_true, type Yes 
• In the Value_if_false, type No 
• Click OK. 

MedAttrib: author-generated. MS Excel IF 
activity in Function Arguments dialog. 

This asks if the value of cell B36 (age 26) is 
greater than the age of 64. It is not greater, so 
cell C36 should return No. 

• Copy the formula of cell C36 down into 
cells C37 – C48. (If Excel does not auto-
populate the column for you.) 

• SAVE your work. 
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Now, let’s find out what generation Joah is. Is 
he a GenXer? A Millennial? Or in some other 
generation? THIS is going to take sone doing, 
so hold on to yourself. . . 

Basically, we have to ask: 

If Joah’s birth year falls in a certain yearly range, 
he is GenX. If it does not fall into that range, 
then does his birth year fall into another yearly 
range? If yes, he is Millennial. If his birth year 
does not fall into that range, then he is some 
other generation. 

This calculation takes some time to figure out, 
because it nests functions inside each other to 
ask and answer those things all in one cell. Plus, 
we have to look at Joah’s birth year in a range of 
dates, not just as one simple choice. This means 
we have to nest in AND functions, which has 2 
arguments and Returns TRUE only if both of its 
arguments are TRUE. 

• In cell E36, type 
=IF(AND(D36>1965,D36<1980),”GenX”,IF(A
ND(D36>1981,D36<1996),”Millennial”,”othe
r generation”)) 
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If Joah’s birth year in D36 is between 1965 and 
1980, he is GenX, otherwise if his birth year in 
D36 is between 1981 and 1996, he is Millennial, 
otherwise he is other generation. 

• Assuming that the function is satisfied 
that Joah is other generation (birth year 
1997), we’re good. 

• If Excel does not auto-populate the 
column for you, copy the formula in E36 
down through cells E37 – E48. 

• SAVE your work, and close the file. We’re 
done! 
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MedAttrib: author-generated. MS Excel IF and 
nested activities. 
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Chapter 17: 
Functions - 
Financial 

What We’ll Cover >>> 

• Fundamentals of Loans 
• PMT Function 
• PPMT Function 

In this chapter, we’ll work through a couple of 
basic financial functions in order to determine 
the payments and other conditions on a loan. 
Excel has a lot of financial functions, most of 
which are specialized to accounting and for 
loans, annuities, stocks, and other high-value 
skill areas. The loan-related functions are 
perhaps the simplest to use on a personal and 
general workplace support environment. 
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Fundamentals of Loans 

A loan is a contractual agreement in which 
money is borrowed from a lender and paid 
back over a specific period of time. The amount 
of money that is borrowed from the lender is 
called the principal of the loan. The borrower is 
usually required to pay the principal of the loan 
plus interest. When you borrow money to buy 
a house, the loan is referred to as a mortgage. 
This is because the property being purchased 
also serves as collateral to ensure payment. In 
other words, the bank can take possession of 
your house if you fail to make loan payments. 

MedAttrib: author-generated. Table of loan 
terms. 

A lender is required by law to provide borrowers 
with an amortization table when a loan 
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contract is offered. Each time a payment is 
made on the loan, you are paying the bank 
an interest fee plus some of the loan principal. 
Each year the amount of interest paid to the 
bank decreases and the amount of money 
used to pay off the principal increases. This is 
because the bank is charging you interest on 
the amount of principal that has not been paid. 
As you pay off the principal, the interest rate is 
applied to a lower number, which reduces your 
interest charges. 

PMT Function 

The PMT function refers to payment. In Excel, 
loan payments are calculated through the PMT 
(payment) function. This function is more 
complex than the statistical functions covered 
in Section 2.2 “Statistical Functions”. With 
statistical functions, you are required to add 
only a range of cells or selected cells within 
the parentheses of the function, also known 
as the argument. With the PMT function, you 
must accurately define a series of arguments 
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in order for the function to produce a reliable 
output. 

Table 2.6 Arguments for the PMT Function 

MedAttrib: author-generated. Table of PMT 
function arguments. 

NOTE: by default, the result of the PMT function 
in Excel is shown as a negative number. This 
is because it represents an outgoing payment 
– something owed. To do this, you can place a 
negative sign between the equal sign and the 
function name PMT. Excel has other formats 
for negative numbers, like the number within 
parentheses, and/or the number shown in red. 

When working with more complex functions 
such as the PMT, it is easiest to use the 
Function Dialog box. Use cell references for the 
arguments of the PMT function whenever 
possible. This will allow you the flexibility to 
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change aspects of the loan and have the 
payment automatically recalculate. 

ACTION: Try Me activity 

We will work with a combination activities 
workbook, named Ch17-Finance.xlsx. Before 
you start working, go to your DataFiles folder 
and make a copy of the file for your Examples 
folder, then open that copy. Here is what we are 
aiming for. The red numbers in parentheses are 
one of Excel’s formats for negative (or in this 
case, owed) numbers. 

414  |  Chapter 17: Functions - Financial



MedAttrib: author-generated. MS Excel loan 
activity. 

The workbook has two sheets. The first is 
named LoanRepay, with a building loan, and 
a car loan. The second is an information sheet 
with a table of common financial functions you 
can use for your reference. 

In the LoanRepay sheet, Taste du Monde has 

Chapter 17: Functions - Financial  |  415



a loan for a shipping warehouse project, and a 
loan for a delivery vehicle. 

The areas to be calculated are cells that have a 
background color: 

• Light tan for the Warehouse loan in 
column C. 

• Light green for the Vehicle loan in column 
D. 

Let’s work on the warehouse loan first; it is the 
left-hand loan in the worksheet, ranging from 
cells C6 through C16. 

The loan is for $2,250,000. It is for an expected 
18 years (amortization). The interest it was 
taken for is 7.79%. 

Our job is to determine the: 

• Monthly loan payment 
• Amount of loan principal the monthly 

payment is applied to at the beginning of 
the loan repayment (first month) 

• Amount of loan principal the monthly 
payment is applied to at the end of the 
loan repayment (last month of 18 years) 
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• Total cost of the loan. 

TIP: Comparable Arguments for PMT 
Function. When using functions such as 
PMT, make sure the arguments are 
defined in comparable terms. For 
example, if you are calculating the 
monthly payments of a loan, make sure 
both the Rate and Nper argument are 
expressed in terms of months. The 
function will produce an erroneous 
result if one argument is expressed in 
years while the other is expressed in 
months. 

In calculating this data, we will have to 
calculate a few other things in order for the 
actual loan payment information to be able to 
be calculated correctly. This includes the: 

• Monthly percentage rate of the annual 
interest rate (Monthly Interest) 

• The number of months in the amortization 
period of 18 years (Nper) 

This feels like a story problem. Ugh. Sorry. 
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Click on Cell C6. This is a simple calculation that 
doesn’t need the Function Arguments dialog, 
just a basic formula. This will give us the 
monthly interest rate from the annual one. 

• In cell C6, type =C5/12 
• AFTER you do this, change the data format 

of Cell C6 to Percentage using the Home 
Ribbon Number Group dropdown and 
choosing Percentage, then 2 decimal 
points. 

Click on cell C8. This is also a simple calculation 
that doesn’t need the Function Arguments 
dialog. This will give us the number of months 
occurring in 18 years. 

• In cell C8, type =C7*12 

Now we have components to work on our PMT 
function. The cell F9 already provides the Pv 
(principle to be borrowed). 

• Click on Cell C11 (for Monthly Loan 
Payment), and use the FX symbol to the 
left of the formula bar to open the Insert
Function dialog box. 
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• In the search, type PMT and click GO. 
• Select PMT and click OK. 
• In the Function Arguments dialog box, 

add: 
• Rate = cell C6 
• Nper = cell C8 
• Pv = Cell C9 
• Ignore the Fv and the Type fields, since 

they are optional (you can tell because 
they are formatted in lighter gray). 

• Click OK. 

MedAttrib: author-generated. MS Excel 
Function Arguments dialog for PMT. 

A number will populate Cell C11; it should be 
$19,401.86. This cell has already been formatted 
to show the number as a negative (a cost in 
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repaying the loan, not revenue from a salary or 
bonus). This particular negative number format 
comes out as the number appearing in 
parentheses, and in red. 

This is the monthly payment (PMT) for the loan 
under the terms of the interest and the 18 year 
repayment plan. 

• SAVE your work. 

PPMT Function 

The PPMT function gives you the payment on 
the principal loan amount (Pv) for a given 
period, for an investment based on periodic 
constant payments and a constant interest 
rate. The principal amount will change over 
time, since the longer a loan is paid, the more 
of it will go to the principal and less to the 
interest. 

In this activity, we’ll look at the payment on 
principal for the first month, then for the last 
month, of the 18-year loan period. 
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Click on cell C13. This is the very first month 
the loan will be paid, and most of the payment 
will apply to the interest. Our question is how 
much will be applied to the actual loan itself 
(the principal – Pv – of the $2,250,000)? 

• Click on cell C13, and use the FX symbol to 
the left of the formula bar to open the 
Insert Function dialog box. 

• In the search, type PPMT and click GO. 
• Select PPMT and click OK. 
• In the Function Arguments dialog box, 

add: 
• Rate = cell C6 
• Per = 1 
• Nper = cell C8 
• Pv = cell C9 
• Ignore the Fv field, since it is optional. 
• Click OK. 

A number will populate cell C13; it should be 
($4,795.61) in red. This is how much of the 
monthly loan payment $19,401.86 (the Nper) in 
Month 1 (the Per) will be applied to the 
$2,250,000 (the Pv) loan amount; the rest will 
go to what is left of the interest. 
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MedAttrib: author-generated. MS Excel 
Function Arguments dialog for PPMT. 

Now, let’s look at the same thing for the final 
month of the loan (month 216 from cell C8). 

• Click on cell C14, and use the FX symbol to 
the left of the formula bar to open the 
Insert Function dialog box. 

• In the search results select PPMT and click 
OK. 

• In the Function Arguments dialog box, 
add: 

• Rate = cell C6 
• Per = 216 
• Nper = cell C8 
• Pv = Cell C9 
• Ignore the Fv field, since it is optional. 
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• Click OK. 

A number will populate cell C11; it should be 
($19,276.72) in red. This is how much of the 
$19,401.86 (the Nper) in the final Month 216 (the 
Per) will be applied to the $2,250,000 (the Pv) 
loan amount. Most of it! 

Now, let’s figure out how 18 years of paying the 
monthly loan will actually cost. We don’t need 
the Function Argument dialog for this; we are 
calculating the monthly loan payment by 
amortization years (18 years) 

• Click on cell C16, and type =C11*C8 

This is the monthly loan payment of $19,401.86 
over 216 months (the nPer), and the total 
comes to a whopping ($4,190,801.39) in red. 

• SAVE your work. 

More Practice 

Let’s find out if we get better terms and results 
for the delivery vehicle. It is the right-hand loan 
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in the worksheet, ranging from Cells D6 
through D16. 

The loan is for $22,000. It is for an expected 4 
years (amortization). The interest it was taken 
for is 5.20%. 

• In cell D6, type =D5/12, then format the 
answer as Percentage with 2 decimal 
points) 

• In cell D8 type =D7*12 
• In cell D11, the formula – after using the 

Function Argument dialog – should come 
out as =PMT(D6,D8,D9) 

• In cell D13, the formula, after using the 
Function Argument dialog, should come 
out as =PPMT(D6,1,D8,D9) 

• In cell D14, you can practice calculating it 
based on what you learned from 
calculating cell C14 for the Warehouse 
loan. 

• In cell D16, you can practice calculating it 
based on what you learned from 
calculating cell C16 for the Warehouse 
loan. 

• SAVE your work. We’re finished! 
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Part 5: 
Summarizing 
Data 

In a way, Excel is a tool for summarizing data 
from other sources, such as big data imported 
from external databases, or regular infusions 
of data entry from customers and paperwork. 
While Excel can be and is used to craft new 
spreadsheets, it is as much about compiling, 
interpreting, cleaning, and preparing data for 
analysis, which is a form of some summarizing. 
However, It isn’t surprising that this data 
management program also needs to be able 
to crunch data further – to summarize it in 
different was so that data can be reviewed, 
tightened, and examined for trends and 
connections. This includes using Pivot tables 
and summary tables. 
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Chapter 18: Pivot 
Tables 

What We’ll Cover >>> 

• Pivot Tables Concepts 
• Creating Pivot Tables 
• Formatting Pivot Tables 
• Pivot Charts 
• Pivot a Pivot Table 
• Slicers for Pivot Tables 
• More about Pivot Charts 

Pivot Tables Concepts 

A way to analyze table information is with Pivot 
tables. A Pivot table is a powerful tool that 
calculates, summarizes, and analyzes table 
data to compare, patterns, and trends. It is not 
the same as a simple dataset or a basic Excel 
Table Object (basic table) like we have been 
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using for general capture and organizing of 
data. Pivot tables are inserted directly from the 
contents in a dataset/basic table, linking to the 
table object’s data but using a summary table 
format while the original dataset/basic table 
remains unchanged. 

Generally speaking, when you pivot on the 
original dataset/basic table data (or a simple 
dataset) you are reorganizing the pivot table 
information to reveal different levels of detail. 
This allows you to analyze specific subgroups of 
information and summarize data quickly and 
easily without having to change the structure 
or layout of the original dataset/basic table. 

When you pull data into a Pivot table there are 
four main area fields: Rows, Columns, Values, 
and Filters. The Rows/Legends and Columns/
Axis fields can interchange quickly to 
summarize the data in different ways or to run 
new reports based on the question or criteria 
being asked. 

ODDITY NOTE: In the quarter between when 
this book was written and then had more 
editing done, the PivotTable Fields panel’s 
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drag and drop fields seems to have changed. 
They used to read Rows, and Columns, (and in 
some files they still DO!) In other files they now 
read Axis (Categories) and Legend (Series). 
The author is not currently able to determine 
why this is happening and why it is not 
consistent. Terefore, the book will refer to 
Columns/Axis (Categories) and Rows/
Legend (Series) to capture both. It seems that 
One also used to be able to create a blank 
Pivot table with no existing data (yet), then 
assign the data cell range, but now Excel 
requires the input of specific dataset/table 
cells in advance. It is useful to note this 
because Microsoft/the Excel program makes 
occasional changes to the UI and tools’ layouts 
due to being an online Software as a Service 
(SaaS).. 

The Value field is data from the table that can 
be calculated (like money amounts), or that 
contain values that the Pivot table will be able 
to summarize. The Values field has multiple 
settings to choose how you want to calculate 
the data: SUM, COUNT, AVERAGE, MIN, MAX. 
This field can even show the displayed values 
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as a percentage of the total, column total, 
grand total, and so on. 

Lastly, in the Filters area, which restricts the 
Pivot table to only show the values matching 
specified criteria. 

Four Primary Pivot table Areas: 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel – Four Primary Pivot table Areas. 

The point of a Pivot table is not to create new 
data, but to have a streamlined tool to filter 
and sort a summary of a larger dataset or basic 
table’s information in different ways for 
different chart and analysis focus. 
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Creating Pivot Tables 

ACTION: Try Me activity 

Let’s now work with an Excel file: 
Ch18–Pivots.xlsx. This is a dataset from Taste 
du Monde of products and their prices. 

Example images of this activity appear in more 
than one part within this chapter. 

Save a copy of Ch18–Pivots.xlsx to your 
Examples folder, then, open the copy file for 
work. There is one worksheet with a dataset 
in it. The dataset has not been converted to 
an Excel Table Object (basic table) and does 
not need to be for this task. The theme, color 
palette have already been set. 

• Click the Sales sheet. Click anywhere in 
the dataset area. To create a Pivot table, 
the dataset  needs to be active first, since 
this data is pulled into the Pivot table for 
summarizing options. 

• From the Insert tab, choose Pivot table. In 
the dialog box that opens, you can see that 
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Excel already selected the dataset area of 
cells. 

• From the Create Pivot table dialogue box, 
make sure the Pivot table report will be 
placed in a New Worksheet, and click OK. 

MedAttrib: author-generated. MS Excel Create 
Pivot Table dialogue box. 

• Notice a new sheet (Sheet1) is inserted 
before the existing Sales sheet. It contains 
the Pivot table1 area and fields dialogue 
box. Rename the default name (Sheet 1) to 
RegionSales. 

• Move the RegionSales sheet to follow the 
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Sales sheet. 
• Note which cell is the top left cell of the 

inserted Pivot table in your file. In my Excel 
experience/example it was cell A3. If yours 
is A2 or A4 or another A cell, then note and 
work with that basis when following the 
instructions below for the cell references 
for the example, and adjust for that. Or, 
you can remove/add rows to your 
workbook so that your RegionSales sheet’s 
Pivot table “starts” at cell A3.  Dealer’s 
choice! 
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MedAttrib: Beginning to Intermediate Excel. 
Empty MS Excel Pivot Table Field pane. 

When you first create a Pivot table to work on, 
Excel’s default is to also open a PivotTable 
Fields panel. This is an interface you can use 
for moving data around so that the Pivot table 
itself updates with rows and columns of 
information. This panel can have more than 
one layout – this chapter will demonstrate the 
side-by-side layout. 
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TIP: PivotTable Fields panel. The panel 
will appear and disappear from view 
when you click outside the active Pivot 
table. If you actually close the panel 
while working IN the Pivot table and 
then need the panel back, clicking in 
the pivot table will not automatically 
return it. You can get it back from the 
contextual PivotTable Analyze tab, the 
Show icon at the left, and choose Field 
List from the dropdown list. ALSO, the 
PivotTable Fields panel may show items 
vertically like in the example image 
above, or in a side-by-side format 
instead; both are effective. 

• From the PivotTable Fields pane, drag and 
drop the Region heading to the Rows/
Legend (Series) section of pane’s Pivot 
table fields area. This would be the Rows. 

• From the PivotTable Fields pane, drag and 
drop the Category heading to the 
Columns/Axis (Categories) field section. 
Notice the categories display. This would 
be the Columns. 

• From the PivotTable Fields pane, drag and 
drop the Sales heading to the Values
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section. There, it will read as Sum of Sales 
(the default). 

• SAVE your work. 

MedAttrib: author-generated. MS Excel Pivot 
table result and Fields panel. 

What are we observing? (See ODDITY NOTE 
above) 

• The Rows/Legend (Series)are the row 
headings, for the regions. 

• The Columns/Axis (Categories) are the 
column headings for the categories of the 
products sold 

• The data in the cells is a summarization of 

Chapter 18: Pivot Tables  |  435



the sums of what was sold. 
• A default Grand Total column shows the 

totals of each row. 
• A default Grand Total row shows the totals 

of each column. 

This table can be filtered to show specific 
categories, or specific regions. And, using the 
PivotTable Fields panel, it can “pivot” to other 
areas of focus for different row and column 
headings to summarize and analyze different 
data. THAT is what pivot means in Pivot table. 

Let’s Pivot Filter the table’s data a bit, just 
temporarily. 

• Click the Filter button in cell A4, and in the 
dropdown, deselect everything. 

• Then select only the items in the list with 
West in them, and click OK. The Pivot table 
will filter the other regions out. 

• Click the Filter button in cell A4, and in the 
dropdown, Select all., so that the table 
goes back the way it was. 
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Formatting Pivot Tables 

After creating a Pivot table and adding the 
fields that you want to analyze, you will need to 
do some clean-up for the table to make sense. 
Sometimes the row or category headers don’t 
really state what you need, or the filter options 
in the pivot table’s subhead row seem 
confusing. You will likely need to also use some 
kind of data formatting for the content, since 
the pivot table info grabs the information, but 
not the numeric data formatting from the 
original dataset/basic table. You may also want 
to enhance the report to include slicers, or 
graphs for easier filtering. 

• Click in the Pivot table area to activate it, to 
get access to a contextual Ribbon tab on 
the ribbon. This will contain a PivotTable 
Analyze tab and related Design tab. 

The Analyze tab contains tools specifically for 
examining data. For example, it has the 
location for re-opening the PivotTables Fields 
panel, and the commands to insert Slicers, or 
illustrative Pivot charts. The Design tab 
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contains tools that specifically tie to how the 
table (and charts) and data visibly display, sort 
of like the basic Table tab does for regular 
tables. For example, when you have a lot of 
data in your Pivot table, it may help to show 
banded rows or columns for easy scanning or 
to highlight important data to make it stand 
out. You will also need to add data formatting 
like currency, percentage, decimals, and other 
related types of data formatting to make it 
more readable. 

NOTE: Interestingly, neither Pivot table-
generated contextual ribbon/tab offers to 
option to change the Pivot table’s name. You 
can do this by clicking into the Pivot table to 
activate it, then right-clicking and selecting 
PivotTable Options from the dropdown list. 
That opens a PivotTable Options dialog window 
that has a space to change the Pivot table’s 
name and do all sorts of other things, like 
adding AltText (for screen readers to access), 
and showing or hiding Grand Totals for 
columns  and rows. 

Let’s clean up our Pivot table’s content. 
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• Right-click in the Pivot table, select the 
PivotTable Options from the dropdown 
list, and in the resulting PivotTable Options 
dialog window, change the table’s name to 
Category Sales by Region. 

◦ Click cell B3 and look at the Active 
Field contents in the PivotTable 
Analyze tab. It reads Category, while 
the Table’s cell reads Column Labels. 

• Overwrite cell B3 with the word Category. 
This will help make using the row’s filter to 
work with the data mean something. 

• Click cell A4, and do the same thing to 
observe the Active Field contents in the 
PivotTable Analyze tab. 

• Overtype cell A4 with Region. 
• Right-click on Cell B5, and choose Number 

Format, then Accounting. ALL the number 
cells in the Pivot table convert to 
Accounting format, but this can look busy. 
Ideally, only the first row and the total row 
should show the Accounting format. 

• Undo the last step with CTRL Z (Mac CMD 
Z). If you can’t, you can instead Right-click 
on Cell B5, and choose General Format. 

• Select Cells B5-F5, and apply the 

Chapter 18: Pivot Tables  |  439



Accounting format to only them using the 
Home ribbon Number group’s Accounting 
format. 

• Select Cells B6-F15 and apply the Number 
format if the data does not already appear 
in number format. 

• IF the format is not already at 2 decimal 
places, select Cells B6-B15, choose Home 
ribbon’s Number group, then apply the 
Increase Decimal by 2. 

• In cells B16-F16, apply the Accounting 
format to only them, with 2 decimal 
points. 
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TIP: Summarizing and giving data 
values. You can right-click on any data 
cell in a Pivot table, and see various 
ways to summarize the data and to 
show those values (not format, but 
other actual value types. These will 
make more sense as you work with data 
in your career and determine the needs 
and what you want your pivot tables to 
do. 

MedAttrib: author-generated. MS Excel Pivot 
table data format and value options. 

Now that our Pivot table is more readable, let’s 
format the Pivot table itself. Taste du Monde 
uses a dark teal, a light green, and a tan as 
some of the signature colors and this file has 
already been set with the Berlin Theme with 
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Aspect color palette. We want the table to be 
easy to read. 

• Click in the Pivot table, then go to the 
Pivot table’s Design tab. 

• In the pivot table Styles gallery select the 
Tan, Pivot Style Medium 21 format. 

• SAVE your work. 

Pivot Charts 

Next, let’s create a pivot chart from this pivot 
table. The process is very similar to what we will 
learn later for regular charts and graphs. 

• Click in the pivot table, then go the 
PivotTable Analyze tab. 

• Choose the PivotChart button on the 
ribbon. 

• From the listed chart types, choose 
Column and select the Clustered Column 
option. Click OK. 

• Drag the pivot chart to the right so that it 
is not overlapping the table. 

• To change the clustered style to another 
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variation, click the chart, then on the Pivot 
chart Design ribbon. HERE, choose 
Change Chart Type, and select Clustered 
3D Column. 

Notice that when you click in the Pivot chart, 
an additional 3rd Pivot table contextual tab 
appears to the right of the Design one, called 
Format. This allows you to do micro formatting 
on the Pivot chart elements, like you would 
with other graphics in Excel. 

Also, notice that (if you had the PivotTable 
Fields panel open) the PivotTable Fields panel 
now reads PivotCharts Fields. 
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MedAttrib: author-generated. MS Excel 3D 
Clustered Column pivot chart. 
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MedAttrib: author-generated. MS Excel 
RegionSales Pivot table and chart sheet. 

Now, let’s filter something in the Pivot table, 
and observe what might happen to the related 
chart. 

• Click cell B3’s Category filter button. From 
the dropdown, deselect Ingredients and 
Seasonings, then click OK. 

• The table now summarizes only Food and 
Cookery, and the related Pivot chart 
adjusts automatically to focus on those as 
well. 

• Click the Filter button in cell B3, and in the 
dropdown, Select all, so that the table 
goes back the way it was. 

• SAVE your work. 

Pivot a Pivot Table 

Let’s keep this table and chart as is, and make 
a copy of the worksheet so we can try some 
other things with the table while leaving this 
RegionSales worksheet one intact. 

Chapter 18: Pivot Tables  |  445



• Right-click the RegionSales worksheet tab, 
choose Move or Copy, then checkmark the 
Copy checkbox. 

• Keep the sheet in the same workbook and 
choose (move to end), then click OK. 

• Name the new sheet SalesRep Sales 
Counts. 

• Delete the pivot chart so that we only 
have the Pivot table. 

• If the PivotChart Field List is no longer 
open on your screen, go to the contextual 
PivotTable Analyze tab, Show icon at the 
left, and choose Field List to open it. 

• In the Field List, uncheck Region and 
choose SalesRep. 

• Keep the SalesReps in the Rows/Legend 
(Series) field. 

• Keep the Category in the Columns/Axis 
(Categories) field. 

• In the Values field, click the dropdown 
arrow, and choose Value Field Settings. 

• In the Value_Field Settings, choose Count, 
instead of Sum, and give it the name 
SalesCount in the Custom Name field. 
Click OK. 

446  |  Chapter 18: Pivot Tables



Now you can see the Pivot table has pivoted 
to give different information. The numbers are 
counts of the number of items sold, not the 
price that was paid. The counts are attributed 
to the Sales Reps responsible for the region the 
products were purchased from. 

There is a little problem, however. Consider cell 
A4, which reads Region. We had manually 
typed that in for the RegionSales worksheet’s 
Pivot table because the default phrase there 
was too general. However, in this worksheet’s 
newly pivoted table, that label no longer 
applies. 

Look in the PivotTable Analyze tab’s Active 
field, and notice that it reads SalesRep. 
Overtype SalesRep into cell A4. 

• Close the PivotChart Field List to make 
viewing room for the table. 

This time let’s see if we can make a Pie Chart. 

• Make sure you click into the Pivot table so 
it is active and shows the Pivot-related 
Ribbon tabs. 
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• Choose the PivotChart button on the 
PivotTable Analyze ribbon. 

• From the listed chart types, select the Pie 
Chart option. Click OK. 

• Click the newly created chart, and in the 
chart’s contextual Design tab, choose Style 
1 from the Chart Styles. 

• Drag the Pivot chart to the right so that it 
is not overlapping the table. 

• The Pie Chart looks nice, but it refers to 
only Cookery. A Pie Chart can really only 
view one 3D column at a time, but the 
pivot chart allows you to filter it with the 
small Category Button in its lower left 
corner. 

• Click the pivot chart’s category button 
dropdown, and deselect all. Then choose 
only Ingredients. The pivot chart will 
change. 

• SAVE your work. 
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TIP: Pivot filtering. To change the pivot 
chart’s focus, you can filter either the 
Pivot table or the pivot chart, since they 
are tied together. 

MedAttrib: author-generated. MS Excel 
SalesRep Sales pivot table and chart sheet. 

Slicers for Pivot Tables 

One of the strengths of pivot tables is that you 
can ask questions of the data by using filters. 
Being able to identify and examine subgroups 
is a useful analytical tool; however, when using 
basic table and chart filters and autofilters, the 
user cannot always tell which subgroups have 
the filters and autofilters selected without 
clicking tiny and not very informative filter 
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buttons. Slicers are easy-to-see buttons that 
you can add to your worksheet, and can click to 
filter the data in pivot tables and pivot charts 
to make the data easier to filter and interpret. 
With slicers, the subgroups are immediately 
identifiable and can be changed with a click of 
a button or buttons. 

Why use slicers rather than row, column, or 
report filters? One effective way to analyze data 
is to use slicers to filter the data in more than 
one field at a time. They offer the following 
advantages over filtering directly in a pivot 
table: 

• In a Pivot table, you use the filter button to 
specify how to filter the data, which 
involves a few steps. After you create a 
slicer, you can perform this same filtering 
task in one step. 

• You can filter only one pivot table at a 
time, whereas you can connect slicers to 
more than one pivot table to filter data 
(advanced) 

• Excel treats slicers as graphic objects, 
which means you can move, resize, and 
format them as you can any other graphic 
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object. As graphic objects, they invite 
interaction. 

• Slicers are intuitive—users without 
knowledge of Excel can use them to 
interact with the data without getting into 
the Pivot table, Pivot chart, or basic Excel 
table object. 

• Slicers make it easy for users to 
understand exactly what is shown in a 
filtered Pivot table or Pivot chart. 

Let’s add slicers to a Pivot table. We will do this 
with the SalesRep SalesCounts worksheet and 
related Pivot table; with no Pivot chart the 
single-minded Pie chart filtering doesn’t 
respond well to Slider filter selections. 

• Right-click the SalesRep SalesCounts 
worksheet tab, choose Move or Copy, then 
checkmark the Copy checkbox. 

• Keep the sheet in the same workbook and 
checkmark (move to end), then click OK. 

• Name the new sheet RepSales Slicers. 
• Delete the existing Pivot chart so that we 

only have the Pivot table. 
• If the PivotChart Field List is no longer 
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open on your screen, go to the contextual 
PivotTable Analyze tab, Show icon at the 
left, and choose Field List to open it. 

• Click on the Pivot table to Activate it, and 
in the PivotTable Fields panel, uncheck 
Region and choose SalesRep. 

• Keep the SalesReps in the Rows/Legend 
(Series) field. 

• In the Columns field make sure to select 
Category. 

• In the Values field, make sure to choose 
Sum, which makes sure that the balue of 
the table are for dollars. 

• Change the contents of cell A4 to read 
SalesRep. 

• Click on the Pivot table, and go to the 
PivotTable Analyze ribbon Filter group. 

• Click on the Filter group’s Insert Slicer
icon. 

• In the Insert Sliders panel, choose only 
SalesRep and Category, then click OK. 

• Two Slicer objects will appear near your 
pivot table, and will have all slicer buttons 
In them already selected. 

• You can move one or both of these Slicer 
objects so they are to the right of your 
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Pivot table, and easy to see. 
• In the SalesRep slicer, deselect everyone 

but Talia Bloom (you may have to scroll). 
• In the Category slicer, select only 

Ingredients and Seasonings. 
• The Pivot table contents will change to 

show only Talia Bloom’s counts for 
Ingredients and Seasonings. 

• In the SalesRep slicer, add Rafe Benally, 
and observe how the pivot table changes. 

• In the Grand Total row, make sure to 
format the values as Accounting. 

• SAVE your work. We are finished with this 
activity! 

MedAttrib: author-generated. MS Excel pivot 
slicers that have been filtered. 

If you decide to create a Pivot chart off of this 
Pivot table, 1) don’t select Pie chart, and 2) any 
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changes in the Slicers will affect both the Pivot 
table and its Pivot chart. 

More About Pivot Charts 

If you need to make a change to the underlying 
data for a Pivot chart, you can click the Change 
Data Source button (PivotChart Analyze ribbon 
Data group. You also can refresh Pivot chart 
data after the change by clicking the Refresh 
button on the same ribbon. 

As you have seen, Excel automatically creates 
a legend when you create a Pivot chart. The 
legend is from the fields in the Values area of 
the PivotChart Field panel. To move the legend 
in a Pivot chart, right-click the legend and then 
click Format Legend on the shortcut menu. 
The Format Legend pane will display options 
for placing the legend at various locations in 
the Pivot chart area. 

As with tables and pivot tables, you can filter 
the data in a Pivot chart. Slicers used to filter 
a Pivot table will affect the related Pivot chart 
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once you refresh the chart. Otherwise, any 
fields in the Columns/Axis (Categories) area of 
the PivotChart Field panel display as filter 
buttons in the lower-left corner of the Pivot 
chart area. 

To filter a pivot chart, click one of those buttons; 
the resulting menu will allow you to sort, 
search, and select. 
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Chapter 19: 
Summary Tables 

What We’ll Cover >>> 

• Summary Table Concepts 
• Subtotals Tables 
• Consolidated Pivot Tables 

Summary Table Concepts 

As you may be getting the idea, there is data 
out there. A lot of data. So much data that even 
a hitchhiker’s guide to data wouldn’t help 
much. However, no panicking is needed. Data 
is collected into many databases and input into 
many places. It can be analyzed and used in 
many ways, of which Excel is one. Excel can 
express it in tables with calculations, sorts, 
filters, and other techniques. Still, it’s data, and 
often a mindbogglingly lot of it. Excel needs 
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to be able to summarize data, and even 
summarize summarized data. Whew! 

Pivot tables demonstrated one key way to do 
so. Also, maybe a basic table of core data that 
doesn’t need the Pivot table steps but can be 
summarized within itself. Or, multiple core 
tables can be consolidated to be summarized. 
Or, Pivot tables/charts themselves (which are 
summarized data) might need to be 
summarized if one needs to review several of 
them for consistencies or trends. 

Subtotals Tables 

One way to summarize data is by using 
subtotals tables. Analyzing a large data range 
usually includes making calculations on the 
data itself, like totaling subtotals + tax amounts. 
You can summarize the data by applying 
summary functions such as COUNT, SUM, and 
AVERAGE to the entire organized range of 
information. Subtotals, in general, are 
summary functions applied to parts of an 
organized data range. 
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For example, in a Subtotal table you can SUM 
Current sales for sales reps from each region 
they sell to. To subtotal the information, the 
data must first be sorted by the Region field. 
For subtotals, the field that you sort is referred 
to as the control field. 

If you choose the Region location in a dataset 
as your control field, all of the region entries 
will be grouped together within the data range, 
like the East region, West region, North region, 
etc. A SUM function then can be applied to add 
up the current subtotals field for each region’s 
location. Excel calculates and displays the 
subtotal each time the region location 
changes. 

In a Subtotal table, a new row containing a 
subtotal of that particular location will be 
inserted, and wherever the field changes a 
value will display; a subtotal group of records. 
Excel updates this subtotal information 
automatically when the control field is 
changed. In theory, when subtotaling, you are 
adding a calculation row to the set of data. 

However, manually adding rows that total 
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information in the middle of an Excel Table 
Object  would compromise the integrity of 
data in the basic table – the table object tools 
would look at the total as a record, not a 
calculation. Therefore the Subtotal feature 
cannot be used in Excel Table Objects, but can 
only be applied to a normal range of data. This 
means that you must convert all Excel basic 
tables to a regular data range prior to using the 
subtotaling option. 

Multiple functions can be applied within the 
same Subtotal. Also, Subtotal data can  be 
filtered. 

The best practice when subtotaling is to follow 
four rules: 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Subtotal Rules. 

ACTION: Try Me activity 

Let’s now work with an Excel file: 
Ch19–Summary.xlsx. This is a dataset from 
Taste du Monde of products and their prices. 
Before starting work, save a copy of 
Ch19–Summary.xlsx to your Examples folder. 
Then, open that file for work. 

Because there are two tasks on different 
sheets, the images of our progress will appear 
through the chapter. 

There are 5 worksheets in Ch19–Summary.xlsx. 
The dataset in the Sales worksheet is a table 
object for easy sorting. Let’s find out how to 
create a subtotals table from it. Follow the 
below steps to Subtotal the sales reps and 
provide a total current sales per region. 

• Double-click the Sales worksheet name 
tab, and choose to make a copy of the 
sheet to follow the Sales worksheet. This is 
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so we don’t adjust the Sales worksheet’s 
main table’s data as we learn. 

• Rename the copy of the Sales worksheet 
as SalesSubtotals. 

• Select the SalesSubtotals worksheet and 
click anywhere in the table area. 

• From the Data tab, choose Sort button. 
Sort the Region by A to Z. 

• Select “Convert to Range.” Excel will 
display a message asking if you really want 
to convert the table back to a normal 
range. Choose Yes. 

TIP: Converted tables. Converted-to-text 
table heading rows no longer have filter 
buttons. The data looks like a table but 
is not an Excel table object any longer. 
The table tools are not active, and the 
information is a normal dataset. Also, 
any table name you assigned in the 
Table Design menu’s Table Name field 
will not translate. 

• Next, click the Data ribbon tab, in the 
Outline group, and  find & select the 
Subtotal icon. 
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• In the Subtotal dialogue box, choose the 
Region field in the “At each change in.” 
For the “Use Function,” choose Sum 
(which is the default setting), and check 
Sales from the Add Subtotal to list. Click 
OK. 

• SAVE your work. 
• Scroll down the worksheet, and observe 

that the Sales column is totaled, per 
region, Like East, Island, etc. 

Subtotal Outline View 

For the summary table to be at all useful – 
especially if the table is more than a page or 
two long, there has to be a way to manage 
what we are seeing. The summary table 
Outline views, located on the left side panel, 
show summary statistics. The Outline tool, with 
levels, allows you to control the expanse of 
detail displayed in the worksheet. 

Currently, the dataset defaults to showing 
everything. On the left side of the dataset, look 
for the minus signs in the lines of the ‘levels.’ 
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These behave as collapsing icons. If you click 
one, the level it represents will collapse out of 
sight. 

The SalesSubtotals worksheet has three levels 
in the Outline of its data range: 

• Level 1 displays only the grand totals. It is 
currently uncollapsed. 

• Level 2 displays the total spent at each 
region. It is currently uncollapsed. 

• Level 3 displays the total sales. It is 
currently uncollapsed. 

The image below shows the Level 3 Outline, 
all the sales reps detail per region, which by 
default is uncollapsed. Clicking the outline 
buttons located to the left of the row numbers 
lets you choose how much detail you want to 
see in the worksheet. (Note that the three level 
numbers are at the top left side of the 
worksheet, just below the Name box.) 
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MedAttrib: author-generated. MS Excel 
subtotals table. 

You will use the outline buttons to expand and 
collapse different sections of the data range. 

• Click level 1. Notice it displays the Grand 
Total. 

• Click level 2. Notice the totals for all store 
locations are displayed. 

Consolidated Pivot Tables 

Next let’s learn how to consolidate multiple 
tables of data so they can be viewed (and 
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charts created) from one summary table. We 
will be doing this with Pivot tables, not the 
main or the Biannual tables. Why? Because 
Pivot tables already do that consolidating of 
Excel basic tables or datasets. This is an 
additional method which allows you to 
consolidate multiple pivot tables. 

NOTE: The Excel built-in table wizard 
demonstrated below does not work for MACs. 
As a result, MAC users would need to combine 
“separate” original data tables into one longer 
data table on a new sheet, and create a single 
pivot table from that single table instead. 
Extra steps but possible. 

FOR PC USERS 

• In the Ch19–Summary.xlsx file, click on the 
worksheet Biannual1 and review it. This 
sheet contains all the same data as the 
main Sales worksheet’s basic table, but 
only for the first half of 2022. The 
Biannual2 sheet contains data from the 
second half of the year. 

In this activity’s case, for real life there isn’t 
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really enough data to require this kind of table 
separation, but consider if a lot more data is 
actually collected quarterly or monthly, then 
compiled into a full annual table, yet still needs 
some summarizing by quarter or biannual 
range. This is what Consolidated Pivot tables 
can help with. This chapter’s file already has 
the main table separated into two Biannual 
worksheets with an appropriate Excel basic 
table on each, then a Pivots worksheet in which 
Pivot tables have already been created from 
those two Biannual Excel basic tables. 

In Ch19–Summary.xlsx, go into the Pivots 
worksheet. The Pivot tables are currently sorted 
by the segment of the customers who make 
purchases (Business and Home), the categories 
of the products they chose (like Cookery), and 
the regions the different regions had 
purchases made from. Let’s consolidate this 
data into a single Consolidated Pivot table for 
expressing to a pie Pivot chart. 

• Go to the Consolidated worksheet. There 
are prep areas for two different summaries. 
We will focus on the first – creating a 
Consolidated Pivot table. Remember, 
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these will be MS Windows for PC steps 
only. 

• Click somewhere around cell A5. 
• Press your keyboard’s Alt key and D key at 

the same time, then release. Then press 
the P key. A PivotTable and PivotChart
Wizard will open the first of 3 steps. 

MedAttrib: author-generated. MS Excel 
consolidating tables Wizard. 

• The data we need for a Consolidated Pivot 
table will come from more than one 
existing Excel Pivot table, so select the 
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Multiple consolidation ranges. 
• Also, choose Table only, then click Next. 
• For step 2a, choose “I will create the page 

fields”, because you will be selecting 
where the data comes from. 

• Click Next. 

Step 2b requires us to tell Excel where the data 
we want to consolidate is coming from. It will 
be from each of the two Pivot tables in the 
Pivots worksheet. 

• First, while this step is open, enter the 
Pivots worksheet, then select all of the 
cells of data in the whole first Pivot table, 
NOT including any grand total. NO GRAND 
TOTAL, which if included would completely 
skew your Consolidated Pivot table’s 
amounts. Once you select the header row 
and data rows (minus the grand total row), 
the data range address will pop into the 
Wizard’s step 2b Range field. 

• Then press the Add button above the 
range. This will add the range into the 
window showing the existing range 
selections. 
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• Next, while still in this step, select all of the 
cells in the second Pivot table (minus the 
grand total row) in the Pivots worksheet. 
Once you select it, the data range will pop 
into the Wizard’s 3rd step Range field. 

• Then again press the Add button above 
the range. Now you should see two data 
ranges in the window. 

• Keep the “How many page fields do you 
want” at the default 0. 

You should now see two listed ranges of data. 

• Click Next to get step 3, which asks where 
you want the resulting Consolidated Pivot 
table. In the Existing worksheet field, type 
=$A$7. This will place your Consolidated 
Pivot table in the Consolidated worksheet’s 
cell A7. 

• Click Finish. 
• SAVE your work. 

 

PIVOT TABLE CLEANUP – Both PC and Mac 

A new pivot table has now opened in your 
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Consolidated sheet starting at cell A7. It doesn’t 
look very helpful. Let’s tidy it up, first by 
narrowing it to something we’d like to 
understand. Let’s say that we’d like to see the 
sales of only the Business and Home segments, 
but in percentage (not dollar) format. 

• In the Consolidated Pivot table, use the 
Row Labels filter to unselect everything, 
then choose only Business and Home. 

• In the PivotTable Fields panel, uncheck the 
Column. This will remove a column from 
the Consolidated Pivot table. 

• In the PivotTable Fields panel, click the 
arrow in the Sum of Value field. Choose 
Value Field Settings. 

• In the Value Field Settings dialog box, 
choose the Show Values As tab. 

• In that tab, click the dropdown menu, and 
select % of grand total, then click OK. 

470  |  Chapter 19: Summary Tables



MedAttrib: author-generated. MS Excel Value 
Field Settings panel. 

• In the resulting changed pivot table, select 
cells B8-B10, and format them with no 
decimal point. 

• In cell A7, overwrite the text with the word 
Segment. 

Now we have a basic Consolidated Pivot table, 
made from two Pivot tables that came from 
two biannual Excel basic tables derived from a 
bigger Excel base table. Oh. . . my . . . 
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FOR MAC USERS: 

because Mac users do not have access to the 
Wizard used above, they have to consolidate 
info differently. It is a little more cumbersome, 
but can yield the same results. However, this 
isn’t really a great option for massive tables, 
though PowerQuery and Power Pivot (more 
advanced) can do a lot more. For now (MACS 
ONLY): 

1. You will need to create a new sheet after 
the two Biannual sheets. Name it AllSales. 

2. Copy the full table from Biannual 1 and 
paste it in cell A4. 

3. In Cell A4, change January-June 2022 Sales 
to read All 2022 Sales. 

4. Copy the full table from Biannual2 and 
paste it into the AllSales sheet in the first A 
cell just below the end of the Biannual1 
table you already pasted in there. 

5. Go to the Biannual1 sheet, and copy Rows 
1-3, then paste them into the AllSales 
sheet’s Rows 1-3 to make the Taste du 
Monde/website link consistent on the 
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AllSales sheet. 

◦ At this point, the new AllSales sheet 
should have the combined data from 
the Biannual1 and Biannual2 tables 
copied into it plus the same Rows 1-3 
Taste du Monde title/icon/website link. 

6. NEXT, in the Consolidated worksheet, click 
in Cell A7, and create a pivot table based 
on the AllSales sheet’s All 2022 Sales table. 

7. Finally, scroll up this textbook page to this 
chapter’s PIVOT TABLE CLEANUP – Both 
PC and Mac instructions, and follow those 
to set up your new pivot table. 

 

CHART 

How about a slice of pie? Or, more accurately, a 
Pie Chart? 

• Click in the Consolidated Pivot table, and 
in the PivotTable Analyze ribbon, click the
PivotChart Icon. This is to create a chart 
from a Pivot tab 
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• Choose a Pie, 3D option and click OK. 
• Drag the new Pie chart so that it is to the 

right of the Consolidated Pivot table. 
• Right-click on the Pie chart, and in Add 

Data Labels, choose Add Data Callouts. 
• SAVE your work, and close the file. We’re 

done! 

MedAttrib: author-generated. MS Excel 
consolidated table and chart. 
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Part 6: Data With 
Charts/Graphs 

One of the most important things to consider 
when using charts in Excel is that they are 
intended to be used for communicating an 
idea to an audience. Your audience can be 
reading your charts in a written document or 
listening to you in a live presentation. 

In fact, Excel charts are often imported or 
pasted into Word documents or PowerPoint 
slides, which serve this very purpose of 
communicating ideas to an audience. The 
thing to keep in mind is that if a chart is 
confusing – if the data isn;t simplified and 
makes easy visual sense, the chart won’t 
communicate well at all, but be a space waster. 
Know what you need your audience to 
visualize, and what your data is capable of 
expressing properly, in choosing chart/graph 
formats. 

Although there are no rules set in stone for 
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using specific charts for certain data types, 
some chart types are designed to 
communicate certain messages better than 
others. Excel has a recommended Chart/Graph 
part of the process to help you visualize how 
the data you have to work with can appear. This 
section explores numerous charts that can be 
used for a variety of purposes. 
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Chapter 20: 
Chart/Graphs 

What We’ll Cover >>> 

• Charts/Graphs Concepts 
• Bar Charts 
• Line Charts 
• Pie Charts 
• Column Charts 
• Doughnut Charts 
• Sparklines 

This section reviews a few of the most 
commonly used Excel chart types. There are 
actually more, but they can be very specialized 
and require datasets beyond the basics/
intermediate level, for particular workflows and 
industries. To demonstrate the variety of chart 
types available in Excel here, it is necessary to 
use a variety of data sets. This is necessary not 
only to demonstrate the construction of charts 
but also to explain how to choose the right type 
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of chart given your data and the idea you 
intend to communicate. 

Charts/Graphs Concepts 

Before we begin, let’s review a few key points 
you need to consider before creating any chart 
in Excel. A chart or graph should exist to clearly 
demonstrate the analysis of some data in a way 
that makes sense to the audience, A chart isn’t 
meant to be a static graphic; it needs to 
communicate something that the viewers 
need while making a decision and considering 
actions to take. Is it showing a comparison, or a 
trend, or a problem in numbers, etc.? 

The concepts of chart and graph tend to be 
used interchangeably, but they have slight 
differences. 

Chart: Tables, diagrams or pictures that 
organize large amounts of data clearly and 
concisely, like in bars, pies, columns, etc. 

Graph: Graphs tend to focus on raw data and 
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show trends over time, such as with scatters, 
line charts, trendlines, etc. 

First, you need to determine which kind of 
chart to use. 

• The first key point is to identify your idea 
or message. It is important to keep in 
mind that the primary purpose of a chart 
is to present quantitative information to an 
audience in a visual way. Therefore, you 
must first decide what message or idea 
you wish to present. This is critical in 
helping you select specific data from a 
worksheet that will be used in a chart. 

• The second key point is to select the right 
chart type. The chart type you select will 
depend on the data you have and the 
message you intend to communicate. 
Some tables or pivot tables may not be 
better explained/visualized with a chart or 
graph. 

• The third key point is to identify the 
values that should appear on the X and Y 
axes. One of the ways to identify which 
values belong on the X and Y axes is to 
sketch the chart on paper first. If you can 
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visualize what your chart is supposed to 
look like, you will have an easier time 
selecting information correctly and using 
Excel to construct an effective chart that 
accurately communicates your message. 

Chart/Graph Tips 

• X-Axis on a chart: When using line charts 
in Excel, keep in mind that anything 
placed on the X-axis is considered a 
descriptive label, not a numeric value. This 
is an example of a category axis. This is 
important because there will never be a 
change in the spacing of any items placed 
on the X-axis of a line chart. If you need to 
create a chart using numeric data on the 
category axis, you will have to modify the 
chart. We will do that later in the chapter. 

• Y-Axis Scale: After creating an Excel chart, 
you may find it necessary to adjust the 
scale of the Y-axis. Excel automatically sets 
the maximum value for the Y-axis based 
on the data used to create the chart. The 
minimum value is usually set to zero. That 
is usually a good thing. However, 
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depending on the data you are using to 
create the chart, setting the minimum 
value to zero can substantially minimize 
the graphical presentation of a trend. 

• Carefully Select Data When Creating a 
Chart: Just because you have data in a 
worksheet does not mean it must all be 
placed onto a chart. When creating a 
chart, it is common for only specific data 
points to be used. You might need to 
create a named data range, or a pivot 
table, in order to narrow down the data to 
be charted. 
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MedAttrib: author-generated. MS Excel Chart 
planning. 

Types of graphs/charts 

• Area: Like a line chart but with the area 
below the line filled in. Highlights 
magnitude of change over time. 

• Bar: highlights individual figures at a 
specific time or indicates variations 
between components – but not in 
relationship to the whole. 

• Box & Whisker: Displays medians, 
quartiles, and extremes of a data set on a 
number line to show the distribution of 
data. Lines appearing vertically are called 
whiskers and show variability outside the 
upper and lower quartiles. 

• Column: Values are shown in vertical bars 
in a way that can compare items or show 
how values vary over time. 

• Combo: Combines two or more chart 
types to make data easier to comprehend. 

• Funnel: Displays values over multiple 
stages of a process; because the values 
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generally decrease, the shape of the chart 
resembles a funnel. 

• Histogram: Condenses a data series into a 
visual representation by grouping data 
points into ranges named bins. 

• Line: Displays trends and overall change 
across time at even intervals, with an 
emphasis on the rate of change, rather 
than the magnitude. 

• Map: Compares values and shows 
categories across geographical regions. 

• Pie/Donut: Shows proportions of data and 
the relationship of the parts to the whole 
(like percentages of 100%). 

• Radar: Accentuates differences and 
amounts of change over time as well as 
variations and trends. Each category has a 
value axis radiating from the center point 
with lines that connect all values in the 
same series. 

• Stock: Shows the four values for a stock: 
open, high, low, and close. 

• Sunburst: Shows hierarchical data with 
each level represented by one ring. The 
innermost ring leads the hierarchy. 

• Surface: Exhibits trends in values across 
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two dimensions, in a continuous curve. 
• Treemap: Offers a hierarchical view of data 

with proportions comparison within the 
hierarchy. 

• Waterfall: Presents how an initial value is 
affected by a series of positive and 
negative values. 

• X Y (Scatter): Demonstrates the 
relationships among numeric values in 
several data series, or plots interception 
points between x and y values. 

Example Chart Decisions 

The data this example comes from has 
generally too many data points to put on a 
column chart, which looks hard to interpret. A 
line chart can show changes in a more clear 
way. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Chart Types. 
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Line Chart vs. Column Chart 

We can use both a line chart and a column 
chart to illustrate a trend over time. However, 
a line chart is far more effective when there 
are many periods of time being measured. For 
example, if we are measuring fifty two weeks, 
a column chart would require fifty-two bars. A 
general rule of thumb is to use a column chart 
when twenty bars or fewer are required and 
there is enough room for the whole chart to 
be very readable. A column chart actually 
becomes difficult to read as the number of bars 
exceeds twelve or so, and twenty should be an 
upper limit. 

Column Chart vs. Bar Chart 

When using charts to show frequency 
distributions, the difference between a column 
chart and a bar chart is really a matter of 
preference. Both are very effective in showing 
frequency distributions. However, if you are 
showing a trend over a period of time, a 
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column chart is preferred over a bar chart. This 
is because a period of time is typically shown 
horizontally, with the oldest date on the far left 
and the newest date on the far right. Therefore, 
the descriptive categories for the chart would 
have to fall on the horizontal – or category axis, 
which is the configuration of a column chart. 
On a bar chart, the descriptive categories are 
displayed on the vertical axis. 

Trendlines 

Using a trendline on certain Excel charts allows 
you to illustrate the behavior of a set of data 
to determine if there is a pattern. Trends most 
often are thought about in terms of how a 
value changes over time, but trends also can 
describe the relationship between two 
variables, such as height and weight. In Excel, 
you can add a trendline to most types of charts, 
such as unstacked 2-D area, bar, column, line, 
inventory, scatter (X, Y), and bubble charts, 
among others. Chart types that do not examine 
the relationship between two variables, such 
as pie and doughnut charts that examine the 
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contribution of different parts to a whole, 
cannot include trendlines. 

Note that many chart types are specific to 
particular types of data, not for general use. 
Data management focuses on skills-building 
for work in that data management and analysis 
area, like statistics, finance, mathematics, 
scientific, etc. In this chapter, we will focus on 
a few common charts you might come across 
in school assignments or routine workplace 
needs. 

ACTION: Try Me activity 

Let’s now work with an Excel file: 
Ch20–Charts.xlsx. This is a dataset from 
Prisvard Tech, with various aspects of data we 
can use. Before starting work, save a copy of 
Ch20–Charts.xlsx to your Examples folder. 
Then, open that file for work. 

We’ll be completing several charts, and the 
images will appear through the chapter. 

There are 6 worksheets. We will work through 
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each sheet for one chart type at a time, and 
place the finished chart for each on the same 
worksheet the data for it is on. 

Bar Charts 

A bar or column chart is commonly used to 
show trends over time, as long as the data are 
limited to approximately twenty points or less. 

The Ch20–Charts.xlsx first sheet is for quarterly 
sales by region. This kind of data can be 
expressed in a bar chart, to highlight individual 
figures at a specific time. 

Go to the RegQSales worksheet. This sheet 
expresses regional sales by quarter in an Excel 
table object with a total row. We’ll start by 
determining if Excel recommends a frequency 
distribution chart, instead of going and looking 
for one ourselves. 

• Click the table and go to the Insert ribbon, 
Charts group, and select Recommended 
Charts. Recommended charts offers both 
column and bar chart options. 
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• Choose the Clustered Bar chart, then click 
OK. 

• A chart appears, floating over our data. 
Drag it so that its upper left corner is 
around cell F1, so that we can see it and 
some of the data. 

Click on the Bar chart. Notice that when you 
do, the table is subtly highlighted to indicate 
that the left column (regions) is in use in the 
chart, and that the numeric data is also being 
referenced in the chart 

• Drag the Bar chart’s lower right-hand 
border to increase the chart size for better 
review. 

Interestingly, the Bar chart does not have a 
title. Excel recognizes the data is a frequency 
distribution, but can’t determine what 
emphasis the chart should be named after. You 
will need to decide. 

• Click in the Bar chart’s Chart Title text box, 
and type Quarterly Sales by Region. 

• Click anywhere in the chart to select it, and 
observe how a contextual Chart Design 
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ribbon and related Format ribbon appear 
to the right of the other Excel ribbons. 

• In the Chart Design ribbon, Chart Styles 
group, hover your cursor over the various 
styles for this Bar chart, and choose one 
that seems easy to view and interpret. 

• In the Chart Design ribbon, Chart Styles 
group, choose Change colors, and see if 
there is a multi-colored palette that works 
for you. Hint: it is not recommended to use 
monochromatic (single color) color blends 
for a clustered chart, because they can 
blend together and be difficult to 
distinguish. 

• SAVE your work. 

We don’t need to do any more with this chart, 
but let’s interpret it. We are seeing a display of 
sales in each region, compared to each other 
for each quarter of the year. Some regions have 
lower sales. The 4th quarter sales seems to be 
consistently the highest, likely due to end-of-
year/holiday spending. 
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MedAttrib: author-generated. MS Excel bar 
chart. 

Line Charts 

The second Ch20–Charts.xlsx worksheet, 
named Comparison, compares monthly sales 
data for two segments that Prisvard Tech 
serves. This kind of data can be expressed in a 
line chart, to display trends and overall change 
across time at even intervals (in this case 
months). 

• Go to the Comparison worksheet. Let’s 
find out if Excel recommends a chart type. 

• Click the table and go to the Insert ribbon, 
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Charts group, and select Recommended 
Charts. Interestingly, Recommended 
charts offers mostly bar and column 
options. We don’t want that, so in the 
Insert Chart panel, select the All Charts 
tab and look for a Line chart. 

• In the Line chart selection, choose the Line 
with Markers option, and the preview 
chart on the right-side of the preview. 
Then click OK. 

• Excel will place the Line chart on the 
Comparison worksheet, and you may need 
to drag it below the table, so it doesn’t 
cover the data. 

Again, the created chart does not have a title. 

• Click in the Line chart’s Chart Title text box, 
and type Quarterly Sales by Region. 

• The Line chart uses colors that Prisvard 
tech doesn’t favor; in the Chart Design 
ribbon, Chart Styles group, hover your 
cursor over the various styles for this Line 
Chart. 

• Choose Colorful palette 2. 
• SAVE your work. 
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We don’t need to do any more with this Line 
chart, but let’s interpret it. It seems as if there 
has been more movement and variation in the 
sales of products to customers of the home 
segment than there was for those in the 
business segment. 

MedAttrib: author-generated. MS Excel line 
chart. 

Pie Charts 

The third Ch20–Charts.xlsx worksheet, named 
RepSales, shows the Sales Reps and their 
regions, and what percentage of all sales they 
were responsible for. This kind of data can be 
expressed in a doughnut or pie chart to reveal 
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proportions of data compared to the whole. 
Because there are more than three or four sales 
reps, a Pie chart might work well. 

• Go to the RepSales worksheet, click the 
table and go to the Insert ribbon, Charts 
group, and select the Insert Pie or Donut 
(spelled out Doughnut) Chart icon. 

• In the flyout selection, choose the Pie, then 
click OK. 

• Drag the Pie chart to the right so that it 
doesn’t cover the table data. 

• In the Percentage text box (which is the 
chart title), type Rep Sales by Percentage. 

• Click on the Pie chart, and go to the Chart 
Design format ribbon. In the ribbon, set 
the width to 8 inches and the height to 5 
inches. 

• Click on the Pie chart, and go to the Chart 
Design ribbon, and choose the Chart Style
11, which will add data labels for us. 

• SAVE your work. 

We don’t need to do any more with this Pie 
chart, but let’s interpret it. This chart only 
displays the percentages of overall sales by 
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sales rep. It doesn’t offer insight as to why, so 
it might be a useful supporting chart but 
something else would have to give more 
context, such as a detailed caption with a 
description, or a different chart type. 

MedAttrib: author-generated. MS Excel pie 
chart. 

Column Charts 

The fourth Ch20–Charts.xlsx worksheet, 
named MonthlySales, shows the actual sales 
by month, compared to the projected sales. 
This kind of data can be expressed in a column 
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or bar chart to show trends over time (months). 
We’ve done a Bar chart, so let’s do a Column 
chart here. 

• Go to the MonthlySales worksheet, click 
the table and go to the Insert ribbon, 
Charts group, and select the 
Recommended Charts icon. 

• In the selection, choose the Stacked 
Column chart, then click OK. 

• Drag the Column chart to the right so that 
it doesn’t cover the table data. 

• Click in the Column chart’s Chart Title text 
box, and type 2022 Projected and Actual 
Sales. 

• Let’s change the colors on this chart, and 
make it 3-dimensional so it pops out a bit 
more. 

• Click on the Column chart, and go to the 
Chart Design ribbon. In the ribbon, select 
Change Chart Type. 

• In the Chart Type preview area for Column 
charts, choose the 3-D Stacked Column, 
the preview on the left, and click OK. 

• Click on the Column chart, and go to the 
Chart Design ribbon, then choose Change 
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Colors. Here, a monochromatic selection 
will work; choose the bottom blue 
monochromatic palette. 

• SAVE your work. 

We don’t need to do any more with this 
Column chart, but let’s interpret it. The stacked 
format shows a comparison between the 
projected and actual sales of each month. In 
this case, a clustered chart actually might 
make more sense, in order to see side-by-side 
differences between the projected and actual 
sales. 

MedAttrib: author-generated. MS Excel 
stacked column chart. 
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Doughnut Charts 

The fifth Ch20–Charts.xlsx worksheet, named 
RegionalSales%, displays a percentage of sales 
per Prisvard Tech’s biomes (West, East, Mid 
country). This kind of data can be expressed in 
a pie or doughnut chart to show percentages 
of data compared to the whole. In this case, 
there are only 3 regions, which may be better 
represented in a doughnut chart; a pie chart 
would focus on the two date ranges, whereas a 
doughnut chart can focus on the three biomes. 

• Go to the RegionalSales% worksheet, click 
the table and go to the Insert ribbon, 
Charts group, and select the Insert Pie or 
Doughnut Chart icon. 

• In the flyout selection, choose the 
Doughnut, then click OK. 

• Drag the Doughnut chart to the right so 
that it doesn’t cover the table data. 

• Click on the Doughnut chart, and go to 
the Chart Design ribbon, and choose the 
Chart Style 3, which will add data labels for 
us. 

• Click on the Doughnut chart, and go to 
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the Chart Design ribbon, Chart Layouts 
group. 

• Then, click on the Add Chart Element icon, 
choose Chart Title, and then choose 
Centered Overlay. 

• Click on the Chart Title text box, and drag 
it just above the top of the doughnut. 

• In the Chart Title text box, type Biannual 
Biome Sales Percentages. 

• Click the Doughnut chart, go to the Chart 
Design ribbon, Data group, and click the 
Switch Row/Column. This will change the 
legend to the regions from the existing 
date ranges. 

• Click the Doughnut chart, go to the Chart 
Design ribbon, and choose the Change 
Colors icon. 

• Choose the Yellow monochromatic 
palette. 

• SAVE your work. 

We don’t need to do any more with this chart, 
but let’s interpret it. This chart displays the 
percentages of sales over two ranges within 
the year, and over three biomes. It doesn’t offer 
insight as to why, but doesn’t really need more 
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information to interpret it. The monochromatic 
colors, however, don’t have the clearest edges 
to separate the date ranges. 

MedAttrib: author-generated. MS Excel 
doughnut chart. 

Sparklines 

Sparklines are miniature charts that can be 
embedded into the background of a cell. Entire 
sparkline charts exist within single cells. Since 
Sparklines can be placed directly next to the 
data set being represented, viewing them 
allows the quick determination of trends or 
patterns within the data without looking at a 
separate chart. Consider using Sparklines to 
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illustrate high and low values within a range, as 
well as trends and other patterns 

The sixth Ch20–Charts.xlsx worksheet, named 
Sparklines, has a table that replicates the 
RegQSales table from the first worksheet, 
although this table is colorized in grays, not 
black. This kind of data can be expressed with 
Sparklines, because Sparklines consider data 
over a period of time (like 4 quarters) and 
present a line chart, or a bar chart, for it. In the 
case of Sparklines, these charts actually fill in 
the cells of the table next to the data, rather 
than being created as a separate chart object. 
Because of this, you can also type in the cells 
with the Sparklines; the text will float over the 
lines, or the column can be widened to the text 
and Sparklines can have enough room to be 
viewed clearly. 

Sparklines first have to be added to new, empty 
cells. 

In the Sparklines sheet of Ch20–Charts.xlsx, 
select the cells F6-F16, which are empty and 
just to the right of the 4th Qtr data. These cells 
are already “in the table” since this worksheet 
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already has a column header for Lines, and 
another column header to its right for 
Columns. 

• After selecting cells F6-F16, use the Insert 
ribbon’s Sparklines group to choose the 
Line icon. A Create Sparklines dialog box 
opens. 

The Location range is already filled with the 
cells you have selected in the F column: 
$F$6:$F$16 

• In the Data Range, select cells B6:E16 (not 
the totals row). This allows the Sparklines 
to summarize the Region quarterly data. 
for rows 6-16. 

• Click OK. 

Column F will now show sparklines in each cell 
of rows 6-16. Let’s make them more visually 
striking for easier viewing. 

• Click on one of the Sparkline cells to 
activate it, and a contextual Sparklines 
ribbon will appear in the Excel ribbons 
area. 
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• Click the Sparkline Color icon on the 
ribbon. 

• In the dropdown menu, select Weight, so 
we can make the Sparkline more 
prominent. 

• In the Weight dropdown, choose 3pt. 
• In the Sparkline ribbon, Show group, put a 

checkmark in the High point and the Low 
point checkboxes. 

• In the Sparkline ribbon Style group, select 
the Red Sparkline Style Dark 3. 

• SAVE your work. 

MedAttrib: author-generated. MS Excel Create 
Sparklines and Sparklines ribbon options. 

Let’s repeat most of these steps to add a 
Column Sparkline element to column G. 
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• Select cells G6-G16, and use the Insert 
ribbon’s Sparklines group to choose the 
Column icon. A Create Sparklines dialog 
box opens. 

The Location range is already filled with 
$G$6:$G$16. 

• In the Data Range, select cells B6:E16. 
• Click OK. 
• In the Sparkline ribbon, Show group, put a 

checkmark in the High point checkbox. 
The high point will now show as a gray, 
rather than brownish colored column. 

• In the Styles group, choose the Brown 
Sparkline Style Accent 2 Darker 25%. 

• SAVE your work and close the file. We’re 
done! 
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MedAttrib: author-generated. MS Excel 
Sparklines example. 
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Chapter 21: 
Chart/Graph 
Modifications 

What We’ll Cover >>> 

• Accessibility 
• Filtering Charts/Graphs 
• Chart Labels 
• X-Axis and Y-Axis Formats 
• Chart Area Titles 
• Data Series Labels 

You can use a variety of formatting techniques 
to enhance the appearance of a chart/graph 
once you have created it. Formatting 
commands are applied to a chart for the same 
reason they are applied to a worksheet: they 
make the chart easier to read. However, 
formatting techniques also help you qualify 
and explain the data in a chart. For example, 
you can add footnotes explaining the data 
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source as well as notes that clarify the type of 
numbers being presented (i.e., if the numbers 
in a chart are truncated, you can state whether 
they are in thousands, millions, etc.). These 
notes are also helpful in answering questions if 
you are using charts in a live presentation. You 
can change the arrangement of some row or 
column references by making them bigger or 
moving them on the chart. You can clarify axes 
information beyond the defaults that Excel 
provides in chart creation. 

We’ll look at a few options in this chapter. They 
can and should become part of your chart 
creation process. 

ACTION: Try Me activity 

Let’s now work with an Excel file: 
Ch21–ChartsDetail.xlsx. This contains two of 
the charts we worked on in Chapter 20. Before 
starting work, save a copy of 
Ch21–ChartsDetail.xlsx to your Examples 
folder. Then, open that file for work. 

We’ll be working with two charts, so the 
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finished images will appear later in this 
chapter. You can scroll down to see them now, 
if you wish. 

There are 2 worksheets: RepSales for a Pie 
chart, and MonthlySales for a Column chart. 

Accessibility 

Charts are graphic items, like photos, shapes, 
tables, and SmartArt. Whenever you place one 
in Excel, you should make a point of making 
sure it meets accessibility standards for when 
the workbook is distributed. You also might 
want to add some intellectual property 
information, so that the Excel metadata for the 
workbook accounts for the chart creation. More 
information on how to do this is in the 
Distribution chapter of this book. 

In Ch21–ChartsDetail.xlsx, go to the first 
worksheet: RepSalesChart. 

The chart actually does not have a name. In 
Excel, all items you create should be given a 
name, whether a table, a data range you need 
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to calculate with, images, SmartArt, shapes, 
and charts. This is, for instance, so that data 
range info is easier to find; so that formulas/
functions can use named ranges instead of 
manual cells selections; and so other users of 
your Excel workbooks can easily identify 
important ranges of data. 

However, naming a chart is not as self-evident 
as it is for naming a table. There is no Chart 
Name field in the contextual Chart Design 
ribbon tab like there is for naming Excel tables. 

• Click on the Pie chart, and go to the Excel 
Name box at the left end of the Formula 
Bar. In it, the Pie chart will be named 
something like Chart1 or Chart37. In the 
Name box, overwrite the existing name 
with something that identifies the chart, 
like PTsaleschart. This helps identify the 
Pie chart if it is needed in any other Excel 
reference. 

• To help the Pie chart be recognized by a 
screen reader, click on the chart and go to 
the Chart Format ribbon’s Accessibility 
group. 

• Click the Alt Text icon. This opens a panel 
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that lets you add alternate text to a chart/
graph, so that a screen reader can 
interpret for a user who cannot see the 
chart. 

• In our case, for practice, simply type: Excel 
pie chart of 2022 sales by percentage. 

All this does is let a screen reader know there 
is an image and offers a summary of what the 
image is. However, note that the details of the 
chart itself, like what the percentages are, who 
the sales representatives are, and other table-
related information isn’t something that can go 
into alternate text. Any remaining accessibility 
has to be part of overall Excel workbook 
creation. 

You can also add appropriate attribution 
information on a chart by giving it a caption 
with this content as well as a brief description 
of what the chart is. If you create the chart itself, 
but from other data, you should also give 
attribution/citation of the data. 

• Click on a cell below the Pie chart – cell 
D20 – and write a simple caption: Prisvard 
Tech’s sales representatives’ 2022 sales 
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by percentage. 
• SAVE your work. 

Filtering Charts/Graphs 

Charts and their graphs can be filtered, as 
needed. This doesn’t pivot the information with 
the same flexibility as Pivot tables and Pivot 
charts, but Excel does allow tables and charts 
to accept and refresh to show changes in the 
table filters. 

• In the RepSalesChart worksheet, click on 
the table to activate it. 

• In cell A5, use the filter button to deselect 
all, then select only Inaya, Nini, and River. 

• SAVE your work. 

The Excel table will show only the percentages 
of those three sales reps, and the Pi chart will 
refresh to do the same. 

• In cell A5, use the filter button to clear the 
filter. 

512  |  Chapter 21: Chart/Graph Modifications



Chart Labels 

Review the Pie chart. Notice how small the 
labels are. They are white on the color 
backgrounds, but they are so small they may 
fade into the overall chart and not  provide 
much information. 

Click on the Pie chart, and look at the top right 
side of its border. There are 3 icons that, when 
clicked, open a variation of the various options 
you can access from icons on the Chart Design 
and Format ribbons. 

MedAttrib: author-generated. MS Excel Chart 
options. 

• Click on the chart, and go to the Chart 
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Format ribbon, Chart Layouts group. 
• Click the Add Chart Element, then choose 

Data Labels, and More Options. 

Excel will open a Format Data Labels panel 
to the right of the workspace. In it, you can 
work with the Label Options (types of labels) 
and Text options (granular detail of how the 
labels are formatted). Note that dealing with 
labels, legends, and other individual chart 
elements is not for the faint of heart or 
something that can be done fast and easily. It 
takes patience, and may require touching each 
element separately. Still, let’s see what we can 
do. 

NOTE: As you later click on different areas of 
your chart (title, legend, an axis) the Format 
panel will change the panel’s format area 
name depending on what chart area you 
clicked, like to Format Axis, Format Data Series, 
Format Title, etc. 

• For instance, in the Format Data Labels 
panel, select Label Options, and in the 
dropdown, select Series “Percentage” 
Data Labels. 
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This selects all of the tiny percentage numbers 
in the pie chart at one time. 

• Then, with those selected, click in the 
Panel’s Text options. There is nothing that 
lets you change all the labels’ text size. 
Let’s try some other method. 

• With those text boxes still selected, go to 
the Home tab Font group, and change the 
font size to 18. Yay! That lets you change 
the font size all at once, (unlike back in the 
author’s salad days, decades ago. . .) which 
is pretty cool. 

• Click the chart somewhere away from the 
data labels, and the panel at the right will 
rename itself Format Chart Area. This 
allows you to format various things using 
this same panel. 

• Click the Chart Options, and select Legend 
/ More Options This selects the visual 
representation of the chart’s data series (in 
this case, the sales reps) shown at the 
bottom of the chart. These are tiny, too. 

• With this Legend area text selected, go to 
the Home tab Font group, and change the 
font size to 12. That let you change the font 
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size for the legend all at once. This 
increases the space needed and decreases 
the pie chart’s graphic a little, but overall, 
the chart is more readable. 

• SAVE your work. 

TIP: Formatting Axes shortcut step. You 
can actually double-click on a horizontal 
category X axis, a vertical (value) Y axis, 
a chart’s title box, and a chart’s legend, 
to open the needed item’s Format Chart 
panel options instead of using those 3 
icons at the side of the chart. 

MedAttrib: author-generated. MS Excel pie 
chart modifications. 
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X-Axis and Y-Axis Formats 

Let’s work with the other chart, Go to the 
second worksheet: MonthlySales. It shows a 
stacked Column chart with an X and Y axis. 

Review 

Let’s start by changing the chart type, since 
the provided Stacked Column chart in the 
MonthlySales worksheet doesn’t really give the 
kind of comparison that is easy to discern. A 
Clustered Column chart might work better. 

• Click the chart, go to the Chart Design 
ribbon, and choose the Change Chart 
Type icon. Choose a Clustered Column, 
the version in the left-side preview, and 
click OK. 

• Next, use the Change Colors icon to 
change the colors to Colorful Palette 2. 

• In the Chart Format ribbon, set the chart 
width to 7.5 inches and the height to 5 
inches. 
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• In the Chart Format ribbon, click the Alt 
Text icon. 

• In the Alt Text panel, type Prisvard Tech 
projected and annual sales chart, then 
close the Alt Text panel. 

• Click the Column chart, and look at its 
name in the Name Box to the left of the 
formula bar. 

• In the name box, overwrite the content 
with PTactsaleschart and press Enter. 

• SAVE your work. 

Chart Axes 

There are numerous formatting commands we 
can apply to the X-axis and Y-axis of a chart 
like the column, bar, line, or other axis-based 
charts. Although adjusting the font size, style, 
and color are common, many more options are 
available through the Format Axis pane that 
can help make the information more readable 
and useful for interpretation and analysis. Try 
the below steps to make some changes to the 
percentage numbers on the vertical (value) Y-
axis. 
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• In the MonthlySales worksheet, click on 
the 2022 Projected and Actual Sales chart. 
Click once on the vertical (value) Y-axis – 
the values are the numbers of the 
projected and actual sales. 

• Go to the Home tab Font group, and 
change the font size to 14. 

• Click once on the horizontal category X-
axis to select the month labels – which is 
the category for this axis. 

• Go to the Home tab Font group, and 
change the font size to 12. 

• Double-click on the same horizontal 
category X-axis, which will open a Format 
Axis panel. 

The Format Axis panel offers Axis options for 
placement, showing faint tick marks, and 
several other micromanaging choices. 

• In the Axis Options, choose Labels, and in 
Distance from Axis, change 100 to 20. 

• In the Text options, choose the Text Fill & 
Outline icon, and under Solid Fill, change 
the color to a dark blue. 

• Close the Format Axis panel. 
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• SAVE your work. 

Chart Area Titles 

Titles for the X and Y axes are necessary for 
defining the numbers and categories 
presented on a chart. For example, by looking 
at the 2022 Projected and Actual Saleschart, it 
is not clear what the percentages along the Y-
axis represent. The following steps explain how 
to add titles to the X and Y axes to define these 
numbers and categories: 

• Click anywhere on the 2022 Projected and 
Actual Sales chart to activate it. 

• In the upper right corner of the graph, 
choose the Charts Element plus sign. 
Select Axis Titles in the dropdown, then 
checkmark Primary Horizontal and 
Primary Vertical. This inserts the place 
holders that you can type text in. 

◦ Mac Users: click the “Add Chart 
Element” button in the Design tab, 
point to “Axis Titles” and click on 
“Primary Horizontal.” Do this one more 
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time and click on “Primary Vertical”. 

One problem is that these Axis titles seem to 
run into things. The Y-axis and its title run 
together, and the X-axis title runs into the 
Legend. Ugh. 

• Click on the chart, and choose the Charts 
Element plus sign again. 

• Choose Legend, and then Top. This gets 
the Legend out of the way of the X-Axis 
title. 

• Carefully click on the vertical (value) Y-axis 
title. Drag it to the top of the chart. 

• Double-click the Y-axis title to open the 
Format Axis Title panel. 

• In the panel, choose Title options, then the 
Size & Properties icon. 

• Below that icon, click Alignment, and in 
the dropdown, choose Text Direction. 

• In Text direction, choose Horizontal. 
• Close the Format Axis Title panel. 
• Click the Y-Axis title, and on the Home tab 

Font group change the font size to 14. 
• Then type Sales in this -axis label. 
• Now, let’s do the other axis title. Click the 
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horizontal category X-axis title, and on the 
Home tab Font group change the font size 
to 14. 

• Then, type 2022 Months in this X-Axis title. 
• Now, let’s make the Legend more 

readable. Click the Legend, and on the 
Home tab Font group change the font size 
to 18. 

• Now, let’s make the Title pop more. Click 
the Title, and on the Home tab Font group 
change the font size to 20. 

• SAVE your work. 

Data Series Labels 

Adding labels to the data series of a chart is 
a key formatting feature. A data series is an 
item that is being displayed graphically on a 
chart. For example, the blue bars on the 2022 
Projected and Actual Sales chart represent one 
data series. We can add labels at the end of 
each bar to show the exact percentage the bar 
represents. 

• Be sure that the entire chart is selected, 
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not just one of the data series. Then click 
the Chart Design ribbon. 

• On the Design tab select the Add Chart 
Element button, then Data Labels, then 
Outside End. Click on one of the Data 
Labels. Note that now all of the data labels 
for that data series should be selected. 

• Now, given how dense this particular chart 
is, these data labels do not help – they 
make it almost unreadable. 

• On the Design tab select the Add Chart 
Element button, then Data Labels, then 
None. This removes them. 

• SAVE your work, and close the file. We’re 
finished! 
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MedAttrib: author-generated. MS Excel 
column chart modifications. 
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Conclusion 

Microsoft® Excel® is clearly a resource that can 
be used in many careers, and is valuable for 
professional and personal purposes. This 
textbook has focused on introducing the 
fundamental skills necessary to get you started 
in using Excel and to a solid intermediate level 
of proficiency, confidence, and comfort using 
the program. 

While this content refers to Microsoft® Excel® 
current full-installation versions, the skills you 
learn and practice here are also consistent with 
open-source and other variations of 
spreadsheet programs, like those in Google, 
LibreOffice, OpenOffice, etc. You can also scale 
your work on Excel to use the lighter versions 
with some of what you learned and practiced 
here. 

There is absolutely tons more to learn for you to 
move past intermediate-level workplace skills 
to more advanced industry-specific skills, 
business informatics management, complex 
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data analysis and modeling, interpreting and 
manipulating content from massive databases, 
etc. YouTube and other videos can give you 
insights, as well as other courses, books and 
articles. Be sure to check out Creative 
Commons for additional free courses, modules, 
practice exercises, and textbook content to 
help you out. 

This particular book may later add another 
chapter or two to help expand some of this 
know-how on an introductory level. However, 
for now, this current content should easily 
prepare you for academic and workplace needs 
in entry-level to intermediate-level positions, in 
your own personal and entrepreneurial work, 
for geekery round-table-with-popcorn 
discussions (yes there ARE Excel-loving geeks 
out here!), etc. 

ALSO, if you have constructive comments, 
suggestions of additional free links and info for 
learners, attributions I may have inadvertently 
missed (or messed-up) noting, and even how 
this content may have helped you out, please 
don’t hesitate to let me know at 
ljbtrainings@gmail.com. 
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Signing off! 
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previously adapted versions of the source OER 
materials noted in this attribution section. It 
aims at working with Universal Design and 
with an eye to Diversity, Equity, Inclusion, and 
Accessibility (DEIA) considerations. It also 
simplifies the design format of the 
book(s)/course(s) from the attributed versions 
to help them be as accessible as possible, 
regardless of format (computer, mobile, 
accessible pdf or ePub, etc.) This work has also 
been greatly expanded to add sections in order 
to offer a more comprehensive look at various 
skills, issues, and challenges in current business 
technology. 

Many of the screenshots that appeared in How 
to Use Microsoft Excel: The Careers in Practice 
Series (upon which much of this content is 
based) adapted by The Saylor Foundation, were 
used with permission from Microsoft 
Corporation, which owns their copyright. How 
to Use Microsoft® Excel®: The Careers in 
Practice Series is an independent publication 
and is not affiliated with, nor has it been 
authorized, sponsored, or otherwise approved 
by Microsoft Corporation. Other screenshots 
have been added/updated to be consistent 
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with the current version of MS Excel in 2023 
and new assessment activities/examples. This 
adapted work uses all Microsoft® Excel® 
screenshots under fair use. If you plan to 
redistribute this book, please consider whether 
your use is also fair use. 

This book has been published with a Creative 
Commons Attribution NonCommercial license. 
This means that others may use this content 
with attribution to the author, for non 
commercial/non profit-making needs. Also, 
given the growing presence and of generative 
AI, if this book is used by others as a starting 
point for rewrites/new generation based on the 
book/my work, I also expect a full attribution for 
that content. 

This book repurposes content and examples 
from: 

Beginning to Intermediate Excel (Creative 
Commons Attribution 4.0 International 
License) by Jevans10spsccedu; Noreen Brown; 
Barbara Lave; Hallie Puncochar; Julie Romey; 
Mary Schatz; Art Schneider; and Diane 
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Shingledecker, of Open Oregon Educational 
Resources. 

In turn, much of their work was adapted from 
How to Use Microsoft Excel: The Careers in 
Practice Series, adapted by The Saylor 
Foundation without Attribution as requested 
by the work’s original creator or licensee, and 
licensed under CC BY-NC-SA 3.0. 

Preparing to Print, by Julie Romey, Art 
Schneider, Mary Schatz; Portland Community 
College is licensed under CC BY 4.0. 

5.1 Table Basics by Hallie Puncochar, Portland 
Community College is licensed under CC BY 
4.0. 

Images have been attributed under the images 
as captions. 

Cover developed from public domain images. 

This book was not written/generated or 
aggregated with generative AI tools. 
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